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Chapter 1, Introduction 

Welcome to Origin 
Thank you for purchasing Origin version 7.5!  This manual is provided to 
familiarize you with the fundamentals of Origin in a minimal amount of 
time.  The manual provides information for new and upgrade users, 
including: 
• A summary of the major new features in version 7.5. 
• An overview of the major Origin concepts and terminology. 
• 14 tutorials covering a broad range of Origin topics. 
For installation and registration assistance, see Chapter 2, Installing 
and Running Origin. 
For additional help using Origin, review the Origin Help files 
(Help:Origin or Help:Programming) or visit the OriginLab web site at 
www.OriginLab.com.   

Getting Help Using Origin 
If you have a question about using Origin, assistance is available from 
several different sources.  

From the Software 
• The status bar in the Origin window provides text clarifying the 

function of toolbar buttons, tool elements, and menu commands.  It 
also displays Origin status messages.   
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• The Origin Help contains information on all of Origin’s features.  To 
open the Origin Help, select Help:Origin or press F1.  If a dialog 
box is open, pressing the F1 key will open the Help file to 
information specific to that particular dialog box.  In addition to the 
F1 key, most dialogs also have a “?” button on the title bar. Pressing 
this “?” button is equivalent to pressing the F1 key.  

Programming Help is available from the Help:Programming submenu.  
Select Programming Guide to learn general tips and strategies on 
programming in Origin.  Select Code Builder User’s Guide for 
information on the use of Origin’s integrated development environment, 
Code Builder.  Select Origin C Language Reference to find information 
on a specific Origin C class or function.  Select LabTalk Language 
Reference to find information on the LabTalk programming language.   

Viewing Origin's Help 
files requires Internet 
Explorer version 4.0 or 
higher (We recommend 
IE v5.0 or higher).   

Important Note about Origin's Help Files:  The Origin Help files are 
compiled HTML Help.  To view these Help files, you must have 
Internet Explorer version 4.0 or higher installed on your computer.  
Internet Explorer need not be your default browser, but it must be 
installed in order to fully utilize your online Help system. 

• Sample Origin projects and data files are provided with Origin.  
These files are located in the Origin \Samples subfolder.  Sample 
projects show you how to perform analysis routines, create custom 
graphs, and program routines in Origin.  Sample files on Origin C 
programming can be found under the \Samples\Programming 
subfolder. 

From the Manuals 
• This Getting Started Manual includes a Getting Started Using 

Origin section with a run-down of basic Origin features.  The 14 
tutorials in this manual will guide you through many common Origin 
operations (Note that these plus a number of programming-related 
tutorials are also available online (Help:Tutorials). 

From the Web Site 
You can access helpful areas of the OriginLab web site by selecting 
Help:Origin on the Web.  This menu command opens a submenu 
providing fast access to a important OriginLab web resources.  These 
resources include technical support pages, a file exchange area for users, 
the graph gallery, a user forum, and the OriginLab home page.  To access 
the OriginLab home page directly from your browser, go to 
www.OriginLab.com.   

From Your Origin Technical Support Representative 
OriginLab and our team of international support representatives are 
committed to providing high quality technical support to our registered 
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Origin users.  To contact your OriginLab Technical Support or to find 
out how to contact your local support representative, select Help:Origin 
on the Web:Technical Support.  Alternatively, go to 
www.OriginLab.com and click the Support link.   
• Customers outside the US and Canada will find contact information 

for technical support representatives listed by country. 
• If OriginLab is your technical support representative, you can submit 

a technical question to OriginLab from the web site.   
Additionally, if OriginLab is your technical support representative, you 
can contact OriginLab Technical Support at tech@originlab.com.  
Phone:  1-800-969-7720 (US) or 1-413-586-2013 (US or Canada). 

OriginPro 
OriginPro includes all the features found in Origin.  Additionally, 
OriginPro is an application development environment for building 
custom analysis and graphing applications based on Origin.  Once 
developed, custom applications can be run on the standard Origin version 
or the OriginPro version.  The standard version of Origin can be 
upgraded to OriginPro. 

Create Sophisticated Custom Interfaces 
• Create dialog boxes, tabbed tools, and wizards using OriginPro’s 

Dialog Builder.  
• Access tool object properties and methods from Origin C 
• Select controls from industry standard development tools. 
• Include ActiveX controls in your tool.  
• Save wizard procedures as a toolbar button. 
• Add your own menus and menu commands to the Origin menu bar. 

COM Client Support 
• Develop Origin C programs using COM, allowing Origin to interact 

with other software applications.  

Automation Server Support 
• Program Visual Basic, Excel, or other COM-enabled applications to 

communicate with Origin (this feature is available in standard 
Origin.)  
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• Support for multiple client access (this feature is only available in 
OriginPro). 

Additional Products Available from OriginLab 

The Peak Fitting Module (OriginPro) 
Work in chromatography, spectroscopy, engineering, pharmacology, and 
other fields frequently requires analysis of data sets exhibiting multiple 
peaks.  Analysis of multi-peak data is particularly difficult when peaks 
overlap, or when data are "noisy."  The Peak Fitting Module (PFM) 
combines an intuitive “wizard” interface with the tools needed for serious 
peak analysis:  
• Data filtering. 
• Automatic and/or manual baseline and peak detection. 
• Built-in or user-defined curve-fitting functions. 
• Highly accurate nonlinear least squares curve fitting. 
• Publication-quality output. 

Figure 2:  The Peak Fitting Module 
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The Origin DataAccess Module 
This module is a collaboration between OriginLab Corporation and 
Bruxton Corporation.  It provides: 
• Direct access to electrophysiology data 
• Reads stimulus (if present) as well as response 
• Point-and-click interface for easy use  
• Script interface for advanced custom analysis 

 

The module supports these file formats:   
• Axon Instruments pClamp,  
• Bruxton Corporation Acquire,  
• Cambridge Electronic Design Spike2 
• HEKA elektronik Pulse 
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Additional Add-ons 
In addition to the Peak Fitting Module and the Data Access Module, 
OriginLab offers custom tools and modules that are available from the 
File Exchange area of the OriginLab web site (www.OriginLab.com).  
The tools add specific enhancements to Origin and OriginPro.   
Most of the tools and modules are provided in a special file format with a 
.OPK extension.  After downloading the file, these tools and modules are 
easily installed by dragging the .OPK file from Windows Explorer onto 
your copy of Origin or OriginPro.   
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Chapter 2, Installing and 
Running Origin 

Single User Licenses 
Your Origin 7.5 single-user package contains: 
• your Origin CD. 
• a label containing your serial number. 
• a letter containing your temporary license code 
• an Origin manual 
• other product information 
If you are unsure if you purchased a single-user license versus a group 
license, please check your serial number.  Single-user license serial 
numbers contain either a 6 or a 9 in the following location: 
xxxxx-6xxx-xxxxxxx 
xxxxx-9xxx-xxxxxxx 
If your serial number does not contain a 6 or a 9 in this location, then you 
have a group license.  For installation and getting started information on 
group licenses, see Group Licenses on page 20.   

Installing Origin 
Before installing your single-user license, please review the following 
system requirements: 

Recommended System Configuration: 
The recommended system configuration is Microsoft Windows XP 
Professional on a PC with a Pentium III processor and 128 MB of RAM.  

Minimum System Requirements: 

Operating 
System 

Windows 98, Windows Millennium Edition (Windows 
Me), Windows NT 4.0 with Service Pack 6 (SP6) or 
later, Windows 2000, or Windows XP or later.  
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Computer 
Processor 

Computer with Pentium 133 MHz or higher processor. 

Memory Windows 98, Me, NT, 2000 - 64 MB of RAM. 
Windows XP - 128 MB of RAM. 

Hard Disk* OriginPro Server: 170 MB of free hard disk space. 
OriginPro Stand-alone: 140 MB of free hard disk space. 
Origin Standalone: 120 MB of free hard disk space. 
Origin Client: 50 MB of free hard disk space. 

Drive CD-ROM drive. 
Display Super VGA (800 x 600) or higher-resolution monitor 

with 256 colors. 
Other Internet Explorer version 5.0 or later.  Internet Explorer 

need not be your default browser, but it must be installed 
for viewing Origin's compiled HTML Help.  

*Note:  Hard disk space requirements will vary depending on the 
configuration.  Additionally, custom installation choices may require 
more or less hard disk space. 

To install Origin, insert your Origin CD in the CD-ROM.  A window 
opens with a number of options, including installing Origin.  Click the 
link to start the installation.  If the CD does not start automatically, 
browse the CD and run ORIGINCD.EXE directly.  
The setup program prompts you to enter your Origin serial number.  
Your serial number is located on a label in your package.   
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After entering this information, click Next and confirm that this 
information is correct. 
The next installation step is selecting a destination folder.  If you have an 
Upgrade serial number (xxxxx-6xxx-xxxxxxx), you are not permitted to 
specify an existing Origin folder as your destination folder.   
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Origin includes a wide selection of numerical computational routines 
from Numerical Algorithms Group, Inc. (NAG®).  NAG functions can 
be called from Origin C, Origin’s programming language.   
To install the PDFs that document these NAG functions, select the NAG 
PDF Files check box and click Next.   

 

The next installation step asks you if you want the Origin program folder 
to be added to the Start menu for all users who log onto the computer, or 
for only you (when you log on using your current log in account).   
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The next installation step allows you to select a new or existing program 
folder for the Origin program icons.   

 

After completing the installation, the program folder that you selected 
during the installation opens. 
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The program icons are used as follows: 

Origin(Pro) 7.5 
Add or Remove 
Files 

Un-install, modify, or repair your Origin 
installation.   
To learn about un-installing, see Un-installing 
Origin on page 19. 
To learn about modifying your installation, see 
Modifying Your Current Installation on page 
19.   
To learn repairing your installation, see 
Repairing Your Current Installation on page 
20.  

OriginPro 7.5 
PFM 

This program icon is only available with 
OriginPro.   
Browse to a folder that contains the PFM 
installation file, PFM.OPK.  To learn more about 
installing and running the PFM with OriginPro, 
see the PFM manual.   

Origin(Pro) 7.5 
Sample Projects 
and Data 

Browse to the sample projects and data folders.   

Origin(Pro) 7.5 Start Origin. 
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Selecting a User Files Folder 
The first time you start Origin, the User Files Folder dialog box opens.   

 

The User Files folder that you select in this dialog box will be the default 
“save in” folder for templates, Origin projects, data files, and other file 
groups that you can save in Origin.  Access to the Origin installation 
folder is provided in the Places Bar, located on the left side of the “Save” 
dialog boxes. 
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After Origin starts, you can change the default “save in” path for any of 
these file groups by selecting Tools:Options to open the Options dialog 
box.  Then select the File Locations tab.   
After you specify your User Files Folder and click OK, Origin copies 
some initialization and configuration files to your User Files folder.  
Origin will read these copies at future start-ups. 

Note:  If you want to change your previously specified User Files folder, 
enter the following LabTalk command in the Script Window: 

del -path  (press ENTER) 
When you re-start Origin, you will be asked to re-select a User Files 
folder.   

Transferring Settings if Upgrading 
If you installed Origin using an Upgrade serial number (xxxxx-6xxx-
xxxxxxx), then the first time that you run Origin you will be given the 
option to transfer fitting function settings from your previous installation 
to your Origin 7.5 installation.   
During this process, Origin will check for previous installations, and 
open a dialog box pre-populated with a previous version location, if 
found.  If the initialized location is not correct, you can browse to the 
correct location.   
During the transfer process, Origin will: 
1)  Copy all user-defined and modified built-in FDF files from the 
previous Origin \Fitfunc folder to the Origin 7.5 User Files folder.   
2)  Upgrade the NLSF.INI from the previous Origin folder to the Origin 
7.5 User Files folder. 
After this transfer process, your previous user-defined and modified 
built-in fitting functions will be available for use in Origin 7.5.   

Setting up the License Management 
The Origin 7.5 license agreement allows you to install Origin 7.5 on as 
many as three computers (work, home, and laptop).  In addition to this 
installation agreement, Origin is managed at run-time by a node-locked 
license file.  Node-locked license files must be obtained for each 
computer you will run Origin on, as they contain computer-specific 
details.   
OriginLab also provides a temporary license number that allows you to 
run Origin for a limited time until you retrieve your node-locked license 
file.   
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Retrieving Your Node-locked License File 
When you first start Origin, the License Information dialog box opens.  
If your computer has internet access, you can retrieve your node-locked 
license file by selecting the Get a License File radio button and clicking 
the Click here to generate your License File from our website... 
button.   

 

After you click this button, Origin notifies you that it will be passing an 
ID containing encrypted details of your computer to the OriginLab 
website.  After accepting this, Origin will open your default browser and 
direct you to a log in page on the OriginLab website.   
If you do not have a web membership account, you must create one to 
proceed.   

Single User Licenses •  15 
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If you have an account but do not remember either your User Name or 
your Password (or both), enter your email address in the text box 
provided and OriginLab will email you back your web membership 
details.   
After logging in to the OriginLab website, you will be stepped through 
the process of retrieving your node-locked license file.   
• If OriginLab is able to successfully process your license file request, 

you will see a web page that contains the node-locked license file 
text.  The last line of the license file text is your Registration ID 
(REGID).  When you copy your license file text to the Clipboard, 
make sure to include the REGID line.  You will then paste the text 
back into Origin’s License Information dialog box and click the 
Step 3 button, labeled Click here to update your License File.   

• If OriginLab is NOT able to successfully process your license file 
request, you can run Origin using a temporary license file.  For 
information on this, see the following section.   

If your computer is not connected to the internet, you can go to the 
OriginLab website from a different computer that does have internet 
access.  In this case, browse to the OriginLab home page 
(www.OriginLab.com) and then click the FLEXlm license file link on 
this page.  You will need your serial number and computer ID (that 
displays in the License Information dialog box on the computer where 
Origin is installed) to complete the license retrieval process. 
Alternatively, you can contact your OriginLab distributor or OriginLab 
Corporation to obtain your node-locked license file.  Again, you must 
provide your serial number and computer ID from the License 
Information dialog box.   

If you encounter a delay retrieving your node-locked license file, you can 
begin using Origin with a temporary license file (see the following 
section).   

Using a Temporary License File 
If you encounter any problems or delays obtaining your node-locked 
license file, you can run Origin using a temporary license.  To enter a 
temporary license, the License Information dialog box must be open.  
The License Information dialog box will open automatically when you 
re-start Origin without a valid node-locked or temporary license file.  
Alternatively, if Origin is already running in the “3 minute mode”, you 
can open the License Information dialog box in this way:  
1. Select Help:About Origin.   
2. Click the License button. 

http://www.originlab.com/
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Once the License Information dialog box is open: 
1. Select the Use Temporary License radio button. 
2. Click the Use Temporary License button.   

 

The temporary license number and date are included on a printout in your 
Origin package.  Additionally, if you encounter problems retrieving your 
node-locked license file, OriginLab provides a temporary license number 
and date on the web page that notifies you of the node-locked retrieval 
problem.  This temporary license number and date provided on the 
website may be different than that provided in your package.  Use the 
combination with the later expiration date.   
If you are copying your temporary license number from the OriginLab 
website, select the Paste ... radio button and then paste the number in the 
large text box.   
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If you are entering the code from the printout in the package, you can 
select either radio button and associated text boxes.  The formatted lower 
text boxes are provided to assist in you in entering the characters. 

Important Note:  Your temporary license will expire on the date 
provided with the temporary license number.  Prior to that expiration 
date, you must obtain your node-locked license file.  To re-open the 
License Information dialog box to either enter or obtain your node-
locked license file from the OriginLab website, select Help:About 
Origin.  Then click the License button.  For more information on the 
node-locked license file, see the previous section.   

Registering Your License 
In Origin 7.5, registering your license is an integral part of obtaining your 
node-locked license file.  Registration entitles you to standard technical 
support for Origin 7.5.  It also entitles you to product updates that are 
available by selecting Help:Check for Updates.   
When you visit the OriginLab website to retrieve your node-locked 
license file, you will be asked to complete (or update) an online 
Registration form.  After successfully completing this form, you will 
obtain your node-locked license file text.  The last line of the text 
contains an updated Registration ID (REGID).  When you successfully 
update Origin’s License Information dialog box with this text, you have 
completed the process of obtaining your node-locked license file and 
registering your Origin license.  In addition, you will receive an email 
containing your license file text and your Registration ID for your 
records. 
If you do not have internet access to obtain your node-locked license file 
(and in the process, register your Origin license), you will need to 
provide OriginLab or your Origin distributor with your registration 
information.  A registration page is included in the back of this manual to 
assist you.   
If at any time you need to enter only your Registration ID into Origin 
(separate from your node-locked license file text), select Help:Register 
Online.  If you need to edit your registration information, select 
Help:Update Registration Info.  These commands are dynamic.  
Register Online is only available if no Registration ID has been entered.  
Update Registration Info is only available if a Registration ID has been 
entered.   



 

 

Chapter 2, Installing and Running Origin 

Un-installing Origin 
To remove Origin from your computer, run the Origin(Pro) 7.5 Add or 
Remove Files program.  This program is accessible from the program 
folder you selected during installation, as well as from the Start menu.  
The Add or Remove Files program opens the following dialog box.  To 
un-install Origin, select the Remove radio button and click Next.  

 

The Remove program copies all built-in files of the following type that 
you have modified into a \Modified Files subfolder.  This includes 
template (OTW, OTP, OTM), script (OGS), initialization (INI), 
configuration (CNF), Origin project (OPJ), data (DAT, etc.), and fitting 
function (FDF) files.  It then removes all installed files (excluding the 
\Modified Files subfolder).   
User-created files that are not modified versions of built-in files (such as 
new templates and new fitting functions) are not removed during this 
process.  The Remove program also does not make any changes to your 
User Files folder.   

Modifying Your Current Installation 
There are two reasons why you may need to modify your current 
installation:   
• Install the PDFs that document the NAG functions.  
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• Change your serial number (for example, if you have changed your 
license from Origin to OriginPro, or from an expiring to a permanent 
license).   

To start the Modify program, run the Origin(Pro) 7.5 Add or Remove 
Files program.  This program is accessible from the program folder you 
selected during installation, as well as from the Start menu.  In the 
Welcome dialog box that opens, select the Modify radio button and click 
Next.  

Repairing Your Current Installation 
To re-install all the original program components, run the Origin(Pro) 7.5 
Add or Remove Files program.  This program is accessible from the 
program folder you selected during installation, as well as from the Start 
menu.  In the Welcome dialog box that opens, select the Repair radio 
button and click Next.  
When you run the Repair program, all built-in files of the following type 
that you have modified are copied into a \Modified Files subfolder.  This 
includes template (OTW, OTP, OTM), script (OGS), initialization (INI), 
configuration (CNF), Origin project (OPJ), data (DAT, etc.), and fitting 
function (FDF) files.  

Group Licenses 
Origin 7.5 group packages contain: 
• one or more Origin CDs 
• a label containing the group serial number 
• a home-use license, in qualifying packages 
• one or more Origin manuals 
• other product information 
If you are unsure if you purchased a group license versus a single-user 
license, please check your serial number.  Group license serial numbers 
contain a 3 or a 2 in the following location: 
xxxxx-3xxx-xxxxxxx 
xxxxx-2xxx-xxxxxxx 
If your serial number does not contain a 3 or a 2 in this location, then you 
have a single-user license.  For installation and getting started 
information on single-user licenses, see Single User Licenses on page 7.   
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Installing Origin 
The group license allows you to set up one of the following group 
configurations: 

Single Origin server and multiple Origin clients.   

 

• This model provides an easy mechanism for sharing custom Origin 
files among all Origin clients.  Files customized from the Origin 
server are available to all the Origin clients. 

• Applying a patch is also a simplified process, as only the Origin 
server is patched.  Clients are then notified that an update is 
available from the Origin server.   

• This model requires that the Origin clients maintain a connection to 
the Origin server when they are running.   

• In this model, the location of the FLEXlm concurrent license server 
is specified by running the Origin server.  Origin clients 
automatically read this path.   

Multiple stand-alone Origins.   

 

• In this model, each stand-alone Origin is patched separately.  Also, 
the location of the FLEXlm concurrent license server must be 
specified when starting each stand-alone Origin.  
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In either of the above cases (the Origin server + clients or  the multiple 
stand-alone Origin installations), a FLEXlm concurrent license server 
performs license management at run time.   
For more information on the license management, see Setting Up the 
FLEXlm Concurrent License Server on page 25.   

Installing an Origin Server 
The Origin server can be installed to a machine running Windows 98, 
Windows Millennium Edition (Windows Me), Windows NT 4.0 with 
Service Pack 6 (SP6) or later, Windows 2000, or Windows XP or later.   
The server software requires approximately 140 to 170 MB of hard disk 
space during installation.  The server software folder occupies 
approximately 110 – 140 MB of hard disk space if all sample project and 
NAG PDF files are installed.   
To install an Origin server, you must log on to an account that has 
administrator privileges on the server machine, unless installation 
permissions are being managed by Microsoft SMS.  The Origin server 
can be installed anywhere on the server machine that is writable.  After 
installing the Origin server, it should be shared as read-only.   

To install an Origin server, insert the Origin CD in the CD-ROM.  A 
window opens with a number of options, including installing Origin.  
Click the link to start the installation.  If the CD does not start 
automatically, browse the CD and run ORIGINCD.EXE directly.  
The setup program prompts you to enter your Origin serial number.  
Your serial number is located on a label in your package.  After 
confirming your serial number, the next installation step provides the 
choice of installing an Origin server or a stand-alone Origin.  Select the 
Install Origin Server for use by Origin Clients radio button.   
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Continue with the Origin server installation as prompted.  For a 
discussion of the remaining installation options, see the installation 
instructions in Single User Licenses on page 7.   
After completing the Origin server installation, a message box informs 
you that the Origin server and clients will be managed at run time by a 
FLEXlm concurrent license server.  To learn how to install and set up the 
license server, see Setting Up the FLEXlm Concurrent License Server 
on page 25.   
Also, you must run the Origin server once after setting up the FLEXlm 
concurrent license server.  On the first start-up of the Origin server, you 
will be asked to specify the location of the FLEXlm server.  Once this 
has been successfully completed, the Origin clients will read this 
FLEXlm server location from the Origin server.   

Installing Origin Clients 
An Origin client can be installed to a machine running Windows 98, 
Windows Millennium Edition (Windows Me), Windows NT 4.0 with 
Service Pack 6 (SP6) or later, Windows 2000, or Windows XP or later.  
The Origin client machine must have a connection to the Origin server 
machine during the client installation and at run time.   
Installing an Origin client requires 50 MB of hard disk space, though the 
client folder will probably increase in size with time as user-specific files 
are added.   
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To install an Origin client, browse to the Origin server’s \ClientSetup 
folder and double-click on Setup.exe.  Alternately, you can mail the 
client users an active link to the client setup program. 
When the installation program launches, enter the UNC path 
(\\ComputerName\ShareName) to the Origin server.   
Continue with the Origin client installation as prompted.  For a 
discussion of the remaining installation options, see the installation 
instructions in Single User Licenses on page 7.   
Additionally, to learn more about the following topics, see the 
appropriate sections: 
• Selecting a User Files Folder on page 13.   
• Transferring Settings if Upgrading on page 14. 
• Un-installing Origin on page 19. 
• Modifying Your Current Installation on page 19. 
• Repairing Your Current Installation on page 20. 

Installing Stand-alone Origin 
The system requirements for a stand-alone group member are identical to 
those for the single user license.  To review this information, see 
Installing Origin on page 7.   
To install a stand-alone group member, insert the Origin CD in the CD-
ROM of the member’s PC.  A window opens with a number of options, 
including installing Origin.  Click the link to start the installation.  If the 
CD does not start automatically, browse the CD and run 
ORIGINCD.EXE directly.  
The setup program prompts you to enter your Origin serial number.  
Your serial number is located on a label in your package.  After entering 
this information, click Next and confirm that this information is correct. 
The next installation step gives you the option of installing an Origin 
server for use by Origin clients, or installing stand-alone Origin.  Select 
the Install Origin for Stand-alone Personal Use radio button and click 
Next to continue. 
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The remaining stand-alone Origin installation options are the same as 
those for a single-user installation.  To review this information, see 
Single User Licenses on page 7.   
Additionally, the following single user topics also apply to stand-alone 
members of a group license:   
• Selecting a User Files Folder on page 13.   
• Transferring Settings if Upgrading on page 14. 
• Un-installing Origin on page 19. 
• Modifying Your Current Installation on page 19. 
• Repairing Your Current Installation on page 20. 

Run time management of the group license differs from the single-user 
license.  Stand-alone members of a group license will be managed by a 
FLEXlm concurrent license server.  For more information, see Setting 
Up the FLEXlm Concurrent License Server on page 25.   

Setting Up the FLEXlm Concurrent License 
Server 
When OriginLab processes a group purchase, OriginLab emails a 
notification to the main contact (a systems administrator is 
recommended) indentified at the time of purchase.  The notification 
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informs the systems administrator how to install and setup a FLEXlm 
license server.  It also informs them how to get the FLEXlm concurrent 
license file.   
The FLEXlm license server does not need to be installed and set up prior 
to installing the Origin server + clients or stand-alone Origins, but it does 
need to be completed before running Origin.   
• If you have installed an Origin server and Origin clients, then you 

must run the Origin server before running any Origin clients.  When 
you run the Origin server, the License Information dialog box will 
open, asking you to enter the FLEXlm license server name or IP 
address, and a port number if required.  

• If you have installed stand-alone Origins, then when you start each 
stand-alone Origin, you will need to specify the path to the FLEXlm 
license server.   

 

After this is completed, Origin clients will read the FLEXlm server 
location from the Origin server. 
• If you have installed stand-alone Origins, then when you start each 

stand-alone installation, you will need to specify the FLEXlm license 
server name or IP address, and a port number if required. 

Registering Group Members 
For group licenses, each Origin client or stand-alone Origin installation 
should register his or her Origin.  Additionally, the systems administrator 
should register the Origin server (if the server + clients group model was 
installed).  Registration entitles you to standard technical support for 
Origin 7.5.  For the Origin server and stand-alone installations, 
registration also inetitles you to product updates that are available by 
selecting Help:Check for Updates (not available from the Origin client, 
only from the Origin server). 
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To register Origin, select Help:Register Online.  If you need to edit your 
registration information, select Help:Update Registration Info.  These 
commands are dynamic; Register Online is only available if no 
Registration ID has been entered.  Update Registration Info is only 
available if a Registration ID has been entered. 
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Chapter 3, What's New in 
Version 7.5 

Introduction 
Origin 7.5 builds on Origin’s already-extensive scientific graphing and 
analysis capabilities with completely new tools that simplify common 
operations.  A new Import Wizard visually assists you with import of 
ASCII and binary data files.  Origin’s new AutoUpdate feature for 
column formulas updates calculations whenever source data are 
modified.  Use the all-new Plot Setup dialog box to create new graphs or 
to add, remove, modify or replace plots in an existing graph.  Instantly 
change the look of any graph by applying a built-in or user-defined 
Theme.   
In the programming realm, there is a new method for dynamically 
creating dialog boxes that supports input form a wide variety of interface 
controls.  User-defined classes are now supported, allowing Origin C 
programmers to create objects of their own type with user-defined 
methods and data members.  Both Origin and OriginPro 7.5 include 
Automation Server functionality (OriginPro supports multiple clients), 
and OriginPro developers can now embed ActiveX controls in their 
custom DDK tools.  
The following sections introduce these new Origin 7.5 features.  For 
more information on the use of these features, review related topics in the 
Origin Help files (Help:Origin and Help:Programming).  Also, be sure 
to look over the tutorials in this Getting Started Manual and in your 
online tutorials (Help:Tutorials). 

Data Exchange 

Import Wizard 
The Import Wizard allows you to customize the way Origin imports data 
of various file types.  The wizard can be used to create custom settings 
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for each file type.  These settings can then be saved as a filter file for 
later use with the same or similar files.   
Use the wizard to specify how data is imported when: 

Opening data files using the File:Open dialog. 

Importing data files using the File:Import menu. 

Dragging-and-dropping data files into the Origin workspace. 

File Types Supported 
The Import Wizard supports the following file types:  

ASCII files. 

Simple Binary files (header followed by simple binary structure). 

User-defined file types. 

 

For the ASCII and Binary file types, the wizard steps you through the 
selection of a suite of import options.  Origin then uses these options to 
read subsequently imported files.   
For importing of user-defined file types, you supply the import code in 
the form of an Origin C function. 

Worksheet and Graph Support 
The wizard supports data import into worksheets or graphs.  The wizard 
pages are context-sensitive, presenting you with only the import options 
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relevant to the particular window type.  You can also specify different 
ways of handling data that are droppped onto a worksheet or onto a 
graph, data that are dropped outside of a window, etc. 

Import Filters 
All wizard settings can be saved to filter files for later use. You can opt 
to save the filter file to the same folder as the data file, or to to a general 
Filters folder in your User Files location.  Further, you can specify wild 
cards to be used for each filter file, allowing the filter to be applied to 
multiple file types.  
When your drag and drop data, Origin searches the data folder and the 
User Files folder for an appropriate filter.  When multiple applicable 
filter are found, a dialog opens allowing you to choose the correct filter. 

Multiple File Import 
The wizard supports multi-file import for files of the same type and 
format, with the first-imported file being used to determine what filter 
will be used for the multi-file import.  

MATLAB Console and File Import 
These features allows Origin users to issue MATLAB commands from 
Origin, transfer data between Origin and MATLAB, and open MATLAB 
workspace files to import data into Origin.   

MATLAB Console 
To make use of the Console feature, you must have both Origin and 
MATLAB installed on your computer.  The MATLAB console is 
invoked with an Origin menu command.  This command simultaneously 
launches:  
• a new instance of the MATLAB application 
• the Origin MATLAB Console (command window) 
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You can issue commands from this Console window to transfer real and 
complex 2-D matrices back and forth between MATLAB and Origin.  
The Import button (the top right corner of the Console) opens the 
MATLAB Import dialog box.  This dialog box lists all variables in the 
current MATLAB workspace.  You can select a single variable or SHIFT 
+ select multiple variables, and import them into an Origin worksheet or 
matrix.  Check boxes provide you with the option to update existing 
Origin matrices and/or to add imported data to an existing worksheet. 
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MATLAB File Import 
In addition to importing variables from the current MATLAB 
workspace, Origin provides a menu command for importing variables 
from saved workspace (*.MAT) files. This feature does not require 
MATLAB to be installed on your computer. Instead, Origin directly 
reads the MATLAB workspace file.  The Import dialog that opens is 
similar to the one invoked by the Import button in the MATLAB console 
dialog. 

LabView Connectivity 
A new feature allows communication between LabVIEW and Origin.  
The Origin installation provides a collection of building-block Virtual 
Instruments (VI) that can be used to create custom a VI that connects to 
Origin, exchanges data between LabVIEW and Origin worksheets and 
matrices, and sends script commands to Origin from LabVIEW. 
A LabVIEW VI Browser tool is also provided.  This tool allows users 
to browse LabVIEW VI files, select a particular VI and then run the VI 
from the Origin environment.  The Browser also allows for exchange of 
data between Origin and LabVIEW. 
These connectivity features require LabVIEW and Origin to be installed 
on the same computer.  LabVIEW versions 5.0, 6.1, and 7.0 are 
supported.  
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Attaching Files to OPJ 
You can now attach files of any type to your Origin Project (OPJ) files; 
you are not limited to file types recognized by Origin.  So, when sharing 
files with colleagues, in addition to Origin C (.c) and LabTalk Script 
(.ogs) or Excel files, you can include Word Documents, PDFs, images 
etc.  

Special handling of Origin C and OGS files 
attached to OPJ 
All Origin C files that are attached to the project are compiled and loaded 
when the project is opened.  All functions defined in the Origin C files 
are thus automatically available when the project is opened.  
Similarly, script sections of any attached OGS become usable once the 
project is opened.  For example, if you were to attach a file named 
MyScripts.OGS, then when the project was reopened it would be 
possible to issue a command from the interface such as: 
Run.section(MyScripts, MySection) 

Origin looks to see if there is a file called MyScripts.OGS that is 
attached to the recently open OPJ, then searches for a MySection 
section within that OGS file.  If found, that section will be run.  If no 
such file is found attached, then Origin will search your User Files area, 
and then finally in the EXE path. 
This feature makes it possible to attach your custom codes to an OPJ file 
in order to create self-contained custom applications. 

Attaching and Retrieving Files 
Presently, you must use the Code Builder IDE to attach and view files 
attached to the OPJ.  Access to attached files from the main Origin 
interface (such as Project Explorer) will be added in a future version. 
To attach a file to the OPJ file, you open Code Builder, right-click on the 
Project subfolder in the Workspace tree, then navigate to and select the 
file that you want to attach (you can also drag-and-drop files from other 
folders such as User and Temp folders into the Project folder).   
Subsequently, when you save the OPJ file (from the Origin interface), 
files in the Project folder are appended and saved with the OPJ.   The 
Project folder tracks with the Origin Project (OPJ) file.  The contents of 
this folder do not change when you change your workspace in Code 
Builder. 
To learn more about this feature, see the section Sharing Origin Project 
Support Files in the Origin Help file (Help:Origin). 
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Graphing 

Themes 
Origin’s new Themes feature allows to copy visual elements of one 
object or graph and apply them to an object, a selection of objects, a 
graph, all graphs in a folder, or all graphs in a project.  This makes it 
possible to make one graph look like another graph with just a couple of 
mouse clicks.  
Quickly apply a uniform set of format options to you old graphs, or give 
a consistent look to graphs that you have received from various project 
collaborators.  Develop a set of Themes that allow you to quickly apply a 
different suite of format options to your graphs as might be required by 
different publications, applications, etc.  Develop what are called System 
Themes and apply a consistent and distinctive look to every graph that 
you create. 

Basic Use 
Basic application of the Themes feature is straightforward:   

1. Right-click on the source object or graph and select Copy 
Format from the shortcut menu; a submenu offers All or a 
subset of all applicable properties. 

2. Right-click on your target selection or graph and choose Paste 
Format to apply your Theme. 

 

 
 

You can also right click and select Save Format as Theme.  This opens 
a dialog box in which you name and save the Theme (with All or a subset 
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of all applicable properties) and (optionally) designate the copied 
information as the System Theme. 

Theme Gallery 
A Theme Gallery allows for managing Themes (adding, duplicating, 
deleting or editing) as well as applying a selected Theme or setting the 
System Theme. 

Theme Editing 
Themes are fully editable, allowing you to tweak your format options, as 
needed.   

Theme Properties Filtering 
You can systematically manage the application of Theme attributes by 
excluding certain Categories and Property Types. 
 

 

Group Incremental Theme Lists 
Group Incremental Lists are a subset of the Themes concept.   Group 
Incremental Lists apply to data sets that are grouped within a layer.  
Grouping is the default behavior when multiple data sets (columns) are 
selected and plotted via the Plot menu.  When grouped data sets are 
plotted, plot characteristics such as line color, symbol type, symbol color, 
etc., are automatically incremented by data set. 
Prior to Origin 7.5, the lists that Origin used to increment plot 
characteristics (Color Palette, Symbols, Line Styles, etc.) could only be 
used in their entirety.  This could occasionally be troublesome.  For 
instance, if you plotted 18 grouped data sets and the 18th color in the 
color list was White, your plot would not show up on a white 
background. 
Now you can quickly create short lists such as… 

Red, Green, Blue 
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Up Triangle, Right Triangle, Down Triangle, Left Triangle 
…that include only the colors, symbol shapes, fill patterns, etc. that you 
find useful.  

 

You can choose which properties you want to increment (as before), and 
you can also choose whether the property lists should be used in a 
Concerted manner (as before) or in the new Nested manner which 
exhausts the elements of the first list before incrementing the elements in 
the next ordered list.  
Nested is particularly useful with a short incremental list.  As an 
example, you might elect to increment Symbol Shape from Square and 
Circle and Symbol Color from Red and Green.  Previously, or with the 
Origin 7.5’s Concerted incrementing method, you would be limited to 
two differentiating sets of plot characteristics – Red Square and Green 
Circle (all attributes are incrementing in a concerted manner).  However, 
if you opt to increment with the new Nested method, you could then 
differentiate between four data sets -- represented by Red Square, Red 
Circle, Green Square, Green Circle. 

The Plot Setup Dialog Box 
The Plot Setup dialog box provides a flexible interface for adding or 
removing data sets from your graph windows.  You can add or remove 
any data set in the Origin project to your graph and you can do so 
without the need to change the column Plot Designations that control 
how the data plot in the graph (as X, Y, error bar, label, etc.). 
Additionally, as you add plots to your graph windows, you can use the 
graph window's current plot type or you can add plots of a different type 
(within limits) "on the fly."  Thus, it becomes a simple process to mix 
plot types such as line, scatter, line & symbol, column, etc. 
Use the Plot Setup dialog box to create 2D plots as well as 3D scatter , 
trajectory, bar, ribbon, wall, and waterfall plot types.  
• Create a simple graph. 
• Add plots to a specific graph template. 
• Add, remove, or replace plots in a graph window. 
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• Add data plots to a graph using the worksheet column Plot 
Designation. 

• Add data plots to a graph without regard to worksheet column Plot 
Designation. 

The Plot Setup dialog box replaces the Select Columns for Plotting 
dialog box..  Plot Setup also incorporates the functionality of the familiar 
Layer n dialog box (though the Layer n dialog box has been retained), 
allowing you to streamline your graphing tasks. 

Style Toolbar Support for Plot Formatting 
In Origin 7, we introduced the Style toolbar as a means of quickly 
formatting annotation objects such as text, lines, rectangles,  etc.  In 
Origin 7.5, we have added support for changing actual data plot attributes  
-- line & symbol colors, line style and width, fill patterns and colors, etc.   

 

For grouped data sets, the edge and fill-color drop-down lists support the 
new Group Incremental List feature, allowing you to quickly apply 
previously saved incremental color lists to your Origin graphs.  This lets 
you apply different color or gray-scale schemes to your grouped data 
plots with a couple of mouse clicks. 
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Improved Layer Tool 
The Layer Tool has been redesigned.  The functionality of the tool has 
not changed from previous versions, but the user-interface has been 
modified in order to make the tool more user-friendly. 
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Analysis 

AutoUpdate of Set Column Values 
The Set Column Values feature lets you define data set values as a 
function of data values in other worksheet columns.  Formulae can refer 
to… 

other columns in the same worksheet using the col(name) notation. 

columns in other worksheets, using the wksname_colname 
notation.  

…and can make use of Origin’s built-in math and statistical functions as 
well as compiled Origin C functions that take double or vector as an 
argument. 
The new AutoUpdate of Set Column Values feature permits dynamic 
updates of target data set values whenever source data set values change. 
For example, if you have two worksheets named Data1 and Data2, and 
you define a formula for column B in worksheet Data2 as… 
Col(B) = Col(A) + Data1_B; 
…then, when values in Col(A) of Data2 or col(B) of Data1 changes, then 
the values in Col(B) of worksheet Data2 are automatically updated 
The AutoUpdate feature can be turned on or off via an AutoUpdate 
check box in each data set’s Set Column Values dialog box. 

Indication and Execution of the AutoUpdate 
Mechanism 
Columns that set to AutoUpdate are marked by a lock symbol that 
displays in the column heading.  This is to indicate that the values in the 
target data set – Col(B) in the figure – cannot be edited directly.   

 
Whenever column values require an update, the lock symbol changes to a 
yellow “caution light” symbol.  Under normal circumstances, Origin 
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operates in Smart Mode, performing the column values updates 
automatically (so you may see the “yellow light” only briefly).  By 
default, the maximum amount of idle time required for Origin to trigger 
the AutoUpdate mechanism is set at 2 seconds.  This is controllable by 
way of a LabTalk system variable (see the next section.). 

Programming the AutoUpdate Feature 
The AutoUpdate process is triggered when Origin is idle (as is usually 
the case when operating in the user interface). When programmatically 
updating source data,  you can program an update for subsequent 
processing of updated data values. 
A new @AU system variable controls the enabling or disabling of the 
AutoUpdate feature  (@AU=1: AutoUpdate is ON; @AU=0: 
AutoUpdate is OFF). 
The new @AUS variable – the AutoUpdate Saturation time – controls 
the maximum idle time to triggering of an AutoUpdate. 

Programming 

GetN Dialog Box 
The GetN (Get Number) dialog box is a dynamically generated, 
powerful, and easy-to-use graphical-user-interface device.  It supports 
input from a variety of user-specified interface controls, validates 
numeric input, then directly stores entered values in a user-defined tree 
structure.  Values stored in the tree structure are subsequently accessible 
by the calling program.   
The GetN dialog box includes OK and Cancel buttons and, optionally, 
an Apply button.  Event handling on user entry is also supported.  

Core Concept 
To create a GetN dialog box, you only need to define an Origin C Tree 
structure and then pass it as an argument to the Origin C function 
GetNBox.  The tree, and the nodes of the tree, are declared and 
initialized by calling one of several predefined Origin C macros.  Each 
macro declares a type of node in the tree and each type of node is 
associated with a particular type of user interface control.  The tree is 
passed to the GetNBox function which, in turn, opens the GetN dialog 
box and dynamically creates the associated user interface controls for 
each node in the declared tree. 
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Using GETN Macros to Create a Dialog 
The GetN dialog box supports a number of different types of user 
interface controls each of which has its own predefined Origin C macro.  
The GetN macros are used to create an Origin C tree that is then passed 
as an argument to a function named GetNBox.  The GetNBox function is 
a global Origin C function:  
bool GetNBox(TreeNode& trNode, LPCSTR lpcszTitle=NULL, 
LPCSTR lpcszDescription=NULL, PAPPLY_FUNC pfn = NULL, 
PEVENT_FUNC pEvtFn = NULL, HWND hWndParent = NULL); 

It takes a GetN tree as its first argument, a dialog title as its second 
argument, a dialog description as its third argument, a pointer to an apply 
function as its fourth argument, a pointer to an event handler function as 
its fifth argument, and a window handle to the dialog’s parent window as 
its sixth argument.   
The GetNBox function returns a value of type bool equal to true 
when the dialog box is closed by clicking the OK button and equal to 
false when the dialog box is closed by clicking the Close or Cancel 
buttons. 

Adding an Apply Button 
Well designed tools allow users to change input values and execute the 
tool a number of times without having to re-open and initialize the tool 
each time.  The GetN dialog box supports this feature by allowing 
developers to add an Apply button.   
To add an Apply button to a GetN dialog box, simply pass a pointer to a 
function as the fourth argument to the GetNBox function.  The GetNBox 
function dynamically adds an Apply button to the GetN dialog box and 
automatically executes the function whose pointer is passed when the 
Apply button is clicked.   
The Apply button function can have any name but must accept an Origin 
C Tree object as its only argument.  The Apply button function should 
return a value of type bool equal to true if the dialog needs to be 
refreshed (for example, if the event handler changes the value of a 
control on the dialog) and should return a value of false if the dialog 
does not need to be refreshed.  When the Apply button is clicked the 
current values entered in the GetN dialog box are saved in the GetN tree 
which is then passed to the Apply function defined by the developer. 

Running Code when Users Change a Value 
It is sometimes useful to run code when users change a value in a dialog 
box.  For example, a developer may want to hide, show, disable, or 
enable other controls on a dialog based on the changing value of a 
checkbox.  The changing of a value in a dialog box is sometimes known 
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as an event and the function or code that gets run when a value is 
changed is often known as an event handler. 
The GetN dialog box supports the running of code when a value in the 
dialog box is changed by allowing developers to specify an event handler 
function.  To specify an event handler function for a GetN dialog box, 
simply pass a pointer to a function as the fifth argument to the GetNBox 
function. 

Adding Push Button Controls  
When collecting input it is sometimes convenient to allow users to select 
desired objects rather than having to enter information by keystroke.  For 
example, an edit box control used to request the path to a file or folder 
could be set by typing in the path or by browsing to and selecting the file 
or folder using a Window’s-like “file open” dialog box.   
The GetN dialog box supports this mechanism by pairing a string edit 
box control with a push button control.  When the push button is clicked 
the GetN dialog triggers the dialog event handler function which in turn 
can execute code that opens a “file open” or “browse” dialog. 
To learn more about the GetN dialog box, see the Programming Help file 
(Help:Programming). 

Origin Automation Server Support 
The Microsoft Component Model (COM) is a software architecture that 
allows applications to be built from binary software components.   COM 
is the underlying architecture that forms the foundation for higher-level 
software services, like those provided by OLE (Object Linking and 
Embedding).  COM provides a means by which two applications can 
communicate by calling each other’s methods. For example, Microsoft's 
Internet Explorer web browser supports calling COM objects through 
script, making it possible to create Web pages that tap into the 
functionality of other applications.  
OriginPro 7 added COM client support to the Origin C programming 
environment.  This allowed OriginPro to access COM components of 
other applications (such as Microsoft Word, Excel) from OriginPro.  
While Origin C COM client code could only be compiled in OriginPro, 
the pre-parsed file (.OP file) was distributable to standard Origin users. 
Origin 7.5 adds Automation Server functionality, whereby other 
applications (such as Microsoft Excel or Internet Explorer) communicate 
with Origin via COM.   
While Automation Server programming is supported in the standard 
version of Origin, OriginPro adds access control for multiple clients 
(such as multiple web pages) to communicate with a single instance of 
OriginPro.  
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To learn more about COM and Origin Automation Server Support, see 
the COM Programming and Origin Automation Server Reference 
sections of the Programming Help file (Help:Programming)  

Active-X Support for Dialog Builder Tools 
(OriginPro) 
You can now embed third-party ActiveX components in the custom 
dialogs that you create with OriginPro's Dialog Builder technology.  For 
example, some of the new dialog boxes appearing in Origin 7.5 -- the 
Theme Gallery, the Plot Setup dialog box, and certain pages of the 
Import Wizard -- incorporate the VSFlexGrid® Active-X component 
from ComponentOne.  Use this technology to build Data Acquisition 
Systems for real-time display as well as instrument controls.  

User-Defined Class Support in Origin C 
User-defined classes allow Origin C programmers to create objects of 
their own type with user-defined methods and data members.  Origin C 
user-defined classes support the dynamic allocation of objects using the 
new and delete operators, data and function encapsulation with the 
access control keywords public, private, and protected, 
overloading of class methods, class derivation and object inheritance, 
casting, object containership, and polymorphism (or code re-use) with 
virtual functions.  User-defined objects can self-reference using the 
this pointer.  

Limited Long Name Support 
The col() function in LabTalk has been updated so that you can refer to 
columns by the 1st line of the label rather than by the column name itself. 
For example, if you have a worksheet named Data1 with the following 
columns: 

 

you can refer to these columns in a script in this way: 
col(calc) = sqrt(col(engine_temperature)) 

instead of saying 
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col(C) = sqrt(col(B)) 

Special characters, spaces, etc. are permitted in the name string.   
Origin first looks to see if the string used is a legal column name.   
If it is, Origin searches for a column with that name. If no column name 
match is found, it looks for a column label match.   
If the string is not a legal column name, Origin looks to find a match with 
column labels. 
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Chapter 4, Getting Started Using 
Origin 

The Origin Workspace 
When you start Origin, a new project opens displaying a worksheet 
window in the workspace.  The worksheet is one type of window 
available in Origin.  Origin also provides graph (including function 
graph), layout page, Excel workbook, matrix, and notes windows.  
Having various windows allows you to simultaneously view different 
visual representations of your data - such as data in a worksheet versus a 
graph - simplifying data manipulation and analysis.   

Figure 1:  The Origin Workspace and Supported Window Types 
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Menus and Menu Commands 
Origin's menu bar provides commands to perform operations on the 
active window and to perform general operations such as opening a Help 
file or turning on the display of a toolbar.  The menu bar changes as you 
change the active window.  For example, the following figures compare 
the worksheet and graph menu bars. 

Figure 2:  The Worksheet Window Menu Bar 

 

Figure 3:  The Graph Window Menu Bar 

 

Menus are also sensitive to the active window.  For example, the 
following figure compares the worksheet and graph Analysis menus.   

Figure 4:  The Worksheet and Graph Analysis Menus 
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Origin provides two menu "levels" which determine the number of menu 
commands that are available.  By default, Origin displays the "full 
menu", which means that all available menu commands are provided.  
However, Origin also offers a "short menu" level, which provides a 
reduced set of menu commands for performing basic operations only.  To 
activate this reduced set of commands, select Format:Menu:Short 
Menus.  At any time you can re-activate the full set of commands by 
selecting Format:Menu:Full Menus.   
Some menu commands have shortcut keys associated with them.  If 
available, the shortcut key displays to the right of the menu command.  
For example, when a worksheet window is active, you can press 
CTRL+F5 to access Set All Column Values.  (Note:  You can't use a 
shortcut key if the menu is open.)   
Some menu commands also have bitmaps that display to the left of the 
command.  The bitmap indicates that the menu command also has toolbar 
button access.  To access the command from a toolbar, look for the 
toolbar button represented by the command's bitmap.   

Figure 5:  Accessing a Command from a Toolbar 

   

(To learn how to open additional toolbars, such as the Worksheet Data 
toolbar, see "Toolbars" on page 50.)   
To turn off the display of bitmaps in the menus, select Tools:Options to 
open the Options dialog box.  Select the Miscellaneous tab and then clear 
the Display Bitmaps in Menus check box.  After you click OK, you are 
asked if you want to save this setting for future Origin sessions.   
Many commands are also available from shortcut menus.  To open a 
shortcut menu, right-click on the object you want to perform an action 
on.  For example, if you right-click on a text label, the shortcut menu in 
the following figure opens.   

Figure 6:  Opening a Shortcut Menu 
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Toolbars 
Origin provides toolbar buttons for frequently used menu commands.  As 
with menu commands, some toolbars are only available when a particular 
window (for example, a worksheet) is active.  Additionally, a toolbar that 
is available for multiple window types may contain buttons that are 
window-sensitive.   
When you position the mouse pointer over a toolbar button, a view box 
opens displaying the button name, which indicates its purpose.  A more 
detailed description also displays in the status bar.   

Figure 7:  Viewing a Button's Name and Purpose 

 

If you open Excel workbooks in Origin, when you change the active 
window from an Excel workbook to any other window type (for 
example, a worksheet), or when you close an Excel workbook, the 
toolbar region displays a blank area where the Excel toolbars were 
located (see the following figure).   

Figure 8:  Blank Area in the Toolbar Region 

Blank area where the Excel toolbars were located.
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To open the Options 
dialog box when an 
Excel workbook is 
active, select 
Window:Origin 
Options.   

This area is called a toolbar spacer.  To hide the toolbar spacer, right-
click in the region and select Hide Toolbar Spacer from the shortcut 
menu.  When you re-activate the Excel workbook window or re-open a 
workbook, Origin will automatically show the toolbar spacer with the 
Excel toolbars.  (To prevent Origin from using the toolbar spacer, select 
Tools:Options to open the Options dialog box.  Select the 
Miscellaneous tab and then clear the Use Toolbar Spacer check box.  
After you click OK, you are asked if you want to save this setting for 
future Origin sessions.) 

When you first start Origin, the following toolbars are available:  
Standard, Graph, Format, Style, Tools, and 2D Graphs. 

Figure 9:  The Standard Toolbar 

 

The Standard toolbar provides buttons for opening, saving, and creating 
new projects and windows, and for importing ASCII data.  It also 
provides buttons for general window operations such as printing, 
duplicating, and refreshing windows.  The Standard toolbar provides 
buttons for opening Project Explorer, the Results Log, the Script 
window, and Code Builder.  A button is provided for custom 
programming.  A button is also provided for adding a column to the 
worksheet.   

Figure 10:  The Graph Toolbar 

 

The Graph toolbar is available when a graph or layout page is active.  It 
provides buttons to zoom in and out and to rescale axes to show all the 
data.  It provides buttons to display data plots in multiple layers, display 
layers in multiple windows, and to merge windows.  Labeling buttons are 
available for legends and a time/date stamp.   
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Figure 11:  The Format Toolbar 

 

The Format toolbar is available when a text label is active.  This toolbar 
provides text formatting buttons.  Color control is available from the 
Style toolbar.  

Note:  The Greek button  uses the Symbol font set.  To associate the 
button with a different font set, select Tools:Options to open the Options 
dialog box.  Select the Text Fonts tab and then select the desired font set 
from the Greek drop-down list.   

Figure 12:  The Style Toolbar 

 

The Style toolbar is available when a text label, or other annotation is 
selected.  It provides buttons to set the line and fill color, style, and point 
size.   
The Style toolbar can also be used to edit plot characteristics of line, line 
& symbol, column and bar plots.  When editing plot characteristics, use 
the toolbar drop-down lists to set such things as data plot line color, line 
width, symbol color, fill pattern, fill pattern color, etc. 

Figure 13:  The Tools Toolbar 

 

The Tools toolbar provides text, arrow, line, and other annotation 
buttons.  It also provides buttons to enlarge a region of a graph.  The 
Tools toolbar also provides buttons to read the XY (and Z, if 3D or 

contour) location on the page , and the XY (and Z) location of a data 

point .  You can also define a range of data .  Furthermore, a 

button is provided to draw a data plot .   
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For more information on the Screen Reader, Data Reader, and Data 
Marker buttons, see "Tutorial 2, Exploring Your Data".   

Note:  If you are viewing an image in a matrix, you can display the 

Rectangle tool in the "region of interest" mode .  The region of 
interest mode allows you to select a region of the image to crop, copy, or 
duplicate.  The region of interest mode is controlled from the 
Tools:Show Tools as ROI menu command.   

Figure 14:  The 2D Graphs Toolbar 

 

The 2D Graphs toolbar is available when a worksheet, Excel workbook, 
or graph window is active.  It provides buttons for the common 2D graph 
templates, and for accessing a custom graph template.   
• When a worksheet or Excel workbook is active, first select the data 

that you want to plot and then click the button on the 2D Graphs 
toolbar to plot your data.  

• When a graph window is active, you can change the graph type (for 
example, from scatter to column) for the active data plot.  To 
activate a data plot, select the data plot from the Data menu.  Then 
click the button on the 2D Graphs toolbar to change the graph type.   

In addition to these default toolbars, you can open the following 
additional toolbars.  To do this, select View:Toolbars to open the 
Customize Toolbar dialog box.  Then select the desired toolbar from the 
Toolbars tab.   

Figure 15:  The Edit Toolbar 

 

The Edit toolbar provides cut, copy, and paste buttons.   
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Figure 16:  The 2D Graphs Extended Toolbar 

 

The 2D Graphs Extended toolbar is available when a worksheet, Excel 
workbook, or graph window is active.  It provides buttons for the 
additional 2D graph templates not accessible from the 2D Graphs toolbar.  

Figure 17:  The 3D Graphs Toolbar 

 

The 3D Graphs toolbar is available when a worksheet, Excel workbook, 

or matrix is active.  The first two buttons  are available for 

plotting XYZ data.  The next four buttons  are 
available for plotting XYY data.  The remaining buttons 

 are available for 

plotting matrices.  The last button, the Image Plot button , is 
available for plotting images.   

Figure 18:  The 3D Rotation Toolbar 

 

The 3D Rotation toolbar is available when a 3D graph is active.  This 
toolbar provides buttons to rotate the graph and change the perspective.   

Figure 19:  The Worksheet Data Toolbar 
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The Worksheet Data toolbar is available when a worksheet is active.  
This toolbar provides buttons to perform statistics on columns or rows of 
data, sort, use functions to set column values or mathematically 
transform values, update these column values, and fill columns with row 
numbers or random numbers.   

Figure 20:  The Column Toolbar 

 

The Column toolbar is available when a worksheet column is selected.  It 
provides buttons to set the column plotting designation and to move 
columns.   

Figure 21:  The Layout Toolbar 

 

The Layout toolbar is available when a layout page is active.  It provides 
buttons to add pictures of graphs or worksheets to the layout page.  

Figure 22:  The Mask Toolbar 

 

The Mask toolbar is available when a worksheet or graph is active.  This 
toolbar provides buttons to mask data from analysis.   

Figure 23:  The Object Edit Toolbar 

 

The Object Edit toolbar is available when one or more annotation objects 
are selected in the active window, or when more than one picture is 
selected in a layout page.  The toolbar provides buttons to align the 
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selected objects/pictures, and to change the drawing order of the 
objects/pictures.  Buttons are provided to group objects so that you can 
move or align the group.  Additionally, buttons are provided to change 
the drawing order of objects relative to data plots.   

Figure 24:  The Arrow Toolbar 

 

The Arrow toolbar is available when one or more lines or arrows are 
selected.  This toolbar provides buttons to align multiple lines/arrows, 
and to customize the arrow head.   

In addition to adding Origin's default toolbars to your workspace, you 
can add and remove buttons from any of the default toolbars, or create 
new toolbars containing a single button or a combination of buttons from 
the default toolbars.   
To add and remove buttons from any of Origin's default toolbars, select 
View:Toolbars to enter the toolbar editing mode.  You can now drag 
toolbar buttons between toolbars.  To remove a button from a toolbar, 
drag the button off the toolbar (not on to another toolbar) and release the 
mouse button.  To add a button to a toolbar, select the Button Groups tab 
on the Customize Toolbar dialog box.  From the Groups list box, select 
the toolbar which displays the button by default.  Then drag the desired 
button onto any of the toolbars. 
To create a new toolbar, you can drag a button into the workspace or into 
the toolbar region (not on to another toolbar).  Alternatively, click New 
on the Toolbars tab of the Customize Toolbar dialog box.  Type the 
desired name in the New Toolbar dialog box and click OK.  Now select 
the Button Groups tab and drag the desired buttons onto the new toolbar.   

Figure 25:  Creating a New Toolbar 
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Window Types 
Origin provides a number of window types for viewing, analyzing, and 
presenting your data.  These windows include worksheet, matrix, Excel 
workbook, graph, layout page, and notes windows.  The window type 
that is currently active in the Origin workspace determines the menu bar 
and toolbars that are available.   

Worksheet Windows 
A worksheet's primary function is to hold and organize the data that you 
bring into Origin, and to provide tools for data manipulation, exploration, 
statistics, analysis, and plotting.   
The columns in a worksheet are related to one another by their plotting 
designation (such as X and Y) and their location.  The plotting 
designation determines how the selected data will plot.  For example, in 
the following worksheet, if you select columns A through E and then 

click the Line & Symbol button  on the 2D Graphs toolbar, columns 
A and B, C and D, and C and E will plot as XY pairs.  

Figure 26:  Worksheet Column Plotting Designations 
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Worksheet Menu Bar 

 
 

Origin 7.5 features a 
new Import Wizard.   
To learn more see 
Chapter3, What’s New 
in Origin 7.5 .   

The File menu provides Origin project and window 
commands that are available independent of the active 
window.  When a worksheet is active, the File menu 
also provides commands to: 
• import and export data    

Undo is available for 
most worksheet 
operations, but it is not 
available for all Origin 
operations.   

The Edit menu provides cut, copy, paste, and undo commands that are 
available independent of the active window.  Additionally, a "button edit 
mode" command is available for editing programmed labels.  When a 
worksheet is active, the Edit menu also provides commands to:  
• set the worksheet display range 
• convert the worksheet to a matrix 
• transpose and paste transpose   
The View menu provides commands to control the display of the Project 
Explorer window, toolbars, status bar, and Results Log.  It also provides 
a command to display a grid for aligning objects.  These commands are 
available independent of the active window.  When a worksheet is active, 
the View menu also provides commands to: 
• update a graph after changing the worksheet data  
• go to a specified worksheet row  
• show a hidden X column 
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Select your data first.  
Then select the Plot 
menu command.   

The Plot menu is only available when a worksheet, matrix, or Excel 
workbook is active.  The Plot menu provides commands to: 
• plot data into a specified graph template 

Select your column first.  
Then select the Column 
menu command.   

The Column menu is only available when a worksheet is active.  This 
menu provides commands to:set the column's plotting designation 
• use functions to set column values or mathematically transform 

values 
• add and move columns  
The Analysis menu provides commands to: 
• extract data 
• sort data 
• normalize data 
• perform FFT-related operations 
• perform nonlinear curve fitting 
The Statistics menu is only available when a worksheet is active.  This 
menu provides commands to: 
• perform a number of statistical tests on your data 
The Tools menu command provides commands to set global preferences 
in the Options dialog box, re-activate reminder messages, and pack 
selected files into a single file to share with other Origin users.  These 
commands are available independent of the active window.  When a 
worksheet is active, the Tools menu also provides commands to: 
• associate LabTalk script with the worksheet 
• perform linear, polynomial, and sigmoidal fitting 
• compare two columns of data by fitting the same function to the data 
The Format menu provides commands to display a reduced menu 
structure in which only basic operations are available, to edit the name 
and programming-related properties of a label, and to align objects to a 
grid.  These commands are available independent of the active window.   
Additionally, the worksheet Format menu provides commands to: 
• set the worksheet or column display options 
• set incremental X values in a worksheet without a designated X 

column   
The Window menu provides commands to arrange the windows in the 
workspace, open the Script window, activate a Project Explorer folder, 
and activate a window in the workspace.  These commands are available 
independent of the active window.  
The Help menu provides commands to open the Origin and 
programming-related Help files, open a dialog box with tips on using 
Origin, go to the OriginLab web site, and register your copy of Origin.  
These commands are available independent of the active window.   
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Graph Windows 
A graph window is a container and editor for creating graphs.  Each 
graph window contains a single editable page.  The page serves as a 
backdrop for the various graph objects, including layers, axes, 
annotations, and data plots.  
There are many ways to create graphs in Origin.  The easiest method is to 
select the worksheet data that you want to plot, and then select the 
desired graph type from the Plot menu or from one of the plotting 
toolbars.  If you've already created a graph window, you can select and 
drag data from a worksheet into the graph window.   

Figure 27:  A Graph with Multiple Layers 

 

Graph Menu Bar 

 

(See the Worksheet Menu Bar for commands that are available for all 
window types.) 
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When copying or when 
exporting to a vector 
image file, you can 
control the graph size 
from the Options 
dialog box 
(Tools:Options, Page 
tab).  

The File menu provides graph-specific commands to: 
• import ASCII data 
• import an image file 
• export the graph to an image file 
The Edit menu provides graph-specific commands to: 
• copy a graph to the clipboard 
• add and arrange layers in the active graph 
• rotate the graph between landscape and portrait orientation 
• merge all the graph windows into one window  
The View menu provides graph-specific commands to: 
• view the graph using the screen driver or active printer driver 
• zoom in and out of the graph 
• show or hide elements in the graph 
• resize the active graph layer so that it fills the page 
• resize the graph window so that it fills the screen 

You can also drag data 
from a worksheet or 
Excel workbook into a 
graph.   

The Graph menu provides commands to: 
• add data to the graph, including error bars or a function 
• rescale the axes and exchange the X and Y axes 
• create a new legend or color scale for color mapped data 
• stack grouped data (most useful for column and bar charts) 

You can open the Plot 
Details dialog box for 
a data set by pressing 
CTRL and selecting it 
from the list. 

The Data menu provides graph-specific commands to: 
• set the display range 
• move and remove data points 
The Data menu also lists the data sets that are plotted in the active 
graph.  The active data set is checked.   
The Analysis menu provides graph-specific commands to: 
• perform linear and nonlinear fitting 
• perform math operations 
• smooth or filter the data 
• differentiate and integrate 
• perform a subtraction or translation 
• average curves 
• perform interpolation and extrapolation 
• perform an FFT 
The Tools menu provides graph-specific commands to: 
• open analysis and fitting tools 
• open a tool for adding and arranging layers 
• compare two sets of data by fitting the same function to the data 
The Format menu provides graph-specific commands to: 
• set the page, layer, data plot, and axes display options 



 

 

Chapter 4, Getting Started Using Origin 

62 •  The Origin Workspace 

 

 

 

Layout Page Windows 
A layout page window is a “display panel” for graphs and worksheets 
that have been created in other windows.  You can add and arrange 
worksheet and graph pictures in a layout page, as well as text and other 
annotations.   

Figure 28:  A Layout Page Window 

 

Layout Page Menu Bar 

 

(See the Worksheet Menu Bar for commands that are available for all 
window types.) 

When copying or when 
exporting to a vector 
image file, you can 
control the size from 
the Options dialog box 
(Tools:Options, Page 
tab).  

The File menu provides layout page-specific commands to: 
• import an image file 
• export the layout page to an image file 
The Edit menu provides layout page-specific commands to: 
• copy a layout page to the clipboard  
• rotate the layout page between landscape and portrait orientation 

The View menu provides layout page-specific commands to: 
• view the layout page using the screen driver or active printer driver 
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• zoom in and out of the layout page 
• show master page items in the layout page 
The Layout menu is only available when a layout page is active.  This 
menu provides commands to: 
• add pictures of graphs or worksheets 
• view picture placeholders to increase redraw speed 
• view pictures using the screen driver to increase redraw speed 
The Format menu provides layout page-specific commands to: 
• set the page display options 

Excel Workbook Windows 
You can open Excel workbooks inside Origin, combining Origin's 
plotting and analysis power with Excel's spreadsheet tools.  To plot your 
workbook data in Origin, you must have Excel version 7 (Microsoft 
Office 95) or later installed on your computer either as a local or network 
copy.   

Note:  When you change the active window from an Excel workbook to 
any other window type, the toolbar region displays a blank area where 
the Excel toolbars were located.  To hide this spacer, right-click in this 
region and select Hide Toolbar Spacer from the shortcut menu.   

Figure 29:  Opening an Excel Workbook in Origin  
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Excel Workbook Menu Bar 

Origin menus.

 

To open the Origin 
Help file, right-click on 
the workbook title bar 
and select Help 
Contents from the 
shortcut menu.  

When an Excel workbook is active in Origin, the menu bar displays both 
Origin and Excel menus.  The File, Plot, and Window menus are Origin 
menus.  All other menus are Excel menus.   
The File menu provides Origin project and window commands. 
The Plot menu provides commands to plot data into a specified graph 
template.   
The Window menu provides commands to: 
• set global preferences in the Options dialog box 
• control the display of the Project Explorer window, toolbars, and 

Results Log 
• convert an Excel workbook to a matrix using direct conversion 
• arrange the windows in the workspace, open the Script window, 

activate a Project Explorer folder, and activate a window in the 
workspace 

Matrix Windows 
A matrix displays a single data set containing Z values.  Instead of 
displaying the data set as a column in a worksheet, a matrix displays the 
data in a specified dimension of rows and columns.  A matrix is linearly 
mapped in X by columns and linearly mapped in Y by rows.  By default, 
the column and row numbers display in the column and row headings.  
To display the X and Y values, select View:Show XY.   

Figure 30:  Showing the X and Y Matrix Values 
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Origin provides a number of methods for converting a worksheet to a 
matrix.  This includes direct conversion, 2D binning, converting regular 
XYZ data, and converting random XYZ data using gridding.  These 
conversion methods are available from the worksheet's Edit:Convert to 
Matrix submenu.   
When a matrix is active, you can create 3D, surface, contour, and image 
plots.   

Matrix Menu Bar 

 

(See the Worksheet Menu Bar for commands that are available for all 
window types.) 
The File menu provides matrix-specific commands to: 
• import and export data  
• import and export image files 
The Edit menu provides matrix-specific commands to: 
• convert the matrix to a worksheet 
The View menu provides matrix-specific commands to:  
• when viewing an image, zoom in and out of the image 
• when viewing data, go to a specified row 
• switch between data mode and image mode  
• show the column and row numbers or show the XY mapping for the 

Z values 
The Plot menu provides commands to plot data into a specified graph 
template.   
The Matrix menu is only available when a matrix is active.  This menu 
provides commands to: 
• set matrix properties such as the internal data type and the display 

format 
• set the matrix dimensions and the XY mapping relationship 
• use functions to set the matrix values or mathematically transform 

values 
• transpose, invert, shrink using averaging, expand using bilinear 

interpolation, smooth, or integrate the matrix  
The Image menu is only available when a matrix is active.  This menu 
provides commands to: 
• display images using selected color palettes 
• open a tool to adjust the brightness and contrast in the image  
The Tools menu provides matrix-specific commands to: 
• display the Tools toolbar tools in the "region of interest mode" for 

selecting a region to copy, crop, or create a new matrix 
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Notes Windows 
Notes windows can contain only text, and are thus used for recording 
information.   

Figure 31:  A Notes Window 

 

Notes Menu Bar 

 

(See the Worksheet Menu Bar for commands that are available for all 
window types.) 
The View menu provides notes-specific commands to: 
• enable word wrapping 

Project Explorer 

Project Explorer is 
shown or hidden by 
clicking the Project 

Explorer button  on 
the Standard toolbar.   

Project Explorer is a tool to help you organize your Origin projects.  It is 
particularly useful if you are working with a project that contains more 
than a few windows.  You can use Project Explorer to develop a folder 
structure for organizing the windows in your project.  You can also use 
Project Explorer to control the view of your workspace.   

When you first start Origin, Project Explorer displays docked to the 
bottom edge of the workspace.  You can dock it to any other edge or 
display it as a window in the workspace.  To prevent Project Explorer 
from docking when positioning it as a window, press CTRL while 
dragging.   
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Figure 32:  Project Explorer 

 

To create a new folder, right-click on the project folder (or a subfolder) 
and select New Folder from the shortcut menu.  Once you have created 
one or more subfolders, you can move windows between folders.   

Figure 33:  Creating a New Folder 

 

In addition to adding and moving folders, Project Explorer also controls 
the view of your workspace.  By default, only the windows in the active 
Project Explorer folder display in your workspace.  For projects with lots 
of windows, this allows you to focus on specific windows in a clutter-
free workspace.   
To control the view of the windows in your workspace, right-click on a 
Project Explorer folder or right-click in a blank space on the left side of 
Project Explorer.  Select View:View Mode to alter the view mode.  
(Alternatively, select View:View Windows:View Mode from the Origin 
menu bar.)   
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Figure 34:  Controlling the View of Windows in the Workspace 

 

After you organize your windows into multiple folders, Project 
Explorer's Find dialog box helps you locate windows in your project.  To 
open this dialog box, right-click on the Project Explorer folder that you 
want to start your search from and select Find from the shortcut menu.  
If you are unsure of the window location within your Project Explorer 
folder structure, right-click on the main project folder and select Find.  

Figure 35:  Finding Windows in Your Project 

 

Because Project Explorer uses some of your workspace, you may want to 
close Project Explorer, even if you have already created a folder 
structure.  To close Project Explorer, click the Project Explorer button 

 on the Standard toolbar.   
When Project Explorer is closed, Origin continues to use your folder 
structure and view settings to display the windows in your workspace.  
Thus, if you are working with a project that contains subfolders, and the 
view mode is set to view only the active folder's windows, then Origin 
will display the windows in your currently active folder.   
To access windows in other folders, you can re-open Project Explorer or 
you can select Window:Folders:Folder Name to view the windows in 
the selected Project Explorer folder.  The window list at the bottom of the 
Window menu updates to reflect the windows in the Folder Name 
folder.   
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Figure 36:  Accessing Folders and Windows from the Menu Bar 

 

Results Log 

When you save an 
Origin project, the 
contents of the Results 
Log is saved with the 
project.   

Origin automatically routes most analysis and fitting results to the 
Results Log.  In most cases, when results are output to the Results Log, 
it opens automatically.  However, to manually open (and close) the 

Results Log, click the Results Log button  on the Standard toolbar.  
Opening and closing the Results Log only controls its view state.  You 
do not lose results by closing the log.   
When the Results Log first opens, it displays docked to the top edge of 
the workspace.  You can dock it to any other edge or display it as a 
window in the workspace.  To prevent the Results Log from docking 
when positioning it as a window, press CTRL while dragging.   
Each entry in the Results Log includes a date/time stamp, the window 
name, a numeric stamp which is the Julian day, the type of analysis 
performed, and the results.   
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Figure 37:  The Results Log 

 

You can right-click in the Results Log to open a shortcut menu with 
commands to copy, print, clear, and view additional results.   

Figure 38:  The Results Log Shortcut Menu 

 

Note:  When you close the Results Log after it has been docked to the 
edge of the workspace, the toolbar region may display a blank area where 
the log was located.  To hide this spacer, right-click in this region and 
select Hide Toolbar Spacer from the shortcut menu.   

Code Builder 
Origin's programming language is called Origin C.  Origin C supports a 
nearly complete ANSI C language syntax as well as a subset of C++ 
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features including internal and DLL-extended classes.  In addition, 
Origin C is "Origin aware".  This means that Origin objects such as 
worksheets and graphs are mapped to classes in Origin C, allowing direct 
manipulation of these objects and their properties from Origin C.   
Origin C's integrated development environment is called Code Builder.  

To open Code Builder, click the Code Builder button  on the 
Standard toolbar.  Code Builder provides tools for writing, compiling, 
and debugging your Origin C functions.  Once an Origin C function is 
compiled, the function becomes accessible from Origin.   

Figure 39:  Code Builder 

 

To learn more about programming in Origin, select 
Help:Programming:Program Guide or review the sample Origin 
projects located in the \Samples\Programming folder.   

Script Window 
The Script Window is available for executing LabTalk commands.  
LabTalk is Origin's first programming language.  It is supported in 
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versions up to and including Origin 7.5.  However, Origin 7.0 introduced 
a new programming language -- Origin C.  Whereas LabTalk scripts are 
interpreted during execution by Origin, Origin C code is compiled to byte 
form and therefore executes much faster than LabTalk.   
Origin C is the preferred programming language in Origin 7.5 but 
LabTalk remains useful for simple operations where speed is not critical.  
Furthermore, you can call Origin C functions that accept basic data types 
such as double and string using LabTalk commands.  These commands 
can be executed from the Script window or from many other locations 
that support LabTalk script (macros, OGS files, button objects, etc.)   

To open the Script window, click the Script Window button  on the 
Standard toolbar.  Note that when you save an Origin project, the Script 
window contents are not saved with the project. 

Figure 40:  The Script Window 

 

To learn more about programming in Origin, select 
Help:Programming:Program Guide or review the sample Origin 
projects located in the \Samples\Programming folder.   

Origin Project Files 
Origin provides sample 
project files in the 
\Samples subfolders.   

An Origin project file contains all the worksheet, matrix, graph, layout 
page, and notes windows that are open in the workspace when you save 
the project.  These windows include minimized and hidden windows, as 
well as windows that are accessible from other Project Explorer folders 
in the current workspace.   
Excel workbook windows are a special case.  If a workbook is open in 
the workspace, the project can be saved with a link to the source 
workbook file, or the workbook can be saved internal to the project. 
• Saving the project with a link to the source workbook file allows you 

to maintain an external Excel file that is updated when changes are 
made to the associated workbook in Origin.  This source file is also 
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available for use in other applications and can be accessed by other 
users. 

• Saving the workbook internal to the project enhances the project's 
portability.  You can open the project on any computer that has 
Origin and Excel installed and have full access to your workbook 
data.   

To control how the workbook is saved with the project, right-click on the 
workbook window title bar and select Properties from the shortcut 
menu.   
In addition to these window types, the contents of the Results Log is 
saved with an Origin project, as well as the current Project Explorer 
folder and window structure.   

Saving a Project 

For information on 
customizing the default 
save path, see 
"Opening an Existing 
Project" on page 75.   

To save a project to the current file name, select File:Save Project.  If 
the project has not been previously saved, this menu command opens the 
Save As dialog box displaying the default file name, UNTITLED.OPJ, 
in the File Name text box.  Type the desired file name in the text box 
(specify the path) and click Save to save the project.   

To save the project to a new file name, select File:Save Project As.  This 
menu command also opens the Save As dialog box.   
If you have developed a folder structure in Project Explorer, you can save 
a selected folder and its subfolders to a new project file.  To do this, 
right-click on the Project Explorer folder that you want to save to a 
project file and select Save As Project from the shortcut menu.   
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Figure 41:  Saving a Project Explorer Folder to an Origin Project File 

 

In this example, the Linked Layers 1 folder and its Raw Data subfolder, 
all the windows that they contain, plus Results Log output specific to 
these windows are saved to a new project file.   

Automatically Creating a Backup 
Origin will automatically create a backup of the currently saved project 
file before re-saving.  Origin renames the saved file BACKUP.OPJ, and 
then saves the altered file using the specified file name.  The automatic 
backup feature is set on the Open/Close tab of the Options dialog box 
(Tools:Options).  

Opening a New Project 
A new project is opened each time you start Origin.  You can also open a 

new project by clicking the New Project button  on the Standard 
toolbar.  In both cases, the new project contains one worksheet window.  
You can, however, customize the new project that opens.  To do this, 
select Tools:Options to open the Options dialog box.  Select the 
Open/Close tab and then modify the Start New Project setting. 
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Figure 42:  Customizing the New Project Setting 

 

You can select from worksheet, Excel workbook, empty graph, matrix, 
ORIGIN.OPJ, or none.  The ORIGIN.OPJ file includes a worksheet and 
a graph window.  The graph window is configured to display a data plot 
of column A (X values) and column B (Y values) automatically, after 
you import or enter data into the worksheet columns.  You can customize 
the ORIGIN.OPJ project file and resave it.  After you click OK in the 
Options dialog box, you are asked if you want to save this setting for 
future Origin sessions.   

Opening an Existing Project 

To open an existing project file, click the Open button  on the 
Standard toolbar and select the desired file from the Open dialog box.   
By default, Origin will keep track of the project file path, so that each 
time you open a project in the current Origin session, the path to the last 
opened file will be selected by default in the Open dialog box.   
To turn off file tracking, select Tools:Options to open the Options dialog 
box, then clear the Track File Dialog Changes check box  
To specify the default project file path, select the File Locations tab.  
Select Origin from the top list box and then click Edit.  This opens the 
File Extension Group Defaults dialog box.   

Figure 43:  Customizing File Tracking 
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• To specify a custom project file path, select User Specified Path in 
the Open Path group and then browse to the desired folder from the 
associated text box.  Click OK. 

• To specify the path to the last opened project file, select Project 
Path in the Open Path group.  Click OK. 

• To specify your Origin folder as the project file path, select Origin 
EXE Path from the Open Path drop-down list.  Click OK. 

• To specify that Origin searches to your User path (chosen when you 
first run Origin) for Origin project files, select User Files Path. 

An Attention dialog box asks if you want to save this setting for future 
Origin sessions.  Click Yes to save for future sessions or No to apply 
settings to the current session only.  

Opening More than One Project 
Origin can only open one project at a time.  To open multiple projects, 
you must start multiple instances of Origin.   

Appending Projects 
The contents of a project can be added to the currently opened project by 
selecting File:Append or by right-clicking on a Project Explorer folder 
and selecting Append Project from the shortcut menu.   
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Figure 44:  Appending Projects 

 

To re-activate the 
display of Reminder 
Message boxes, select 
Tools:Reactivate 
Reminder Messages.   

After you select the project to append, Origin displays a Reminder 
Message asking if you want to append the contents of the new project 
into a new Project Explorer folder or into the current folder.   
If duplicate window names exist between projects, Origin automatically 
changes the name of the appended window by adding an "A" to the 
window name (AWindowName).  For example, in the following figure, a 
project containing a Data1 worksheet is appended to a project that also 
contains a Data1 worksheet.  The appended window is renamed AData1.  

Figure 45:  Renaming Duplicate Window Names when Appending 

 

Project Windows 

To learn how to 
organize your project 
using Project Explorer, 
see "Project Explorer" 
on page 66.   

Project windows include worksheet, matrix, Excel workbook, graph, 
layout page, and notes windows.  You can create and open any number 
of windows in an Origin project.  The only limitation is your machine's 
memory.  However, you should keep your projects manageable by 
limiting the number of windows contained in a project.  You should also 
consider organizing the windows using Project Explorer.    
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Creating a New Window 
To create a new window, click one of the New Window buttons on the 
Standard toolbar.   

Figure 46:  New Window Buttons on the Standard Toolbar 

 

To learn more about 
templates, see 
"Window Templates" 
on page 83.   

These buttons create windows based on a default template.  For 

example, the New Worksheet button  creates a worksheet based on 
the ORIGIN.OTW template.  You can change the template that is 
associated with any of these buttons.  To do this, select File:New to 
open the New dialog box.  To change the template associated with the 
New Worksheet button, select Worksheet from the list box, then select 
the desired template from the Template group.  Click Set Default to 
associate this template with the New Worksheet button.   

Figure 47:  Changing the Template for the New Worksheet Button 

 

You can also use the New dialog box to create new windows based on 
specific templates.   
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Renaming a Window 
To rename a worksheet, matrix, graph, layout page, or notes window, 
activate the window and then select Window:Rename.  Alternatively, 
right-click on the window's title bar and select Rename from the shortcut 
menu.  Both menu commands open the Rename dialog box.   
To rename an Excel workbook window, right-click on the window's title 
bar and select Properties from the shortcut menu.   
When renaming windows, consider the following: 
• The window name cannot start with a numeral.  
• Origin ignores any spaces between characters.   
• The name cannot exceed 13 characters in length (worksheet or 

matrix windows) or 24 characters (graph, function or layout 
windows).  

For greater flexibility in window naming, include the Label field in the 
window title bar.  The label allows more characters and accepts special 
characters (for example, an underscore and dollar sign).  It also allows 
spaces between characters.  

Hiding a Window 
To maximize the use of your workspace, you can hide windows from 
view - without deleting them from the project.  To hide a window in the 
workspace, select the desired window icon on the right side of Project 
Explorer and then double-click on this icon.  To return the window to the 
normal view mode, double-click again on the window icon.  These view 
controls are also available by right-clicking on the window icon in 
Project Explorer, or by right-clicking on the window title bar.   

Figure 48:  Hiding a Window from View 

        

Deleting a Window 

When you delete a 
window, it is no longer 
a part of the project.   

To delete a window from the project, click the X button in the upper-
right corner of the window.  Origin then asks you if you want to hide or 
delete the window.   
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To prevent this verification prompt from displaying, select 
Tools:Options to open the Options dialog box.  Then select the 
Open/Close tab.  In the Window Closing Options group, select how you 
want Origin to respond when you click a particular window type's close 
button.   

Figure 49:  Setting the Close Option for a Window Type  

 

Refreshing a Window 
Whenever you change the contents of a graph window or a worksheet, or 
expose a part of a window that was hidden, Origin automatically redraws 
the affected portion of the window.  Occasionally, a portion of the 
window may not refresh correctly.  Whenever this occurs, click the 

Refresh button  on the Standard toolbar to refresh the active window.   

Note:  To control the percentage of the window that must be exposed 
before Origin automatically redraws the window, select Tools:Options 
to open the Options dialog box.  Select the Miscellaneous tab and then 
edit the No Redraw (% Covered) combination box.   

Duplicating a Window 
To duplicate the active worksheet, graph, matrix, or layout page window, 

click the Duplicate button  on the Standard toolbar.  When a 
duplicate window is created, Origin names the window using the default 
window name syntax: 
DefaultWindowNameN 
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where N is assigned the lowest available number not used by other 
window names (of the same type) in the project.  

Table 1:  Default Window Names 

Window Default Name 
Worksheet  WorksheetN 

Graph GraphN 

Matrix MatrixN 

Layout Page LayoutN 

Function Graph FunctionN 

Saving a Window 
In addition to saving projects, windows (except for layout pages) can be 
saved to a file.  When a window is saved to a file, the window can be 
opened in any other Origin project.  To save the active window to a file, 
select File:Save Window As.  This menu command opens the Save As 
dialog box.  Origin automatically lists the correct file extension for the 
active window type in the Save as Type drop-down list.  

Table 2:  Window File Extensions 

Window File Extension 
worksheet .OGW 

matrix .OGM 

graph .OGG 

Excel workbook .XLS 

notes .TXT 

Opening a Window from a File 

To learn how to 
append projects, see 
"Appending Projects" 
on page 76.   

If you have a window in one project that you want to include in another 
project, you can append the projects.  However, this action will add all 
the windows from a selected project into the currently open project.  To 
"append" only the desired window, you must save the window to a file 
and then open the window in the desired project.  To open a worksheet, 
graph, matrix, or notes window that was saved to a file, click the Open 

button  on the Standard toolbar.  This button opens the Open dialog 
box.  From the Files of Type drop-down list, select:  
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‘Worksheets (*.OGW)’ to open a worksheet window.  
‘Graphs (*.OGG)’ to open a graph or function graph window.  
‘Matrix (*.OGM)’ to open a matrix window.  
‘Text (*.TXT)’ to open a notes window.  
After you open a worksheet, graph, matrix, or notes window file in a 
project and then save the project, the window then remains a part of this 
project.  

To open an Excel workbook file, click the Open Excel button  on the 
Standard toolbar.  After you select your Excel file, a dialog box opens 
asking if you want to open the workbook as an Excel workbook or as an 
Origin worksheet.   

Figure 50:  Opening an Excel Workbook 

 

If you open the workbook as a workbook, you can continue to use Excel's 
spreadsheet tools to process your data, all within the Origin workspace.  
You also have access to Origin's plotting and analysis tools.  When you 
are ready to save your project, you can save the project with a link to 
your source workbook, and update the link, or you can save the 
workbook as part of your Origin project.  When you update the link to a 
(linked) workbook, the updated workbook is available for other 
applications or other users.  
If you open the workbook as one or more Origin worksheets, you have 
no access to Excel's spreadsheet tools in Origin.  Furthermore, the data 
no longer has a connection to the source workbook.  Thus, the changes 
you make to the data are lost to the original workbook. 
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Window Templates 
When you create a new worksheet, graph, or matrix window, (for 

example, by clicking the  ,  , or  button on the Standard 
toolbar), Origin creates the new window based on a template.  The 
template determines the properties of the new window.  For example, if 
the new window is a worksheet, the template determines the number of 
columns in the worksheet, each column's plotting designation and display 
type, the ASCII import settings, and any formulas used to set the column 
values.  If the new window is a graph, the template determines the 
number of layers (sets of XY axes) on the page and their arrangement, 
the types of data plots in each layer (for example, scatter or bars), the 
number of data plots, the axes scale type, and text labels and other 
annotations.  Basically the template determines all the attributes of the 
window, except for the actual data the window will contain.  Data is 
never saved with a template.   
The following table lists the file extensions for the templates.   

Table 3:  Template File Extensions 

Window Template File Extension 
worksheet .OTW 

graph or function graph .OTP 

matrix .OTM 

Origin provides many built-in templates.  For example, most of the graph 
templates are accessible from the plotting toolbar buttons.   

Figure 51:  Plotting Toolbar Buttons 
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Origin also provides a Template Library tool for categorizing and 
accessing graph templates.  To open the Template Library tool when a 
worksheet or an Excel workbook is active, select Plot:Template 
Library.   

Figure 52:  The Template Library Tool 

 

You can also use the Template Library tool to plot your worksheet or 
Excel workbook data.  If you highlighted data in the worksheet or 
workbook before opening the tool, and your data selection is appropriate 
for the template you've selected, then click the Plot button to plot the data 
into the template.  If you did not highlight data or if your selection was 
not appropriate for the template you've selected, then click the Plot 
button to open an intermediary dialog box for data selection.  

To create a custom template, you can modify an existing template or 
create a new template.  The procedure is similar in both cases.  You must 
first open a window based on a built-in template, customize the 
properties of the objects in the window, and then save the window as a 
template.  The instructions on re-building the window are saved with the 
template.  However, any data in the window is not saved with the 
template.   
For example, suppose you want to customize the template associated 

with the New Worksheet button  on the Standard toolbar.  To do this, 

click  to open a new worksheet.  Now customize the attributes of this 
worksheet.  For example, perhaps you always import ASCII data files 
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that contain data in the format X, Y, Y Errors.  In this case, click the Add 

New Columns button  on the Standard toolbar.  Then right-click on 
the new column (C) and select Set As:Y Error from the shortcut menu.   
To save this window as a template, select File:Save Template As.  The 
built-in template ORIGIN.OTW is listed by default in the File Name text 
box.  If you click Save, you will overwrite the built-in template with your 
custom settings.  Alternatively, you can type a new file name to save 
your changes to a new template.   
If you save to a new file name, you can associate the New Worksheet 

button  with this new template file (it is currently linked to 
ORIGIN.OTW).  To do this, select File:New to open the New dialog 
box.  Select Worksheet from the list box.  Then select your new template 
file from the Template group.  Finally, click the Set Default button to 
associate this template with the New Worksheet button.   

Themes 
You can develop and 
apply a System Theme, 
allowing you to give a 
consistent look to every 
graph that you make. 

Themes are a new feature in Origin(Pro) 7.5.  Themes are applied to 
graph windows.  The Theme concept differs from that of the template in 
that selected styles and formats are applied to any plot you make, 
regardless of the settings that have been saved with a particular graph 
template.  Use Themes to copy visual elements of one object or graph 
and apply them to one or more selected objects, a graph, all graphs in a 
folder or all graphs in a project file.  
At a basic level, the Theme concept is simple:   
1. You customize a graph or a graph object (text label, arrow, etc.). 
2. You select the customized graph or object and you copy the format. 
3. You select a target graph or object and you paste the copied format 

to the target. 
A suite of format options (of your choosing) are applied to the target 
graph.  If you wish to save this suite of format options for future use, you 
save them as a Theme (.OTH) file.  A format saved becomes a Theme. 

To learn more about 
Themes, see Chapter 
3, What’s New in 
Origin 7.5. 
 
For an in-depth 
discussion of Themes, 
see the Origin Help file 
(Help:Origin). 

Themes are managed with the Theme Gallery.  Origin(Pro) 7.5 ships 
with a number of pre-built Themes.  You can develop your own custom 
Themes by modifying these or you can develop your own Themes from 
scratch.  A Theme editor (the Theme Editing dialog box) gives you 
control over each Theme property with the option to apply filters which 
broadly exclude categories of stylistic elements or property types from 
the Theme.  
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Tutorial 1, The Origin Workspace 

Origin Windows 
Origin has numerous windows and workspaces available for completing 
various tasks.  The worksheet is the primary structure for organizing 
your data.  On the surface, the worksheet looks much like a conventional 
spreadsheet.  However, its behavior and capabilities are unique.   
When you start Origin, the default workspace opens to display a single 
worksheet named Data1. 
If you have not done so, start Origin.  Note the single blank worksheet 
window named Data1. 

To open a fresh Origin worksheet:  
1. From the menu, choose File:New.   The New dialog box opens. 

 

2. Select Worksheet and click OK.  A second worksheet is added to 
the workspace.  Note that Origin has automatically named the 
worksheet Data2.   
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Notice also that as you opened the new worksheet, the color of the title 
bar of the Data1 worksheet turned gray.  The new worksheet’s title bar is 
now highlighted, indicating that it is the active window in the Origin 
workspace.  Any commands that you issue to Origin, either through the 
user interface (the menus, toolbars, etc.) or programmatically (via 
LabTalk or Origin C), act upon the active window.  It is likely that many 
windows of many different types will be open in the Origin workspace, 
and the color of the title bar is your primary indicator as to which is the 
active window. 
3. Click anywhere on the Data1 worksheet.  The title bar is highlighted 

and Data1 becomes the active window.  The title bar of Data2 is now 
grayed out. 

 

Origin keeps track of the various windows in the workspace by assigning 
a unique name to them.  You can assign your own names to worksheet 
windows, but Origin will not allow you to assign the same name to two 
windows.  Recall that when you opened a second worksheet, Origin 
automatically assigned the name of Data2 to the worksheet to distinguish 
it from Data1.  The necessity for this naming system will become more 
apparent as you work with Origin, but for now, suffice it to say that the 
window name is a unique identifier that allows for manipulation of the 
window and its contents. 

To rename a window: 
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1. Right-click once on the window title bar of the Data1 worksheet and 
select Rename from the shortcut menu (or select Window:Rename 
from the menu).  The Rename dialog box opens.    

2. Enter MyData1 in the Name field but do not click OK just yet. 
3. In the Label field enter Data from Trial 1, select the Both Name 

and Label radio button, and click OK.  Note that spaces are not 
allowed in window names but spaces are okay in window labels. 

4. Click the Close button  in the upper right corner of the Data2 
worksheet.  An attention box opens asking you to delete or hide the 
worksheet.  Choose Delete.  The worksheet closes. 

5. Click the Close button  in the upper right corner of the renamed 
MyData1 worksheet.  An attention box opens asking you to delete or 
hide the worksheet.  Choose Delete.  The worksheet closes.   

To learn more about Origin worksheets, see Tutorial 2, Worksheets, 
Data Import and Plotting. 
Provided you have Excel 7 or later installed, Origin opens, creates, edits, 
analyzes, graphs, and saves Excel workbook data without leaving the 
Origin workspace.  We will look further at this in a later tutorial, but, for 
now, let’s just open a fresh Excel workbook.   

To open an Excel workbook window: 
1. From the Origin menu, choose File:New.  The New dialog box 

opens. 
2. Select Excel and click OK.  A blank workbook opens.  Note that the 

workbook is named Book1. 

Note:  It may take a moment to open the Excel workbook.  In fact, if you 
are observant, you’ll notice that the program menu structure changes 
completely as the workbook opens.  This is because you are actually 
running the Excel program within the Origin workspace.  Thus, the 
menus that you see when the workbook opens are actually Excel’s 
menus. 

The Origin graph window is the primary window for plotting in Origin.  
Origin’s many built-in 2D and 3D graph types use very different 
specifications (and graph templates) to create a graph, but all graphs – 
whether 2D or 3D – use the same Origin graph window.   

To open an Origin graph window: 
1. Choose File: New from the program’s main menu.  The New dialog 

box opens. 
2. Select Graph and click OK.  
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or 

2. Click the New Graph button  on the Standard toolbar. 
 A blank graph window opens.  Note that the graph window is named 
Graph1. 
Most often you will use the worksheet for tabulating and manipulating 
your data, while you will use the graph window for plotting your data.  
However, if you are making 3D surface or contour plots of XYZ data, 
you will need to become familiar with another window type – the Origin 
matrix. 
The Origin matrix, like the worksheet, superficially resembles a 
spreadsheet, though it’s purpose is to store the Z coordinates of an XYZ 
dataset.  We will say much more about Origin matrices in a later tutorial, 
but, for now, let’s just have a look at one. 

To open an Origin matrix window: 
1. From the menu, choose File:New.   
2. Select Matrix and click OK.  A data window with a pale yellow 

background opens.  The window is named Matrix1.  
Origin has another special type of graphing window called a Function 
window.  This window allows you to plot a function without having to 
create a dataset.  Consult you Origin Help file (Help:Origin) for more 
information on the Function graph. 

To open an Origin Function window:  
1. From the menu, choose File: New. 
2. Select Function and click OK.  A blank Function window opens.  

Simultaneously, the Plot Details dialog box will open to the 
Function tab.  This tab allows you to type a function in the bottom 
text box and plot it in a graph window.  As this is just an 
introduction to the function window, click Cancel in the Plot Details 
dialog box. 
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Note:  The Plot Details dialog box is Origin’s all-in-one interface for 
customizing Origin graphs.  You will learn more about the Plot Details 
dialog in later tutorials. 

Of course, much of Origin’s utility derives from its presentation quality 
graphics capabilities and Origin’s Layout window is specifically 
designed for assembling graphic presentations.  While you can combine 
several graphs on a single graph page, the Layout window is the only 
window in which you can combine worksheets and graphs. 

To open an Origin Layout window: 
1. From the menu, choose File:New. 
2. Select Layout and click OK.  A blank Layout window opens. 
3. Right-click in the gray area to the right side of the Layout page (this 

is the area outside the page but inside the window). 
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4. Choose Rotate Page from the shortcut menu.  The page orientation 
changes from landscape to portrait. 

The Notes window is a general purpose text window that is useful for 
making notes to yourself about procedures, to pass information on to 
others with whom you share your Origin files, to save equations, scripts, 
mathematical functions, etc.  

To open an Origin Notes window: 
1. From the menu, choose File: New. 
2. Select Notes and click OK.  A blank Notes window opens. 
Origin has another specialized text window that reports and stores your 
analytical output (statistical results, curve fitting results, etc.).  This is the 
Results Log.   

To display the Results Log: 
1. From the menu, choose View:Results Log.    
This menu item toggles the Results Log on and off, so that you can 
conserve screen space when it is not needed.  Hiding the Log does not 
delete the contents; unless cleared, Results Log contents are saved with 
the Origin Project file. 
Another cornerstone of Origin’s power is its programmability.  Origin 
has two programming languages: LabTalk and Origin C.  LabTalk is 
Origin’s proprietary scripting language.  The Script window provides a 
convenient way to issue LabTalk commands in Origin. 

To display the Script window: 
1. From the menu, choose Window:Script Window.  A blank Script 

window opens (Note that you can also open the Script window by 
choosing View:Script Window or by clicking the Script Window 

button on the Standard toolbar).  

2. Close the Script window by clicking the Close button  in the 
upper right corner of the window. 

Origin C is Origin’s new ANSI C-compliant programming language.  
Origin provides a special workspace known to programmers as an 
integrated development environment (IDE).  This Origin IDE, called 
Code Builder, is provided for writing, compiling, running and 
debugging your Origin C programs. 

To display the Code Builder integrated development environment: 
1. Choose View:Code Builder from the menu.  The Code Builder IDE 

opens. 
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2. Click the Close button  in the upper right-hand corner of Code 
Builder. 

There can only be one instance of Code Builder or one Script window 
opened per instance of Origin.  You can toggle the Script window on and 
off without losing the window contents.  To temporarily hide Code 
Builder, use the minimize button in the upper right hand corner of Code 
Builder.   
To learn more about programming in Origin, see the Command Line and 
Programming tutorials available from the Origin Help menu 
(Help:Tutorials). 

Origin Menus 
Our quick tour of Origin’s many window types probably gave you a hint 
as to the wide range of Origin’s capabilities.  In order to accommodate 
Origin’s varied capabilities, Origin’s designers have created a context 
sensitive menu structure.  Context sensitive menus present the user with 
only the commands that are pertinent to the currently active window type 
(worksheet, graph, matrix, etc.).  This helps to speed your work, because 
you are not forced to wade through dozens of irrelevant or grayed-out 
menu items to find the one that you are looking for. 

To see how this context sensitive menu structure works, do the following: 
1. If you have not done so, start Origin.  If you are continuing from the 

previous Origin windows tutorial, select File:New Project.  When 
prompted to save the contents of your previous session, say No. 

At this point, you should have a clean workspace containing a single 
Origin worksheet. 

Origin’s main menu should look like this: 

 

2. From the menu, choose File:New.  The New dialog box opens.  
Select Graph and click OK.  A blank graph window opens. 

Origin’s main menu should now look like this: 
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Note that the menu options have changed.  Opening a new graph window 
made the graph window the active window, and Origin altered the menu 
structure to hide worksheet-relevant options and make graph-relevant 
options available to you. 
3. From the menu, choose File:New.  The New dialog box opens.  

Select Matrix and click OK.  A blank matrix window opens. 

Origin’s main menu should now look like this: 

 

Again, note that the menu structure has changed.  When the new matrix 
window became the active window, the menu structure changed to make 
matrix-relevant commands available to you.  Let’s perform one more 
operation just to reinforce the point of this short exercise: that Origin’s 
menu structure changes according to the active window type.  If you find 
that you are suddenly unable to find the menu command that you are 
looking for, chances are good that you simply need to activate a window 
of the appropriate type. 
4. From the menu, choose File:New.  The New dialog box opens.  

Select Excel and click OK.  A blank Excel workbook window 
opens. 

Origin’s main menu should now look like this: 

 

Note:  It may take a moment to open the Excel workbook.  When you 
choose to open an Excel workbook in Origin, you are actually running 
the Excel program within the Origin workspace.  Thus, there may be a 
several second delay before the program responds. 

Origin Toolbars 
Origin’s toolbars give you quick access to many of Origin’s menu 
commands.  This tutorial will give you a few pointers on managing your 
Origin toolbars. 
As you work with Origin, you may find that there are some toolbars that 
you use extensively and others that you use rarely, if at all.  You can 
choose to display or hide any built-in or user-defined toolbar.   
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To hide or display an Origin toolbar: 
1. Select View:Toolbars from the menu.  The Customize Toolbar 

dialog opens. 
The Toolbars tab displays a list of standard Origin toolbars.  Those that 
are active (visible in the workspace) will have a check mark next to 
them.   
2. Position your cursor over the check box next to the Standard 

toolbar and click once to clear the box.  Notice that the Standard 
toolbar disappears from the toolbar spacer. 

3. Position your cursor over the check box next to the Standard toolbar 
and click once to select (restore) the Standard toolbar. 

In addition to hiding or displaying toolbars, you can use the Customize 
Toolbar dialog to add or remove buttons from your toolbars or create 
new toolbars using a single button or a combination of buttons.   
When you choose View:Toolbars from the menu, you enable toolbar 
edit mode.  To see how this works, let’s run through a short exercise. 

To customize a toolbar: 

1. Place your cursor over the New Project button  on the 
Standard toolbar (if you closed the Customize Toolbar dialog, 
reopen it.).   

2. Hold down the left mouse button, drag the New Project button into 
a an empty region of the Origin workspace and release the mouse 
button.  Notice that the New Project button is removed from the 
Standard Toolbar. 

To add a button to an Origin toolbar: 
1. Click on the Button Groups tab of the Customize Toolbar dialog. 
2. Select Standard in the toolbar Groups list.  Note that the Standard 

toolbar buttons appear to the right under the Buttons heading. 

3. Place your cursor over the New Project button  and drag the 
button icon back to the first position on the Standard toolbar.  The 
complete Standard toolbar looks like this: 

 

As you become more familiar with Origin, you may decide to create your 
own toolbars using just the buttons that you use most, or you may wish to 
take it a step further and create your own bitmaps and buttons that 
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perform custom routines.  To find out more about Origin toolbars, select 
Help:Origin and search on keyword toolbars. 

Project Explorer 
Typically, users amass quite a lot of data in an Origin project file.  If you 
anticipate building a project file that contains dozens of worksheets, 
graphs, notes windows, etc., you will probably want to use Project 
Explorer to help you manage your Origin workspace.  Project Explorer 
helps to organize your workspace so that you see only data that is 
relevant to the task at hand.  In addition, you can use Project Explorer to 
create new project files from a portion of an existing project file or to 
append the contents of another project file to your current file.  The 
Project Explorer workspace can be hidden or restored as needed. 

To display the Project Explorer workspace: 
1. If you are continuing from a previous session, click the New Project 

button  on the Standard toolbar.  You do not need to save 
anything from a previous tutorial session.  

2. If the Project Explorer workspace is not open, press ALT + 1, or 

click on the Project Explorer toolbar button . 
The Origin workspace should only have a single worksheet named 
Data1.  The Project Explorer window will display at the bottom of the 
Origin workspace and should look something like this: 

 

The left hand window shows a single folder entitled “Untitled.”  This is 
your as-yet-unnamed Origin project file.  The right hand window 
displays the contents of your project file – at this point, a single 
worksheet entitled Data1. 
3. Add another Origin worksheet by clicking on the New Worksheet 

button  on the Standard toolbar. 

Note:  The New Worksheet button performs the same operation as 
selecting File:New…Worksheet from the menu. 
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Your unnamed project file should now contain two worksheets and both 
should display as icons in the Project Explorer workspace. 

4. Click the New Graph button  on the Standard toolbar. 
5. Click the New Graph button once more.  You should now have two 

worksheets and two graphs in the untitled project file. 
Obviously, adding many new worksheets and graphs to the project 
would, in time, make it difficult to find what you are looking for.  To 
help manage your project files, you might create subfolders within the 
Origin project file.  Let’s create two subfolders – one for worksheets and 
one for graphs – and put the empty worksheets and graphs that we have 
opened into the appropriate folder. 

To add a subfolder to the project using the Project Explorer interface. 
1. Right-click on the Untitled folder icon in the left-hand pane of the 

Project Explorer workspace.  A shortcut menu opens. 
2. Select New Folder from the shortcut menu. 
3. A new folder opens in the right hand pane of Project Explorer.  You 

can rename this folder at this time.  We'll name it Worksheets. 
4. Once again, right-click on the Untitled folder icon in the left-hand 

pane of the Project Explorer workspace. 
5. Again, select New Folder from the shortcut menu and rename it 

Graphs. 

 

Your Project Explorer workspace should now look something like this. 
6. Hold down the CTRL key and select Data1 and Data2 from the 

right-hand pane.  When you have selected both of them, hold down 
your left mouse button and drag the two window icons to the 
Worksheets subfolder on the left side of the workspace. 

7. Hold down the CTRL key, select Graph1 and Graph2, and drag the 
two graph window icons to the Graphs subfolder. 

Your worksheets and graphs are now in two separate subfolders.  How 
you organize your Origin project files is, of course, entirely up to you, 
and will depend on your needs and your work style.   
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Suppose that we wanted to save just the contents of the Graphs subfolder 
as a separate file?  

To save a project subfolder as a separate file: 
1. Click on the Graphs subfolder in the left-hand pane, right-click and 

choose Save Project As…from the shortcut menu.  Origin’s Save 
As dialog opens prompting you for a name and destination 
directory.  You do not need to save this file.  

2. Choose Cancel. 
On occasion, you may also find it helpful to hide certain windows, so 
that they are not visible in the Origin workspace  These may be 
worksheets of questionable data or the results of something that you tried 
that didn't work out.  Rather than delete these windows, you may prefer 
to simply hide them. 

To hide or show a window in Origin using the Project Explorer: 
1. Select the Graphs subfolder in the left-hand pane of the Project 

Explorer workspace.  Your two graph windows should be visible in 
the Origin workspace.  Notice also, that two window icons – Graph1 
and Graph2 – appear in the right hand pane of Project Explorer. 

2. Click the Close button  in the upper right hand corner of Graph1.  
An attention box asks whether you wish to hide or delete Graph1. 

3. Choose Hide.  Notice that Graph2 disappears from the Origin 
workspace.  Notice also that, although the Graph2 icon is still visible 
in the right-hand pane of Project Explorer, it is a bit “washed out” 
looking.  This is a visual cue as to the hidden status of this window. 

4. Double-click on the Graph1 icon in the right hand side of Project 
Explorer.  The graph window is restored and the window icon now 
looks “normal.” 

5. Double-click again on the Graph1 window icon in the right-hand 
pane of Project Explorer.  The window is again hidden. 

Thus, you see that there are a couple of ways that you can show or hide 
windows in the Origin workspace. 
The last part of this exercise is simply a short lesson in manipulating the 
position of the Project Explorer workspace.  The default state for Project 
Explorer is docked at the bottom of the Origin workspace.  However, this 
can be altered, as needed. 

To undock and dock the Project Explorer workspace: 
1. To undock Project Explorer, double-click on the two vertical bars 

on the left side of the Project Explorer workspace.  
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2. To return the Project Explorer workspace to it’s docked position, 
double-click on the workspace title bar. 

 

In terms of default position, the Project Explorer workspace behaves as 
do Origin toolbars.  When you exit the program, the existing position and 
state (docked or undocked) of toolbars or of the Project Explorer 
workspace are stored as the default. 
 
 
This concludes the Origin Workspace tutorial. 
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Tutorial 2, Worksheets, Data 
Import, and Plotting 

Introduction 
The worksheet is Origin’s primary data storage structure.   
In this tutorial, you will import a sample dataset into an Origin worksheet 
and format the worksheet to control the way that the data are plotted.  
Then, you will create a line and symbol graph from the imported data. 

The Origin Worksheet 
The Origin worksheet looks superficially like a spreadsheet.  However, it 
differs from a spreadsheet in some key respects: 
• When working with spreadsheets, you typically refer to data points 

by intersecting row and column designations.  In Origin, a worksheet 
column or dataset defines the primary data grouping while index 
(row) numbers serve to define a secondary grouping. 

• While it is certainly possible to programmatically read and write to a 
single Origin worksheet “cell,” a worksheet “cell” cannot be made to 
store a mathematical formula that refers to the value contained in 
another cell in the same column as one might do with a spreadsheet 
(Note, however, that Origin does have a similar feature that allows 
you to create a data set -- a column of data -- by defining a function 
that references the values in other data sets in the Origin workspace). 

We will begin this tutorial by importing some sample data.  Origin 
imports data stored in a wide variety of formats, and it will import very 
large files (more than 1 million lines of ASCII data) relatively quickly.  
These various file format import options are available from the 
worksheet's File:Import submenu. 

1. Click the New Project button  on the Standard toolbar.  You do 
not need to save the results of the previous tutorial session.  A new 
project file will open containing a single worksheet named Data1. 
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2. From the menu, choose File: Import…: Import Wizard….  The 
Import Wizard opens.  There will be a slight delay if this is the first 
time you have opened the wizard as Origin must first compile some 
files required for the wizard to operate. 

3. Click on the browse button  next to the File edit box and 
navigate to the file Tutorial_1.DAT under the Origin\Tutorial folder. 

4. Select the Rename Worksheet to File Name check box.  
5. Clear the Set Worksheet Label to File Name check box. 
6. Leave the Import Filter for Current Data Type drop-down list at 

the bottom of this page on <none> and click the Next button. 
7. You will now be on the Header Lines page. On this page, verify 

that... 
 
Number of Header Lines is set to 2. 
Column Names From Line is set to 1. 
Column Label Lines is set to 1 to 2. 
Save Header Lines is set to 1 to 2. 

8. Click the Finish button to import the file.  You should now see a 
tutorial1 worksheet display as below: (you may need to resize the 
worksheet to see all columns) 

 

Notice that the worksheet is renamed using the name of the ASCII file 
that you imported.  Recall that Origin does not allow special characters in 
window names so the underscore is dropped.  

Note:  The Import Wizard has many other settings for customizing the 
import of complex ASCII files, as well as features such as extracting 
variables from header lines etc. The Wizard is also capable of importing 
simple binary files, and also for supporting user-defined import code 
written in Origin C. The Wizard allows users to save settings in Filter 
files that can be re-used to quickly import similar files in the future, 



 

 

Tutorial 2, Worksheets, Data Import, and Plotting 

Designating Worksheet Columns as Error Bars •  103 

 

 

 

without having to repeatedly specify import options.  
 
In addition to using the Wizard for importing files, you can drag-and-
drop your file onto the Origin interface, or use the “Import ASCII” 
toolbar buttons located in the Standard toolbar.  
 
Origin also supports import of many other file types such as such as 
ThermoGalactic SPC, Minitab etc. These file can be imported by either 
using the File:Import menu or by drag-and-drop. 
 
When performing drag-and-drop, if Origin is minimized, drag the file to 
the Taskbar program icon and hold it there until the program workspace 
is restored. Then drop the file onto a worksheet, graph window, or an 
area outside the window. 

Designating Worksheet Columns as Error Bars 
When you import data into a worksheet, Origin’s default behavior is to 
designate the leftmost worksheet column as an X column and all columns 
to the right as Y columns.  These X and Y designations are important 
because they determine the way that Origin will treat the data when they 
are plotted. 

 

In this case, the Time column is designated as X and the Testn and Errorn 
columns are designated as Y columns.  In this worksheet the Errorn 
columns are intended to be error measurements.  Further, the Error1 
dataset is associated with the to Test1 dataset, the Error2 dataset is 
associated with the Test2 dataset, and so on.  Column designations 
should be (from left to right)  X, Y1, Y1 Error, Y2, Y2 Error, Y3, Y3 
Error. 
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To specify the plot designation: 
1. Position the cursor over the column heading labeled Error1(Y) and 

double-click with your mouse.  The Worksheet Column Format 
dialog box for that column (data set) opens (You can also open this 
dialog box by highlighting a column and choosing Format:Column 
from the Origin menu). 

2. In the Options group, select Y Error from the Plot Designation 
drop-down list. 

3. Click the  button at the top of the dialog.   
4. The Test2 column is properly designated as a Y column so we will 

skip to the next column. 

5. Click the  button. 
6. To designate Error2 as an error column, choose Y Error from the 

Plot Designation drop down list. 
7. The Test3 column is properly designated as a Y column, so we will 

skip to the next column. 

8. Click the  button and designate Error3 as a Y Error 
dataset and then click OK. 

The worksheet should now look like this: 

 

Note:  Column designations can be set using the Import Wizard pages so 
that the columns are set to desired designations when the file is imported 
into the worksheet. In this tutorial, we chose not to set the designations 
using the wizard, but to set them manually from the interface. 
 
Also, rather than setting the plot designation of each column manually, in 
this case, we could have set the designations by selecting the entire 
worksheet (as illustrated below), right-clicking on the worksheet, and 
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selecting Set As: XYYErr from the shortcut menu.  
 

      

Plotting Your Data 
For most 2D and some 3D graph types, creating a graph is a simple, two-
step process:  (1) select your worksheet data and (2) click on a button on 
one of the plotting toolbars.  
When you select and plot multiple datasets using this technique, Origin 
automatically groups the data plots and increments attributes such as the 
symbol type and color by dataset, so as to visually distinguish individual 
plots.   
The tutorial 1 worksheet should look like this: 

 

1. Position your cursor in the upper left corner of the worksheet (as 
illustrated above) and left-click once to select the entire worksheet. 

2. Click the Line+Symbol graph button  on the 2D Graphs 
toolbar. 

The data are plotted as a Line + Symbol plot, and the Error datasets are 
plotted as Y Error bars on the Test1, Test2, and Test3 data plots, 
respectively. 
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Focusing on a Region of Your Graph 
You may want to take a closer look at some portion of your plot(s), 
particularly if your plots are composed of large numbers of data points.  
Origin provides several tools to accomplish this, including the Enlarger 
tool.  The Enlarger tool automatically rescales the axes of the graph to 
show only the region of the data plot(s) you select.   

To enlarge a region of your data plots using the Enlarger tool: 

1. Click the Zoom In button  on the Tools toolbar. 
2. Using the magnifying glass cursor, hold down the left mouse button 

and drag a box around the large peaks (near X = 1.5) in the graph 
window.  Release the mouse button to complete the operation. 

Note:  If the Enlarger tool button is not visible, you may need to make 
the Tools toolbar visible.  To show or hide an Origin toolbar:  
 
1. Select View:Toolbars… from the main menu. 
2. Select the Toolbars tab of the Customize Toolbars dialog. 
3. Check to show -- or uncheck to hide -- a toolbar.  
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Your graph should now look something like this: 

 

3. To replot the data over the entire range of X values, click  the Zoom 

Out button  on the Tools toolbar. 
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Customizing Grouped Data Plots 
The flexibility to customize virtually every graphic element is one of the 
cornerstones of Origin’s power.  You can easily change the appearance 
of most graphic elements by pointing to that element and double-clicking 
with your mouse.   
For most graphic elements, customizations are made from the Plot 
Details dialog box.  This tabbed dialog allows you to customize every 
aspect of your graph with the exception of graph axes and text labels.  
Using the Apply button, you can readily see how your changes will 
affect the appearance of your graph, without having to repeatedly reopen 
the dialog box. 

Note:  Once a graph is customized, you can save the customization as a 
(graph) Template file, or you can save the settings as a Theme file, and 
recall them for future use.  To learn more, please refer to the Themes and 
Templates tutorials in this collection. 

 

As you look at the Plot Details dialog box, you can see that it is divided 
into two main parts:   
• The left pane provides a hierarchical view of the graph’s primary 

elements: 
Graph > Layer(s) > Data set(s). 
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• The right pane contains one or more tabs that provide access to the 
format options available for the element -- the page, the layer, the 
data set, or the data point -- selected in the left-hand pane.   

Changing the appearance of grouped data plots 
We have already noted that when you select multiple data sets and plot 
them into a single layer, Origin automatically creates a data plot group, 
wherein plot attributes (color, symbol shape, fill pattern, etc.) are 
assigned to each data set by incrementing the members of a list pertinent 
to each attribute.   
For example, looking at the legend that was created for our tutorial plot, 
we can see that line and symbol color increments in this fashion: data set 
1 (Test1) is black, data set 2 (Test 2) is red, and data set 3 (Test 3) is 
green.  Similarly, symbol shape increments in this fashion: data set 1 
(Test1) is filled square, data set 2 (Test 2) is filled circle, and data set 3 
(Test 3) is filled up-triangle.  

 

To edit grouped data plots... 
1. Double-click the Test1 data plot icon  in the graph legend.  

The Plot Details dialog box opens with the tutorial1: Time(X), 
Test1(Y) data plot icon selected in the left hand pane.   

As the first data set in the data list, Test1 controls the plot attributes of 
the two other Y data sets in the group -- Test2 and Test3.  The attributes 
of plots Test2 and Test3 are assigned by incrementing the relevant list 
(color, symbol shape, etc.) following the style that is applied to the first 
data set in the group.   

 

Now, look to the right side of the dialog box (the Group tab) and note a 
couple of things: 
• The Dependent radio button is selected indicating the 

aforementioned plot attribute dependency. 
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• Group Members provides a preview of plot appearance. 
• Check boxes in the Increment column indicate that Line Color and 

Symbol Type are set to increment, but Line Style and Symbol 
Interior do not.  We can see that this is true as Line Style is solid 
and Symbol Interior is filled for all three data sets;  these attributes 
do not increment.  

 

2. Click once at the right side of the color bar in the Details column 

and a "browse" button  will appear. 

 

3. Click once on the browse button and open the color list dialog box. 
4. Rearrange the color list by dragging the ordering number at the left 

side of this dialog box, so that it looks like this: 
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The first data set in our group will now be represented by the color 
red, the second in our group by the color green,  and the third in our 
group by the color blue. 

5. Select the Symbol tab on the right side of the Plot Details dialog 
box. 

6. Click OK.  Note that our Group Members list now looks like this: 

 

7. Clear the (Increment) Symbol Type check box, select the Line 
Style check box, and click OK.  The Group Members now look like 
this: 

 

We no longer increment symbol type by data set, but line style is 
incremented by data set according the order -- solid, dashed, dotted, etc. -
- in the line style increment list (To view the line style increment list, 
point to the right edge of the symbol bar in the Details column and click 
once; click on the browse button that appears, to open the symbol list 
dialog box). 
There is much more that can be done with the Group Incremental Lists. 
You can rearrange and delete members of any list and save the resulting 
list (or lists) with the graph template (.OTP file).  Alternately, you could 
save the resulting list(s) as a Theme (.OTH file), in which case you could 
apply the theme to other graphs -- regardless of the template used in their 
creation -- giving your graphs a new look. 
To learn more, go to Index keyword Group Incremental List at (from 
the Origin menu) Help:Origin.   Also, be sure to work through the 
tutorials on Themes and Templates, included in this document. 
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Customizing the Graph Axes 

To customize the graph axes using the Axis dialog box: 

 

1. Double-click on the X axis.  The Axis dialog opens. 

Note:  If you double-click on the axis itself, the Axis dialog opens to the 
Scale tab.  If you double-click on the axis label, the Axis dialog opens to 
the Tick Labels tab.  You can also open the Axis dialog by choosing 
Format:Axes from Origin’s main menu. 
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2. On the Scale tab, type 1.2 in the From text box, 1.8 in the To text 
box, and 0.1 in the Increment text box. 

3. Select the Title & Format tab. 
4. Type Time (sec) in the Title text box, overwriting the default text 

(We could just as well edit the axis title directly in the graph, but 
since we are working in this dialog box, we will do it this way). 

5. Select the Left icon  from the Selection list box. 
6. Type Potential (mV) in the Title text box, overwriting the default 

text. 
7. Select the Scale tab. 
8. Type -.001 in the From text box, .014 in the To text box, and .002 in 

the Increment text box. 
9. Click OK. 
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Your graph should now look something like this: 

 

Adding Text to the Graph 
To further customize your graph, you can add annotations including text, 
arrows, lines, and shapes.  The tools for adding these annotations are 
located on the Tools toolbar.  Alternatively, you can right-click anywhere 
in the graph to Add Text using a shortcut menu. 
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1. First click and drag the legend so that it is located close to the Y 
axis.  Click outside the legend to de-select it.   

 

2. Click the Text tool button  on the Tools toolbar and then click in 
a blank area in the upper-left corner of the graph.  A text label is 
created.  You will see the cursor flashing at the text entry point. 

 

3. Type Effect of Solvent Loss on Sample Potential in the text label.  
When you are done, click once outside the text label, or press ESC, 
to exit the text edit mode. 

4. Click once on the new text label so that it becomes selected.   

 

5. Drag the bottom right control handle to increase the size of the label. 
The control handles are the small, black squares surrounding the text 
label. 

6. When finished resizing, click outside the label to de-select it.   

7. Click the Date & Time button  on the Graph toolbar to add a 
date and time stamp.   
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Saving Your Project 
Your project currently consists of one worksheet and one graph window 
and the data displayed in both.  Both of these windows and the data they 
contain are stored within the Origin project file when you save the 
project 

1. Click the Save button  on the Standard toolbar.  This opens the 
Save As dialog box. 

2. Type Tutorial_1 in the File name text box, then click Save.  The 
project is saved as Tutorial_1.OPJ.  Note the path to the saved file. 

 
 
This concludes the tutorial on Worksheets, Data Import, and Plotting. 
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Tutorial 3, The Import Wizard 

Introduction 
In this tutorial, you will import an ASCII data file using the Import 
Wizard and in the process create a custom import filter for importing 
similar files in the future.  You will also extract information from the 
header section of the ASCII file, and then use the extracted information 
to create a custom label on a graph. 

Selecting a File to Import 

1. Click the New Project button   on the Standard toolbar.  You do 
not need to save the results of the previous tutorial session.  A new 
project file will open with a Data1 worksheet active. 

2. Select File: Import:Import Wizard….  The Import Wizard opens.  

Note:  If this is the first time you are starting the Import Wizard, there 
may be a slight delay caused by Origin compiling files associated with 
the wizard. 

3. Make sure the ASCII radio button is selected in the Data Type 
group.   

4. Click the browse button  next to the File text box, and navigate 
to the file Tutorial_ASCII.DAT under the Origin\Tutorial folder. 
 Select this file, and then click the Open button. 

5. Leave the Rename Worksheet to File Name check box cleared, and 
the Set Worksheet Label to File Name check box selected.  

6. Leave the Import Filters for Current Data Type drop-down list at 
the bottom of this page set to <none>, and click the Next button. 
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Customizing the Import Settings 
You are now on the Header Lines page of the Import Wizard.  The 
Header Lines page contains options for customizing how lines of the data 
file are interpreted.  Origin makes assumptions and creates defaults based 
on the data file format which you can change in the list boxes at the top 
of the page.  
1. On this page, make sure the drop-down lists have the following 

settings: 
 
Number of Header Lines = 8 
Column Names From Line = 7 
Column Label Lines = 7 to 8 
Save Header Lines = 1 to 8 
 
A preview of the ASCII file is shown below the drop-down lists, and 
the header lines are colored according to the drop-down settings. 
Make sure the Define Header Variables checkbox is checked. 
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2. Click the Next button to continue to the Header Variables page.  
3. Select Colon(:) from the Delimiter drop-down list, then click the 

Scan button.  
The variable list in the lower half of the page will update to show the 
variables and their string values, from the header section.  These 
variables will be saved in the worksheet when import is completed. We 
will use them to label a graph later in this tutorial. 
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4. Click the Next button three times to arrive at the Save Filters page. 
 On this page, we will save our current settings to an Origin Import 
Filter File (*.OIF). 

Saving the Options as a Filter 
Origin Import Filter Files (*.OIF) allow you to save the settings from the 
Import Wizard so that you can import this file (or similar files) in the 
future without having to specify all the import settings each time. 

To save the settings from this session as a filter: 
1. Select the Save Filter check box. 
2. Select the In the User Files Folder radio button.  The filter file will 

be saved in a default Filters subfolder in the User Files area. 
3. In the Filter Name text box, enter Tutorial for the name of the 

filter. 
4. In the Wildcards text box, enter Tutorial*.dat. 
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5. Leave the Specify Advanced Filter Options checkbox cleared, and 
click Finish.  The ASCII file will now be imported into the Data1 
worksheet, which should look like the following figure: (Note: the 
column widths have been increased to show the entire label). 

 

Notice that the file name has been assigned to the worksheet label, which 
is now displayed on the title bar of the worksheet page.  Also, notice that 
the column labels have the entire column name with spaces (such as “ST 
Potential”) whereas the spaces have been removed from the column 
name (such as STPotential).  Special characters (such as spaces) are not 
allowed in column names. Furthermore, column labels can be longer than 
column names. 

Using the Header Data to Create a Custom 
Label 

Now that the data file has been imported we will illustrate the utility of 
the ASCII file header.   We will create a graph and label the graph using 
information extracted from the header section of the ASCII file. 
1. Highlight all columns of the worksheet by placing the cursor on the 

white rectangle at the top left corner of the worksheet and then 
clicking the left mouse button when the cursor changes to a down 
arrow. 

2. Select Plot:Panel:Stack.  This will create a graph with 4 layers and 
will plot all the Y columns from the worksheet in those four layers. 
The column label information will be used in the left axis labels for 
each layer. 

3. Click the Text Tool button  on the Tools toolbar, and then click 
on the area on top of the graph. This allows you to create a text label 
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on the graph and by default, will place you in the in-place text 
editing mode. 

4. While in the in-place text editing mode, press CTRL + H. This will 
open the Insert Info Variables dialog box.  The variables extracted 
from the ASCII file header will all be listed in this dialog, along with 
information such as file name, file path etc.   

5. Hold the SHIFT key down, and select the user variables 
 Measurement Type, Measurement Title, and Acquisition Date.    

6. Click the Insert button to close the dialog and insert all three 
variable values into the text object.  

With some minor edit changes such as making this new label a multi-line 
centered text, your graph should like the following: 
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Using the Import Filter  
We will now re-import the same data file using the import filter we 
created earlier in this tutorial. 

To Import an ASCII file using a filter: 

1. Start a new project by clicking on the New Project  button. You 
don’t have to save the existing project. 

2. With the Data1 worksheet active, select the menu item 
File:Import:Import Wizard….   

3. Click the browse button  next to the File Name edit box and navigate 
to the file Tutorial_ASCII.DAT in the Origin\Tutorials folder.  Select this 
file and click Open. 

4. At the bottom of this page of the wizard, select the List Files Applicable 
to Both Data Type and File Name check box.  From the Import Filters 
For Data Type drop-down list, select User: Tutorial.  This is the 
category and name of the import filter file that we saved earlier. 

5. Click the Finish button to complete the import process. 
6. The Data1 worksheet should now have the same content as it had in the 

previous section of this tutorial. 
Origin Import filter files also support drag-and-drop operation.  

To use drag-and drop, perform the following: 

1. Start a new project by clicking on the New Project  button. You 
don’t have to save the existing project. 

2. Open Windows Explorer and locate the subfolder \Tutorial under the 
Origin installation folder. 

3. Click on the file Tutorial_ASCII.DAT., hold the left mouse button down, 
and then drag-and-drop the file onto the Origin interface.  If Origin is 
minimized, hold the file over the Origin task bar icon, wait for Origin to 
maximize, and then drop the file (release the mouse button) on the Origin 
interface.  This should immediately result in the file being imported into 
Origin.  Note that if you drop the file onto an existing worksheet, the data 
is imported into that worksheet.  If you drop the file onto the gray area, a 
new worksheet is created. 
Defining a filter with a wild card specification also results in a new entry 
in the File:Open menu.  

4. Select File:Open.  This opens the File Open dialog box.   
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5. Click on the Files of Type drop-down list.  You will see an entry that 
reads: 
Tutorial(Tutorial*.dat) 

6. Select this entry, navigate to the Tutorial_ASCII.dat file, and double-
click on the file to import it.  The file gets imported into a new 
worksheet. 
 
 
This concludes the Import Wizard tutorial. 
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Tutorial 4, The Plot Setup Dialog 
Box 

Introduction 
In this tutorial, we introduce the new Plot Setup dialog box.  The Plot 
Setup dialog box provides a flexible interface for adding or removing 
data sets from your graph windows.  You can add or remove any data set 
in the Origin project to your graph and you can do so without the need to 
change the column Plot Designations that control how the data plot in the 
graph (as X, Y, error bar, label, etc.).  Additionally, you can specify the 
plot type and data range using Plot Setup dialog box controls.  
The Plot Setup dialog box opens under these circumstances:  
• You click a graph toolbar button or select a plot from the plot menu, 

without selecting any data. 
• You right-click on the graph window layer icon and select Plot 

Setup… from the shortcut menu. 
• With a graph window active, you select the Graph:Add Plot to 

Layer menu item. 
In this tutorial, we will utilize this dialog box for creating a new plot 
starting with a fresh graph template, for editing data plot contents of an 
existing graph window, and for creating a graph with data from multiple 
worksheets. 

Creating a New Graph 
In this section, we will see how the Plot Setup dialog box can be used to 
create a new graph starting from a fresh graph template. 
1. Open the project \Tutorial\Tutorial_Plot_Setup.OPJ.   
2. From the menu, choose Plot:Template Library.  This opens the 

Template Library dialog box.  
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3. From the Category list, choose Special Line & Symbol.  From the 
Template list, choose Doubley.  The Preview pane shows a sample 
"double Y" (two Y axes) plot.   

4. Click the Plot button. This opens the Plot Setup dialog box. 
5. There are three panels in this dialog box.  All three should be visible 

at this point.   

If they are not, use the  and  buttons to display all three 
panels. 

 

6. In the top-most panel, click and highlight the row that corresponds to 
Data1 worksheet. 

7. In the bottom panel, you will see two layers corresponding to the 
two layers in the DoubleY graph template that we opened.  Click on 
Layer1 to select it.  This layer has one plot style holder.  We will 
now fill this style holder with a data plot. 
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8. Go to the middle panel, select the box under column X, in the row 
which has Time in the Column (Name) column; select the box 
under column Y on the row that has STPotential as Column 
(Name).  Click the Add button to add this data plot to Layer 1 in the 
panel below. 

 

9. Now click and select Layer 2 in the bottom panel.  In the middle 
panel, under the Y column, clear the current check box and select the 
box corresponding to the row with SVPotential as Column (Name). 
 Click the Add button to add this new data plot to Layer 2.  

10. Make sure the Rescale check boxes for each layer are checked, then 
click the OK button.  This will close the dialog box and create a new 
graph. 
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Editing an Existing Graph 
This section will show how to edit/re-configure an existing graph using 
the Plot Setup dialog.  We will continue from where we left the project in 
the previous section. 
11. Click on Graph1 that was created in the previous section of this 

tutorial. 
12. Double-click on one of the layer icons in the top left corner of the 

graph.  This reopens the Plot Setup dialog. 

13. In the bottom panel of the Plot Setup dialog (again, use the  and 

 buttons, as needed to display all three panels of the dialog box), 
select the data plot named Time(X), SVPotential(Y), under Layer 2. 
This action updates the middle panel of the dialog with the column 
selection information for this data plot. 

14. Change the Y association by clearing the check box under the Y 
column and selecting the check box on the row with STPressure as 
Column (Name). Click the Replace button. This replaces the data 
plot in Layer 2 with a new plot as specified in this middle panel. 

15. Make sure the Rescale check boxes are checked, then click OK to 
close the dialog.  The graph is then updated with the change you 
made to the data plot in Layer 2. 
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Plotting From Multiple Worksheets 
This section will show how to create a new plot by selecting data from 
multiple worksheets.  We will continue from where we left off in the 
previous section.  
16. Click on (any) one of the worksheets in the current project, then 

from the menu select the menu item Plot:Panel:Vertical Two 
Panel.  The Plot Setup dialog reopens.  Make sure all three panels 
are visible. 

17. In the top panel, you will see three worksheets.  As you select each 
of the three worksheets, the middle panel is updated with column 
(data set) information pertinent to that worksheet.   

18. Click on the Label column heading in the top panel. This sorts the 
list of worksheets in that panel.  You can thus sort this list on any 
column.  Drag your mouse over the three worksheet names to select 
all three (you can also use SHIFT or CTRL + select, as in Windows 
Explorer). 

19. Once you select all three worksheets in the top panel, the middle 
panel displays all columns that are common to the three worksheets. 
In this project, all three worksheets have the same columns, and so 
all columns are displayed. 

20. Select the X box on the row named Time, and the Y box on the row 
named STPotential. 

21. Make sure the Layer 1 row in the lower panel is highlighted, and 
then click the Add button.  This will then add three data plots to this 
layer, one from each of the worksheets selected in the top panel. 

22. Now make Layer 2 row active in the lower panel, select the Y box 
on the row named STPressure in the middle panel, and click the 
Add button to add three data plots to Layer 2. 

23. Hold down the SHIFT key, select all three plots added under Layer2 
in the bottom panel,  then right-click and select Group.  This groups 
the three data plots in that layer.  Repeat this grouping procedure for 
Layer 1. 

24. Make sure the Rescale check boxes are selected and click OK to 
create the graph. 
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This concludes the Plot Setup dialog box tutorial. 
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Tutorial 5, Working with Excel in 
Origin 

Introduction 
You can open Excel workbooks directly in Origin, provided you have 
Excel 7 or later installed on your computer.  This allows you to combine 
Excel’s spreadsheet tools with Origin’s powerful graphing and analysis 
tools.   
This tutorial will show you how to open Excel workbooks in Origin, plot 
your Excel data using Origin graph templates, then save your Excel 
workbooks from Origin. 

Opening an Excel Workbook in Origin 
To follow this tutorial, you must have Excel version 7 or later installed 
on your computer, either as a local or network copy.   

To open an existing Excel workbook: 

1. On the Standard toolbar, click the New Project button . 

2. On the Standard toolbar, click the Open Excel button . 
3. In the Origin \Tutorial folder, select Tutorial_7.XLS from the file 

list. 
4. Click Open. 
The Open Excel dialog box opens.  This dialog box gives you the choice 
of opening your Excel workbook (in Origin) as a workbook or opening it 
as an Origin worksheet.  If you open a workbook as a workbook, you 
have access to Excel menus and toolbars, but somewhat restricted use of 
Origin’s analysis and graphing features.  If you open the workbook as an 
Origin worksheet, you have full access to Origin’s graphing and analysis 
features, but you will not have access to Excel’s spreadsheet features. 
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Note:  The workbook/worksheet choice isn’t entirely an “either/or” 
situation.  You can open an Excel file twice – once as a workbook and a 
second time as a worksheet – and have access to everything that both 
programs have to offer.  You can also copy and paste data from an Excel 
workbook into an Origin worksheet.  

 

5. Select the Open As Excel Workbook radio button. 
6. Click OK. 
The workbook opens in the Origin workspace.  Notice that a combination 
of Origin and Excel menus and toolbars are now displayed in the 
workspace. 
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Plotting an Excel Workbook in Origin 
Plotting Excel workbook data in Origin is very similar to plotting Origin 
worksheet data.  If a graph window is open, you can drag and drop data 
from a workbook into the graph window.   
You can also create a new graph from your workbook data by (1) 
activating your workbook and (2) clicking a button on one of the plotting 
toolbars or by selecting a graph type from the Plot menu.  An 
intermediary Select Data for Plotting dialog box opens to allow you to 
assign data sets to the graph.   
By default, the Select Data for Plotting dialog box opens when you select 
your Excel data and click a button or select a menu command to plot the 
data.  After you become familiar with Origin's graph templates, you may 
be able to bypass this dialog box and plot your data directly from the 
workbook.   
To bypass the Select Data for Plotting dialog box, open the Options 
dialog box (when a workbook is active, select Window:Origin Options; 
When any other window type is active, select Tools:Options) and select 
the Excel tab.  Then, in the Plotting Selection Group, select the Default 
Plot Assignments check box.  

Creating a Graph Using the Select Data for 
Plotting Dialog Box 

The Select Data for Plotting dialog box lets you select data and then 
assign plotting designations.   

To create a graph using the Select Data for Plotting dialog box: 

1. Click the Column button  on the 2D Graphs toolbar.  This 
opens the Select Data for Plotting dialog box. 

2. Reposition the dialog box so that you can see the column headings in 
the Excel workbook. 

3. Click the column A heading in the workbook, then click  in the 
Select Data for Plotting dialog box. 

4. Click the column C heading, then CTRL+Click on the column F 

heading and then click  in the Select Data for Plotting dialog 
box. 
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The box below the buttons indicates data ranges by plot designation.  
X:A1:A65536 means that the X data is being represented by column A, 
rows 1 to 65536.  The last row number of the column is shown because 
you selected the whole column. 
5. Click the Plot button in the Select Data for Plotting dialog box, 

then click Close. 
6. Reposition the legend on the graph page. 
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When the graph window is active, you may notice a blank gray area in 
the toolbar region.  This is called a toolbar spacer.  The toolbar spacer is 
reserving space for the Excel toolbars, which will display when you re-
activate the Excel workbook.  If desired, you can hide the toolbar spacer 
by right-clicking in the spacer and selecting Hide Toolbar Spacer from 
the shortcut menu.  When you re-activate the workbook, Origin will 
automatically display the spacer with the Excel toolbars.   

 

Creating a Data Plot by Dragging Data Into a 
Graph 

When you drag Excel workbook data onto an Origin graph, Origin makes 
assumptions about the plotting designations of the selected data.   
• If one column (or a range from one column) is highlighted, then this 

column supplies the Y values for the data plot.  The data is plotted 
versus row number. 

• If more than one column (or a range from more than one column) is 
highlighted, the leftmost column supplies the X values.  All other 
columns supply the Y values.  The data is plotted versus the X 
values. 

• If more than one column (or range from more than one column) is 
highlighted and the CTRL key is depressed while dragging the data, 
then all the columns supply the Y values.  The data is plotted versus 
row number. 
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To create a graph using the drag-and-drop method: 

1. Click the New Graph button  on the Standard toolbar.  
Reposition/resize the Graph2 window so that when the workbook is 
active, it doesn’t completely hide the new graph window. 

2. Select Window:Book1 to activate the Excel workbook window. 
3.  Highlight the first two columns in the workbook.  Note that as you 

move your mouse over the right edge of your two columns of 
selected data, the cursor changes. 

 

4. Point to the right edge of the B column and, when the cursor 
becomes a pointer, hold down the left mouse button and drag the 
data to the Graph2 window.  When you release the mouse button, 
column B is plotted against column A as a line plot in the graph 
window (an attention message may ask to rescale the axes to display 
all data; say Yes). 

5. Click on the graph window to make it the active window. 
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Creating a Graph Using Origin’s Default Plot 
Assignments 

This plotting method allows you to select your workbook data and graph 
type, and then Origin creates the data plots by making assumptions about 
the plotting assignments of the selected data.  This plotting method is not 
available by default.  It must be activated from the Options dialog box 
(Window:Origin Options when a workbook is active; Tools:Options 
when an Origin window is active). 

To create a graph using Default Plot Assignments: 
1. Select Tools:Options to open the Options dialog box.  (If the 

workbook is active, then select Window:Origin Options). 
2. On the Excel tab, select the Default Plot Assignments check box. 
3. Click OK, then click No (no need to save as a start up option) to the 

dialog box that opens. 
4. Make the Excel workbook active. 
5. Click on the column A heading, then CTRL+ select column D and 

G headings. 

6. Click the Area graph button  on the 2D Graphs toolbar. 
7. Reposition the graph legend. 
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Saving an Excel Workbook in Origin 
There are two ways to save Excel workbooks with your Origin projects.  
You can save the workbook internal to the project, which means that it 
is saved as part of the Origin project and can only be opened by opening 
the Origin project file. 
The other choice is to save the workbook as external to the Origin 
project file.  When you save a workbook externally, a link to the 
workbook is maintained in the project file.   
The chief advantage to storing your workbook internally is that all of 
your graphs, analyses, support data, etc., can be bundled together in a 
single file.  This makes it easy to share data with other Origin users.  
Of course, sometimes sharing data with colleagues may mean that you 
are working on a common file that is saved to a shared folder on the your 
network.  In such cases, saving your data to an external Excel workbook 
file may be the way to go. 

Note:  Internally saved workbooks do not maintain links with external 
Excel workbook files.  Thus, if you save a workbook internally while 
colleagues continue to work on the external Excel file, your project 
workbook will not be updated. 

By default, pre-existing workbooks that are opened in an Origin project 
are saved external to the project, whereas workbooks that are created 
from within Origin are saved internal to the project.  However the save 
option can be changed in the Workbook Properties dialog box. 

To save the workbook internal to the Origin project: 
1. Make the Excel workbook active. 
2. Right-click on the title bar of the workbook and select Properties 

from the shortcut menu.  This opens the Workbook Properties 
dialog box.   

3. Select the Internal radio button in the Save As group. 
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4. Click OK. 
5. Select File:Save Project As. 
6. Type Excel_Tutorial in the File Name text box. 
7. Click Save. 
The project is saved and the workbook is saved internal to the project.  
Any changes that you now make to the Excel workbook located in the 
\TUTORIAL folder will not be reflected in the project file the next time 
it is opened.   
 
 
This concludes the Excel tutorial. 
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Tutorial 6, Exploring your Data 

Introduction 
Origin offers a number of data selection tools to aid in exploring and 
analyzing your data; these include the Data Reader, Screen Reader, Data 
Selector, Enlarger, Zoom, Region of Interest and the various data 
masking tools available from the Mask toolbar.  To learn more about 
these features, consult the Origin help file at Help:Origin…. 
In this tutorial, you will use the masking tools to selectively exclude 
unwanted data points from your analyses.  You will also mathematically 
transform some worksheet data, do a primary and secondary sort of some 
worksheet data, plot a range of data and perform a quick linear fit on a 
plotted data set. 

Importing Data 
To begin this tutorial, you will open a new Origin project and import 
ASCII data.  To import an ASCII data file: 

To import an ASCII data file: 

1. Click the New Project button  on the Standard toolbar.  

2. Click the Import ASCII button , then select Tutorial_2.DAT 
from the Origin \Tutorial folder.  

3. Click Open.  

Note:  A portion of the worksheet (and the imported data) may not be 
visible.  You may need to use the scroll bars at the bottom and right 
edges of the worksheet to locate worksheet columns of interest. 
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Transforming Column Values 
You can create or transform datasets with a mathematical expression via 
the Set Column Values dialog box.  This dialog box provides a text box 
for you to type a value or mathematical expression (or compiled Origin C 
functions) to apply to an entire column, or portion of a column of 
worksheet data. 

 

The Set Column Values dialog also includes a function drop-down list 
from which you can select a function to add to the text box.  A column 
drop-down list contains a list of all columns in the active worksheet.  
Select the column you want to add to the text box, then click Add 
Column to add the selected column to the text box.   

Note:  You can also type column names into the text box, and, in fact, 
when referring to columns in other project worksheets, you must do so.  
Refer to columns in the same worksheet using the col(name) notation. 
 Refer to columns in other worksheets using the wksname_colname 
notation.  For example: col(A)=Data1_b*3 

To transform a column of values via the Set Column Values dialog box: 
1. We will begin by inserting a column into the Tutorial2 worksheet. 

 Click on the Depth column heading (to the right of the Time 
column) and choose Edit:Insert from the menu.  This inserts an 
empty column into the worksheet. 

2. Double-click on the new column's heading to open the Worksheet 
Column Format dialog box. 
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3. Change the Column Name to TimeMin and click OK.  Your 
worksheet should now look like this: 

 

4. Right-click on the TimeMin(Y) column heading, and select Set 
Column Values… from the shortcut menu.  This opens the Set 
Column Values dialog box. 

5. In the Col(TimeMin)= text box, enter the following expression:  
col(Time)/60  

6. Select the AutoUpdate check box and click OK.   
The TimeMin(Y) column is filled with values, according to the formula 
entered in the column's Set Column Values dialog box.  Note, too, that 
column TimeMin is now "locked"  -- as indicated by the lock symbol on 
the column heading.  When an AutoUpdate is pending, the lock symbol 
will appear as a yellow "traffic light" (Unless a number of operations are 
queued, you may never see the traffic light).  

 

When you select AutoUpdate, as we did, any change to the source data 
(in this case, the Time column), triggers an execution of the TimeMin 
column formula and an update of TimeMin column values. 
7. Right-click on the Time(Y) column, select Set Column Values, 

enter the following expression in the Col(Time)= text box, and click 
OK: 
col(Time)+100 
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The worksheet now looks as follows.  Note the AutoUpdate of the values 
in column TimeMin(Y): 

 

Sorting Worksheet Data 
Origin can sort data in individual columns, multiple columns, or entire 
worksheets.  Origin offers simple sorting in which selected data are 
sorted using a “sort by” column, in ascending or descending order.  
Origin also offers custom sorting of multiple columns, in which sorting is 
done first on a primary column, while subordinate "sort by" columns are 
sorted in nested fashion in either ascending or descending order. 

To sort worksheet data: 
1. Hold down the CTRL key and select every column in the worksheet 

except the locked TimeMin(Y) column.  This column must be 
excluded because it's values are dependent upon values in another 
column.  
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2. Click the Sort button  on the Worksheet Data toolbar to open 
the Nested Sort dialog box  (If the Worksheet Data toolbar is not 
displayed, select View:Toolbars and select it from the list). 

3. Select DEPTH from the Selected Columns list box, then click the 

 button.  The column is added to the Nested Sort 
Criteria list box.  This selection makes DEPTH the primary column, 
to be sorted in ascending order. 

4. Select STN from the Selected Columns list box, then click 

.  This makes STN the secondary sort column, to be 
sorted in ascending order. 

 

5. Click OK.   
The entire worksheet is sorted so that the values in the DEPTH (primary) 
column are ascending.  For duplicate values in the DEPTH column, the 
values in the corresponding rows of the STN (secondary) column 
determine how the worksheet data are ordered. 
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Note:  To sort the values in every column in a worksheet in ascending 
order, you would have to sort columns individually.  Otherwise, the 
worksheet is sorted on the primary column and all values in row ii will 
still be in a common row after data are sorted.  

Plotting a Range of the Worksheet Data 
You can delimit your worksheet data so that subsequent plotting and 
analysis are performed only the selected range. 

To select a range of worksheet data: 
1. From the menu, select View:Go To Row. 
2. Type 52 in the GoTo Row dialog box, and click OK. 
3. Right-click on the row heading of row number 52. 
4. Select Set As Begin from the shortcut menu. 
5. Use the vertical scroll bar to move down in the worksheet so that 

row number 68 is visible. 
6. Right-click on the row heading of row number 68. 
7. Select Set As End from the shortcut menu. 
Notice that the data outside the selected range is no longer displayed in 
the worksheet (excepting the locked TimeMin(Y) column).  The data has 
not been deleted from the worksheet, only hidden to provide for easier 
viewing of the selected range.  To restore the hidden data, select the 
entire worksheet from the menu, choose Edit:Reset to Full Range. 

To plot this subset of data: 
8. Click on the FLUOR(Y) column heading to select the column. 
9. Scroll to the right in the worksheet, hold down the CTRL key and 

click on the TEMP(Y) column heading.  This selects both the TEMP 
and the FLUOR columns.   

Note:  To select noncontiguous columns, use CTRL + click.  To select a 
range of contiguous columns, use SHIFT + click. 

10. Click the Double Y Axis button  on the 2D Graphs Extended 
toolbar  (or select View:Toolbars if the 2D Graphs Extended toolbar 
isn't open.). 
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Masking Data in the Graph 
The Mask toolbar provides other means for excluding data from Origin's 
analysis and fitting routines.  You can mask individual data points or a 
range of data.  Once data are masked, you can change the masked data 
color, hide or show the masked data, swap the masked and unmasked 
data, and enable or disable masking.   

To mask a data point in the graph: 
1. Select View:Toolbars, select Mask from the list of toolbars and 

then click Close.  This opens the mask toolbar. 

2. Click the Mask Point Toggle button  on the Mask toolbar.  This 
activates the Data Reader tool. 

3. Move the cursor (it is now a cross-hair) to the Double Y-axis plot 
that we just created and left-click anywhere on the FLUOR data plot 
(the black square symbols) in your graph window. 

4. Using the right or left arrows on the keyboard, move the cursor to 
the data point at X = 34 and Y = .59.  The Data Display tool 
displays the point coordinate values.   
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5. Press ENTER or double-click to mask this point.  

6. Click the Change Mask Color button  on the Mask toolbar.  
The color of the masked data point changes to green.  If you scroll 
the worksheet to find the data point that you just masked in the 
graph, you will see that it now displays with a green background to 
indicate that this particular data point is masked. 

 

7. With the graph window active, click the Hide/Show Masked Points 

button  on the Mask toolbar to hide the masked data point.  Note 
that the point is removed from the graph. 

8. Once again, click the Hide/Show Masked Points button  on the 
Mask toolbar .  This restores the masked data point to the graph. 
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Performing a Linear Fit on the FLUOR Data Plot 
Masking the data point in the FLUOR data plot excludes that point from 
analysis and fitting operations.  You can, however, disable the mask on 
the data point, and analyze or fit all the data points in the current 
selection range.  

To perform a linear regression with the data point masked: 
1. Select Analysis:Fit Linear.  A “best-fit” line is added to the graph 

and the Results Log opens to display the fitting results (parameter 
and error value estimates, R-value, SD, etc.).  You can scroll the 
Results Log to view the results.   

2. Click the Refresh button  on the Standard toolbar and reposition 
the legend so it fits on the page. (remember that the page is the white 
area within the graph window; anything that laps onto the gray area 
will not be visible when the graph is printed or exported) 
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By default, the Results Log shows the results for all curve fitting done in 
the active Project Explorer folder.  To change this default behavior, right-
click in the Results Log and select a different reporting option. 
Each time a fit is performed, the results are appended to the Results Log.  
Each entry in the Results Log includes a date/time stamp, the window 
name, a numeric stamp which is the Julian day, the type of analysis, and 
the results.   

To perform a linear fit with the Mask disabled: 

1. Click the Disable/Enable Masking button  on the Mask 
toolbar.  The masked data point changes from green to black. 

2. From the menu, select Analysis:Fit Linear.  A second regression 
line is drawn on the graph. 

3. Verify that the mask is disabled by comparing the two fit results in 
the Results Log.   
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To remove the initial regression line from the graph: 
1. Hold down the ALT key and double-click on the Layer 1 icon 

 in the upper-left corner of the graph.  This opens the 
Layer 1 dialog box.   

2. Select linearfit1_tutorial2fluo from the Layer Contents list box.   
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3. Click the  button to remove linearfit1_tutorial2fluo from the 
Layer Contents list box.  

4. Click OK to close the dialog box. 

5. To update the legend, click the New Legend button  on the 
Graph toolbar.  You may also need to click the Refresh button 

 on the Standard toolbar.   
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Saving the Project 
Your Origin project currently contains your data, worksheets, graph, 
analysis results and the current folder organization as it shows in Project 
Explorer. 

 

To save the current Origin project: 
1. From the menu, select File:Save Project. 
2. Type a name in the File Name text box. 
3. Click on the Save button. 
 
 
This concludes the Exploring Your Data tutorial. 
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Tutorial 7, Creating Multiple 
Layer Graphs 

Introduction 
The layer is the fundamental building block of Origin graphs.  A layer is 
an Origin object consisting of one set of controlling axes.  You may opt 
to hide or show any or all of the four axes (top X, bottom X, right Y, and 
left Y) that make up the layer.  A layer contains text labels, drawing 
objects, or data plots, that may be shown or hidden.  A graph window 
must contain at least one layer and may include as many as 80 layers. 
This tutorial will introduce you to the graph layer concept.  In addition, 
you will learn about Origin's built-in multiple layer graph templates.  
You will also learn how to create your own multiple layer graph and save 
it as a template for later use.   

The Graph Layer Concept 
There is always one -- and only one -- active layer in a graph window.  
This active layer is the only layer that is subject to program commands.  
Data or objects added to a graph can only be added to the active layer.   
Unless intentionally hidden, a graph window will have one or more layer 
icons – one for each layer in the graph window – in the upper left corner 
of the graph window.  The active layer is denoted by a depressed layer 
icon. 

 

• To hide the layer icons, select View:Show:Layer Icons.  
• To highlight the axes in the active layer, select View:Show:Active 

Layer Indicator.  



 

 

Tutorial 7, Creating Multiple Layer Graphs 

156 •  The Graph Layer Concept 

 

 

 

Reminder:  Just as there can be only one active layer within a graph 
window, recall that there can be only one active window within the 
Origin workspace.  Thus, the above actions only affect the active graph 
window.   

 

You can activate a layer in several ways:  
• Click once on the corresponding layer icon in the upper left corner of the 

graph window. 
• Click once anywhere within the graph's layer frame. 

Note:  The layer frame is a reference frame defined dimensionally by the 
Layer Area settings on the Size/Speed tab at the Layer level of the Plot 
Details dialog. The graph axes, tick marks, tick labels, attached objects 
and plotted datasets are drawn in relation to this frame and may extend 
beyond this frame. 

• Click once on any object (text, axis titles, etc.) that is part of or is attached 
to the layer. 
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Opening the Project File 
The data for this tutorial is provided in an Origin project file.  

To open the Origin project file: 

1. Click the Open button  on the Standard toolbar. 
2. In the Origin\Tutorial folder, select Tutorial_3.OPJ from the list of 

files.   
3. Click Open.  A project containing four graph windows and a 

worksheet opens. 

Note:  Three graph windows and the worksheet are in a minimized state 
at the bottom of your Origin workspace. 

Origin's Multiple Layer Graph Templates 
Origin includes a number of highly useable, built-in, multiple layer graph 
templates.  Putting one of these templates to use is a two step process:  
(1) first, you select a range of data, then (2) you click a button to plot the 
selected data into multiple layers in a graph window.   
The trick is to become comfortable with the behavior of grouped 
datasets, the graph layer concept, and the workings of the various 
multiple layer templates.  Once you accomplish this, you will be well on 
your way to producing visually appealing and highly illustrative multi-
layer graphs with just a few clicks of the mouse. 
The double Y axis graph template is ideal for plotting data that consists 
of two or more dependent data sets and a common independent data set.  
A sample double Y axis graph is currently active in your project.   
Note that, unlike the example in our lead-in discussion of the graph layer 
concept, the layers in this graph are superimposed.  This is an important 
point and one that helps to illustrate the power of Origin’s layer concept.  
Because layers are constructed independently, you can combine and 
manipulate them in innumerable ways.  This allows a great deal of 
flexibility in the graph creation process.   
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Origin’s built-in horizontal 2 panel graph template is ideal for plotting 
related data that do not share an independent data set.  Tutorial_3.OPJ 
contains an example of a graph made using this template. 

1. Click on the Restore Up icon  on the minimized 
Horizontal2Panel window icon at the bottom of your workspace.  
The Horizontal2Panel graph should now be visible. 

2. Click on the Restore Up icon  on the minimized Layers 
worksheet at the bottom of your workspace.  The Layers worksheet 
should now be visible. 

3. Select the Pontential1(Y) and Pressure1(Y) columns by holding 
down your left mouse button and dragging the “+” cursor across 
both column headings.  When both are selected, release the mouse 
button. 
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To plot the selected data using Origin’s Horizontal 2 Panel template: 

1. Click the Horizontal 2 Panel button  on the 2 D Graphs 
Extended toolbar. 

The resulting graph should look very much like the Horizontal2Panel 
graph window, minus some text annotations. 

2. Click on the Close icon  of the graph window that you just 
created.  You may delete the window. 

Origin’s vertical 2 panel graph template provides the same data 
presentation as the horizontal 2 panel graph template, but in a one 
column/two row configuration (i.e. the graph panels are stacked one on 
top of the other).   

3. Click on the Restore Up icon  on the minimized Vertical2Panel 
window icon at the bottom of your workspace.  The Vertical2Panel 
graph should now be visible.  Resize/move this window so that you 
can clearly see the Layers worksheet. 

To plot the selected data using Origin’s Vertical 2 Panel template: 
1. Select the Potential1(Y) and Pressure1(Y) columns of the Layers 

worksheet if they are not selected and click the Vertical 2 Panel 

button  on the 2D Graphs Extended toolbar. 
The resulting graph should look very much like the Vertical2Panel graph 
window, minus some annotations. 

2. Click on the Close icon  of the window that you just created.  
You may delete the window. 

When your worksheet includes multiple X columns, Y columns in the 
worksheet plot against the nearest X column to the left.  Though this 
default behavior can be disregarded by selecting non-contiguous columns 
with CTRL selection, the default plotting behavior allows you to quickly 
create graphs from associated XY data sets. 
The Layer worksheet contains a second column that should be designated 
as an X column – this is the Trial2(Y) column – so we will change the 
plot designation to X so that we can proceed with our last multiple layer 
template plotting exercise. 

To designate a second X column: 
1. Right-click on the Trial2(Y) column heading and select Set As:X 

from the shortcut menu, or double-click on the column heading and 
choose X from the Plot Designation drop-down list in the 
Worksheet Column Format dialog box. 
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The Trial2 column designation changes to X2 and the columns to the 
right of it are designated as Y2.  In addition, the Trial1 column 
designation changes to X1 and the columns between Trial1 and Trial2 are 
designated as Y1.  Thus configured, the default behavior is for Y1 
columns to plot against the X1 column, Y2 columns to plot against the 
X2 column, etc.  

To create a multiple layer graph using the 4 Panel template: 
1. Select the entire worksheet by placing the cursor in the upper left 

corner of the worksheet.  When the cursor becomes a downward 
pointing arrow, left-click once. 

2. Click on the 4 Panel button  on the 2D Graphs Extended 
toolbar. 

Your 4 layer, 4 panel graph should look something like this: 
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Creating Your Own Multiple Layer Graph 
Template 

Obviously, Origin could not contain pre-defined templates for all the 
different ways in which layers can be arranged.  However, you can create 
your own custom multiple layer graph and save it as a template for future 
use.   
This segment of the tutorial describes a method for creating a multiple 
layer graph, using a single layer graph as a starting point.  This 
information is provided to familiarize you with important layer concepts.  
Keep in mind that you can use any of Origin’s multiple layer graph 
templates as a starting point for your custom multiple layer graph.   

To begin this portion of the tutorial: 
1. Click on the Potential1(Y1) column heading in the Layers 

worksheet. 

2. Click the Line graph button  on the 2D Graphs toolbar. 

 

3. From the menu, select Tools:Layer to open the Layer tool. 
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Note:  Make a mental note as to where to find this tool.  As the tool’s tab 
names imply, it is very useful for adding and arranging layers in multiple 
layer graphs.  This tool is available only when a graph window is active.   

4. On the Add tab, click the Linked Right Y button .  This adds a 
second layer to the graph.   

By default, the X axis of this new layer (layer 2) is linked to the X axis of 
layer 1.  This means that if you change the X axis scale in layer 1, the X 
axis scale in layer 2 will change simultaneously.  Linking is controlled 
by settings on the Link Axis Scales tab (Layer level) of the Plot Details 
dialog box. 
5. ALT + double-click on the layer 2 icon in the upper-left corner of 

the graph window. 
This opens the Layer n dialog box.  What you see to the left side of this 
dialog is list of all Y datasets in the current project.  Note that no datasets 
are currently listed in the Layer Contents list box.  We have added a 
second layer to our graph, but we have not added any data to the layer. 
6. Select layers_pressure1 in the Available Data list box. 

7. Click the  button to add the layers_pressure1 data set to the 
Layer Contents list box. 

8. Click Layer Properties.  The Plot Details dialog box opens. 
9. Double-click on the Layer2 icon on the left side of the dialog box. 
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10. Select the LAYERS:Trial1(X), Pressure1(Y) data plot icon on the 
left side of the dialog box.  This action opens the Line tab.  

11. Select Blue from the Color drop-down list, then click OK. 
12. Click OK to close the Layer 2 dialog box. 

 

Note:  If you see only the positive peaks in the layers_pressure1 data set, 

make certain that layer 2 is active and click the Rescale button  on 
the Graph toolbar.  

Origin provides many methods to add layers to your graph.  In addition 
to the Layer tool, you can select menu commands from the Edit menu.  
You can also right-click in the gray area outside the graph page (but 
inside the window) and add layers via the shortcut menu. 

Arranging Layers in the Graph Window 
In this section, you will add and arrange layers to set up a vertical 2 panel 
graph with left and right Y axes. 

To add and arrange layers in the graph: 
1. Select Edit:Add & Arrange Layers. 
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2. In the Total Number of Layers dialog box, type 2 in the Number 
of Rows text box. 

 

3. Click OK.  Origin asks for permission to create 1 more layer. 
4. Click Yes.   
5. Click OK in the Spacing dialog box to accept the default settings. 

 

To add the right Y controlling axis to the top layer: 
6. With the layer 3 icon selected, right-click in the gray area inside of 

the graph window (but outside of the page) and select New Layer 
(Axes):(Linked):Right Y from the shortcut menu. 
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Adding Data to the New Layers 
To add the data to layers 3 and 4, you will use the Layer dialog box in 
the same way you added the data to layer 2. 

To add data to the new layers: 
1. ALT + double-click on the layer 3 icon.  The Layer 3 dialog box 

opens. 
2. In the Layer 3 dialog box, select layers_potential2 from the 

Available Data list box, and click  to add the data set to the 
Layer Contents list box. 

3. Click OK. 
4. ALT + double-click on the layer 4 icon. 
5. In the Layer 4 dialog box, select layers_pressure2 from the 

Available Data list box, and click  to add the data set to the 
Layer Contents list box. 

6. Click Layer Properties to open the Plot Details dialog box. 
7. Double-click on the Layer4 icon on the left side of the dialog box, 

then click on the LAYERS:Trial2(X), Pressure2(Y) data plot icon. 
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8. Select Red from the Color drop-down list. 
9. Click OK to exit the Plot Details dialog box. 
10. Click OK in the Layer 4 dialog box. 

11. Click the Rescale button  on the Graph toolbar. 

 

Linking Axes 
You can link the axes of multi-layer graphs so that when you change the 
axis scale in the parent layer, the child layer's axis will change 
accordingly.  Axes can be linked dimensionally, linked by axis scale 
values, or linked both dimensionally and by axis scale values. 
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To Link the X Axes: 
1. ALT + double-click on the layer 3 icon to open the Layer 3 dialog 

box. 
2. Click Layer Properties. 
3. Select the Link Axes Scales tab. 
4. Select Layer 1 from the Link To drop-down list. 
5. In the X Axis Link group, select the Straight (1 to 1) radio button. 

 

6. Click OK to close the Plot Details dialog box.   
7. Click OK in the Layer 3 dialog box. 
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You can test the axis link by double-clicking on the bottom X axis (this is 
Layer 1) and changing the From or To values on the Scale tab.  After 
clicking OK, the top X axis will reflect your changes. 

Note:  Though you only actively linked layer 3 to layer 1, all four layers 
of this graph are actually linked, directly or indirectly, to layer 1.  Recall 
that when you added layer 2, you added a linked right Y axis.  Recall 
also that when you added layer 4, you added a linked right Y axis.  
Thus, layer 2 is linked to layer 1, layer 4 is linked to layer 3, and layer 3 
is linked to layer 1.   
 
Any change to the physical dimensions or scale values of linked layers 
should be done to the parent layer (this is layer 1 in the above example).  
Changing dimensions or scale values of a child layer will not effect 
changes in the parent layer, and the linking criteria will not be respected.   

Customizing the Legend 
Origin automatically displays a legend when you create a new graph.  
Furthermore, legends are layer-specific, so that if your graph has multiple 
layers, Origin displays a legend for each layer.  If you add additional data 
to a layer, the legend will not update to include the new data unless you 
have selected the Auto Update check box on the Legends tab at the page 
level in the Plot Details dialog box (Format:Page).   

 

You can update the legend for the active layer at any time by clicking the 

New Legend button  on the Graph toolbar.  If there is currently no 
legend in the layer, Origin creates one. 
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A legend is really a specialized text label.  Origin names the text label 
Legend to identify it.  This name is stored in the legend's Label Control 
dialog box.  You can open this dialog box by selecting the legend and 
then selecting Format:Label Control.  If you should rename the legend, 
it retains it's current information, but it will no longer update when you 
click New Legend or when you add data to the layer. 

 

A legend text label also uses special formatting to display the data set 
names and the data plot type icon (such as a line).  If you double-click on 
the legend in the top layer of the current example, the in-place editing 
mode will display as shown in the following figure.   

 
The %(1) is called substitution notation.  This notation instructs Origin to 
display the data set name for the first data set in this layer.   
When you are performing an in-place edit of any label, you can use 
substitution notation.  For example, you can display the value of a 
specific data point in a data plot using the following substitution 
notation: 
%(WorksheetName, ColumnNumber, RowNumber) 
For example, if a worksheet is named Data1, and you have plotted 
columns A(X) and B(Y), you can display the value of the data point in 
column 2, row 3 using: 
%(data1, 2, 3) 
To enable use of this substitution notation, you must select the Link to 
Variables (%,$) check box in the Label Control dialog box (see the top 
of the dialog box, in the above figure). 
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In addition to substitution notation, Origin uses a special escape sequence 
to display the data plot icon in the legend.  This special escape sequence 
is:  
\L(DataListPosition) 
Where DataListPosition is the data plot's position in the data list at the 
bottom of the Data menu.  

 

If you double-click on a legend to enter the in-place editing mode, you 
will see the data plot icon, not the \L( ) escape sequence.  This is because 
Origin does not support using escape sequences in the in-place editing 
mode.  To use escape sequences, you must edit the label in the Text 
Control dialog box (see the following instructions).   

To customize the legend: 
1. In the bottom layer, click on the text portion of the legend reading 

Potential1 (mV), then press DELETE. 
2. In the top layer, right-click on the text portion of the legend reading 

Potential2 (mV) and select Properties from the shortcut menu.  This 
opens the Text Control dialog box.   
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3. In the Text Control dialog box, type the following text, overwriting 
\L(1) %(1): 
\L(1.1) Potential1 

\L(2.1) Pressure1 

\L(3.1) Potential2 

\L(4.1) Pressure2 

The preview box on the bottom of the dialog box shows what will 
display in the legend. 
4. Click OK. 
5. If necessary, drag the legend to a new location to minimize 

overlapping of graphic elements. 

Note:  The legend border may be somewhat larger than is needed.  To 
resize the border/background without resizing the legend text, click once 
on the legend border to activate the “resize border only” handles.  When 
a mouse-over produces a double-headed arrow, use your mouse to resize 
the legend border.  The text point size will not be affected. 
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The legend now displays the data plot type representations from all the 
layers in the graph.   

To prevent Origin from overwriting your custom legend (for example, if 
you should accidentally click the New Legend button on the Graph 
toolbar) you should rename the legend. 

To rename the legend: 
1. Right-click on the legend text. 
2. Select Label Control from the shortcut menu that opens. 
3. Type Custom Legend in the Object Name text box. 
4. Click OK. 

Note:  To automatically add all data plots in a graph window to a single 
legend, activate the graph, select Format:Page, click on the Plot Details 
Legends tab, and select Include Data Plots from All Layers. 

Saving the Graph as a Template 
Template files retain information concerning how data should be 
displayed, but templates do not save any actual data.  If you save the 
current graph window as a template, then the next time you need to 
create a similar graph, you can select your worksheet data and then select 
your custom graph template.  Your custom template is recalled by 

clicking the Template button  on the 2D Graphs toolbar or by 
selecting Plot:Template Library. 

To save your graph as a template: 
1. Right-click on the graph window title bar. 
2. Select Save Template As from the shortcut menu. 
3. Type Multilayer in the File Name text box. 
4. In the Template Category combo box, type My Templates.   
5. Click Save. 
To test your template, you can make the Layers worksheet active, select 
all worksheet columns, then select Plot:Template Library.  Select the 
My Templates category and then select your Multilayer template.  Click 
Plot to plot your data. 
This concludes the Multiple Layer Graphs tutorial. 
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Tutorial 8, Templates 

Introduction 
Templates are Origin child windows that have been saved as files with 
visual properties set to pre-defined values.  All Origin graphs are 
constructed by loading particular template files for each plot type.   
Each of the three major child window types have an associated file 
extension for templates:  
 

Child Window Template File Extension 
Worksheet .OTW 

Graph .OTP 

Matrix .OTM 

 
These files do not contain any data.  However, in the case of graph 
templates (OTP files), you must have plotted data in order to save any 
plot styles you have defined. 

Creating Worksheet and Matrix Templates 
Worksheets and Matrices are data containers that have similar visual 
editing dialogs which can be opened by double-clicking in the upper left 
of any worksheet or matrix window.  Worksheet properties can also be 
accessed with the Format:Worksheet menu command.  All the 
properties accessed from the Worksheet Display Control (or Matrix 
Display Control ) can be saved in a template.  
1. Open a new worksheet and double-click in the upper left corner (or 

select Format:Worksheet from the menu) to open the Worksheet 
Display Control dialog box.  This dialog controls the size and 
appearance of many worksheet elements unrelated to data. 

2. Edit the properties to match these settings: 
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3. Click the Page Color button to open the Page Color dialog.  This 
dialog box has options for coloring the worksheet background. 

4. Edit the properties to match these settings: 

 

5. Click OK twice (to exit both dialogs). 
6. Double-click on the A(X) column in the worksheet to open the 

Worksheet Column Format dialog.  This dialog box can be used to 
pre-set the plot type for select-and-click plotting and to control 
numeric formatting for display purposes. 

7. Edit the properties to match these settings: 
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8. Click OK. 
9. Enter the numbers 1 through 8 in rows 1 through 8 of column A(X). 
10. Highlight cells in rows 1 through 8 of column B(Y), right click and 

select Set Column Values to open the Set Column Values dialog 
box. 

11. Enter col(A) in the large text box, select the AutoUpdate check-box, 
and click OK. 

12. The values in column B will be the same as in column A, but with 
different numeric formatting.  Your worksheet should look like this: 

All the elements shown (minus the data) are saved in the template 
file. 
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13. From the menu, select File:Save Template As and save your template 
file.  If you overwrite the existing ORIGIN.OTW or ORIGIN.OTM, 
these templates will be used whenever you ask Origin for a new 
worksheet or matrix window.  

The data you entered will not be saved as part of the template – only the 
worksheet appearance, data formatting and column formulas are saved.  You 
should note that worksheets can have an associated Script that is also saved as 
part of the template. 

As with worksheets, matrices use the Worksheet Display Control and Page 
Color dialog boxes for visual properties.  Matrices also have three specialized 
dialogs available from the Matrix menu (visible only when a matrix is 
active).  All of the properties set in these three dialog boxes are saved in 
the matrix template.  

Matrix Properties  

The Matrix Properties dialog controls the numeric display format as well as 
column width and internal data storage. (Changing internal data storage to 
anything other than double(8) may disable some analysis functions.) 
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Matrix Dimensions 
The Matrix Dimensions dialog determines how much data is stored in the 
matrix (rows and columns) as well as the matrix mapping for plotting 
purposes. The columns of a matrix are linearly mapped to X values ranging 
from that assigned to the first column to that assigned to the last column. The 
rows of a matrix are linearly mapped to Y values ranging from that assigned 
to the first row to that assigned to the last row. These X,Y values are used for 
plotting the Z values contained in each cell. 

Matrix Values 

The Set Matrix Values dialog lets you define an equation for setting Z 
values (the cell values) using either X and Y coordinates or i and j  row 
and column numbers as parameters. 

Creating Graph Templates 
Most Origin plot types are created by loading pre-saved graph templates and 
adding selected datasets.  Most of the visual elements of a graph can be saved 
to a template and applied to new data.  If you save a graph window plotted 
from a menu or a button using the existing template name, then all graphs 
created by that menu or button will have the new appearance.  You can also 
save a graph template with your own name and it will become available in the 
Template Library (Plot:Template Library).  
1. Open a new worksheet and import the ASCII file GROUP.DAT from the 

TUTORIAL folder. 
2. Highlight columns B(Y) to D(Y) and select Plot:Line + Symbol from 

the menu. 
3. Select Format:Plot from the menu to open the Plot Details dialog. 
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Selecting any of the three branches in the tree at left (Graph, Layer or 
data plot -- designated as Group: A(X), B/C/D(Y) in this example) will 
activate individualized tabs on the right.  Different data plot types have 
different tab sets.  The Group tab that is shown is only available when 
multiple data plots have been grouped – which occurred automatically 
when we plotted multiple selected columns.  This tutorial only touches 
on a small number of the many possible changes that you can make to a 
graph.  
4. Click on the Symbol tab and note the Automatic button next to 

Symbol Color (Symbol Color has inherited the Line color in this 
case).  

5. Click the Automatic button and select Individual Color => Red. 
6. In the Interior drop-down, select Open.  This enables a new Fill 

Color button set to Automatic (Fill Color is coming from the Default 
Symbol Fill Color on the Graph page of the Options dialog available 
from the Tools menu). 

7. Click the Automatic button and select Individual Color => LT 
Yellow. 
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8. Click the Group tab and note the additional properties available. 
 We will keep the additional property increment boxes unchecked; 
they will not increment for each member of the plot group. 

9. Click the colors in the Details column of the Line Color row.  This 

action enables a browse button  at the right of the color bar. 
10. Click the New button to open a dialog and right-click on any of the 

colors to open a shortcut menu.  Note that you could edit or delete 
any color in the list or add new colors to the list. 

11. Select Load and choose Color List RGB. This changes the color list 
to just three colors. 

12. Right-click on Red and choose Delete.  Click OK.  Our color list 
now consists of only Green and Blue. 

13. Click the symbols graphic under Details in the Symbol Type row to 
enable its edit button.  Click the edit button. 

14. Right click on any of the symbols and select Load and choose 
Symbol List Triangles. 

15. Right click and Delete the left-pointing and the right-pointing 
triangles and click OK.  The incremental styles now consist of two 
colors and two shapes for a possible combination of four styles.  If 
you clicked OK at this point, the first and third datasets (B and D) 
would have Green lines and Up triangles while the remaining dataset 
(and a fourth if present) would have Blue lines with Down Triangles. 
 This would only use two style combinations. This is called 
Concerted behavior. 

16. Right-click anywhere in the Increment or Details column and select 
Nested. 

17. The property names are now gray boxes and we can reorder this list 
by dragging.  Drag the Symbol Type property so it appears above 
the Line Color property and click OK. Our finished plot shows 
three of the four possible style combinations which would repeat for 
additional datasets added to the group.  The graph should look like 
this: 
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18. Select File:Save Template As… from the menu and name this 
template TEMPLATE TUTORIAL and click Save.  Your template is 
now available for plotting any new data. 

19. Return to the original worksheet and add a new column.  Enter 4, 8, 
12, 16, 20 and 24 (to continue the progression of data).   

20. Highlight the B(Y) to E(Y) columns and select Plot:Template 
Library from the menu.  Select My Templates in the Category list 
and then select TEMPLATE TUTORIAL (or whatever you named 
it) in the Template list.   

21. Click Plot to create a new plot based on your template.  The graph 
should look like this: 
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Using Templates 
There are three primary ways in which templates are called: 
• From the Template Library (graph templates). 
• From the File:New... menu (any template type). 
• From LabTalk or OriginC program code (any template type). 
The graph template that we created in this tutorial relied on the datasets 
being members of a Group.  Grouping occurs automatically when we 
select multiple columns for our plot. 
Selecting new multiple datasets and plotting through the Template 
Library will show the new data correctly.  You will also get this 
behavior if you select multiple columns and go to our graph template and 
select Graph:Add Plot to Layer.  Plotting through the Template Library 
without selecting columns (which brings up the Select Columns for 
Plotting dialog box) or by loading a template through the File:New 
menu will not result in grouped data; all datasets will have the styles of 
the first dataset.  If you subsequently group the datasets, then they will 
show the group plotting behavior we designed into the template.  
Similarly, dragging multiple selected datasets onto a graph will exhibit 
group behavior while dragging individual datasets will exhibit individual 
behavior.  You can always group the datasets after plotting by accessing 
the Layer dialog (double-click on the layer icon/number in the upper left 
of a graph window) and selecting those datasets that you wish to group. 
Use of graph templates in LabTalk or OriginC similarly depend on the 
plotting methods used and whether that method groups datasets or not. 
 
 
This concludes the Templates tutorial. 
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Tutorial 9, Themes 

Introduction 
Themes provide a method for applying a suite of pre-defined format 
options to an object, a data plot, a graph window, or a set of graph 
windows, regardless of the target object/plot/graph window's original 
format or plot style.  This differs from Templates which have the graph's 
(or the worksheet's and matrix's) appearance stored in a file which must 
be loaded by a user and which -- in the case of graph templates -- contain 
plot styles.  With Themes, you can copy style elements (either in whole 
or in part) from one existing window and apply them to another.  Only 
those elements defined in the Theme, are applied to the target graph. 
Origin ships with a number of built-in Themes, plus you can edit any 
theme or create your own new Theme.  You can also designate a System 
Theme which is applied to all graphs you make, overriding equivalent 
template properties.  Group Incremental Lists – a subset of Themes – 
allow you to define a list for a particular property -- say color (e.g. red, 
purple, green, yellow) or fill pattern (e.g. dense diagonal left, sparse 
diagonal right, sparse cross-hatched) -- and have the list elements applied 
in either a Nested or Concerted incremental fashion to multiple grouped 
data plots.  

Creating and Applying a Theme 
You can create a new Theme by copying from an existing graph or 
Theme or by Adding a new Theme and building it one element at a time. 
  A Theme will consist of any or all of the elements of a graph layer that 
you choose to include.  Several dialogs assist you to this end. 
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The right-click context menu of a graph offers two options for creating a 
Theme from a Graph:  
• Copy Format holds the copied Theme in memory. 

 
• Save Format as Theme saves the copied Theme to a file. 

 

Let’s begin by copying a Theme from an existing graph: 
1. Open the  PLOTS.OPJ found in Origin’s TUTORIAL folder. 
2. Create a new worksheet and import (using ASCII) GROUP.DAT from 

Origin’s TUTORIAL folder. 
3. Highlight the B, C and D columns and click the Scatter (graph) button 

. 
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4. Move the new Graph1 window off all existing windows and activate the 
MixedScale window so that MixedScale and Graph1 are both visible. 

5. Right click on the MixedScale graph (making sure you do not select 
anything with your click) and select Copy Format:All in the context 
menus. 
When your click selects something – such as grid lines in the MixedScale 
window – you can only copy from or paste to that selection. 

6. Right click on the Graph1 window and select Paste Format. 

Oops! Our data seems to have vanished from our graph! 

 

By copying all formatting elements, we included scales that were not 
appropriate for the data in Graph1. 
7. Select Edit:Undo from the menu to restore our Graph1. 
8. Return to MixedScale and right click and select Copy Format:All 

Style Formats (which excludes Dimension and Scales). 
9. Return to Graph1, right click and select Paste Format. 



 

 

Tutorial 9, Themes 

186 •  Creating and Applying a Theme 

 

 

 

Here is our graph now:  
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10. Right click on our Graph1 again and select Save Format as Theme.  
11. Name the theme Before Edit, check the All Styles radio button and 

click OK.  
The Theme is saved in the Themes folder in Origin and is now available 
for use. 
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The Theme Gallery and System Themes 
1. Select Format:Theme Gallery from the Origin menu (or press F7) 

to open the Theme Gallery dialog box.  

  

Note the Theme that we saved (highlighted for clarity).  
In this dialog box, you can select a theme to Duplicate, Delete or Edit. 
 You can also Apply theme to Graph, Folder (all graphs in a folder) or 
Project (all graphs in a project).  Selecting a check box under the System 
heading makes that item the System Theme (which applies to all graphs 
you create).  
Clearing Exclude increment lists will show you Group Incremental 
Lists (which apply only to grouped datasets which have one element set 
to Incremental), as well as Themes.  You can also construct a Theme 
from scratch using the Add button. 
Let’s make a copy of our Theme, combine it with another available 
Theme and make the new Theme our System Theme: 
2. With our Before Edit theme selected, click the Duplicate button. (A 

new Theme is created and selected.) 
3. Click the Edit button to open the Theme Editor. 
4. Enter My system theme in the Description field. 
5. Click the List View box to collapse the "tree" into a simple list. 
6. Click the first Value item (the None next to 

Page.Background.BaseColor) and select Yellow from the color list. 
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7. Scroll to the bottom of the list and click the color bar under Value 
next to Global.ColorList and click the button which appears on the 
right of the list. 

8. Right-click on any color in the dialog box that opens and select 
Load:Color Lists RGB.OTH (This is an example of a incremental 
list; it is a sort of limited theme which, in this case, only stores 
colors). 

9. Click OK twice (to close two dialog boxes) and return to the Theme 
Gallery. 

10. Double click on the Theme1 name and rename it After Edit. 
11. Check the box under System next to After Edit. 
12. Click Close. 

 

Notice that After Edit appears on the status bar in Origin to indicate that 
a System Theme is in use. 

Editing a Theme 
1. Return to our GROUP worksheet, select columns B, C and D and 

click the Column graph button .  Our new graph is clearly 
different than the Column plots we normally see in Origin. 

2. Double click on any column to open the Plot Details dialog box.  
3. Check the Increment boxes next to Border Color and Fill Color. 

 This enables the short Red-Green-Blue color list in our Theme for 
group incrementing of our datasets.  

4. Click OK to close the dialog box. 
Let’s make one more change using Themes.  Press F7 to open the Theme 
Gallery.   
5. Select the Ticks All In theme and click the Apply Theme button. 
6. Close the Theme Gallery.  
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Our completed graph now has all tick marks pointing inward: 

 

We made a change to our graph, so to save the change: 
7. Right click on the graph and select Save Format as Theme.  
8. Type After Edit in the Name of the New Theme text box, click All 

Styles and click OK.  
A message box warns us that we are replacing an existing theme.  
9. Click OK.   
10. Return to our GROUP worksheet, highlight columns B, C and D and 

click the Line button  to create a line plot.  Note that our System 
Theme can be applied to other plot types, too. 

 
 
This concludes the Themes tutorial. 
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Tutorial 10, 3D Surface and 
Contour Graphs 

Tutorial 10, 3D Surface and Contour Graphs 
There are two primary data structures in Origin:  worksheets and 
matrices.  Data stored in worksheets can be used to create any 2D graph 
and some 3D graphs, but in order to create a 3D surface graph or a 3D 
contour graph you must have your data stored in a matrix.  Origin 
provides methods for converting worksheets to matrices, and for 
converting matrices to worksheets.   

An Introduction to Origin Matrices 
Matrices have numbered columns which are mapped to linearly spaced X 
values and numbered rows which are mapped to linearly spaced Y 
values.  You can view the X and Y values in the matrix column and row 
headings by selecting View:Show X/Y.  Each cell value in a matrix 
represents a Z value which is located in the XY plane by the cell's X 
value (determined by its column) and by the cell's Y value (determined 
by its row).  

To learn more about the XY mapping in a matrix: 

1. Click the New Matrix button  on the Standard toolbar to create 
an empty matrix.   

2. Select Matrix:Set Dimensions to specify its dimensions and 
coordinates.   

3. In the Dimensions group, type 21 in the Columns text box and 21 in 
the Rows text box.   

4. In the Coordinates group, type -10 in both the First X (Columns) 
text box and the First Y (Rows) text box.   

5. In the Coordinates group, type 10 in both the Last X (Columns) 
text box and the Last Y (Rows) text box.   
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6. Click OK.  Use the horizontal and vertical scroll bars on the matrix 
window to verify that you have created a matrix with 21 columns 
and 21 rows. 

7. From the Origin menu, select View:Show X/Y.   
8. Use the horizontal and vertical scroll bars on the matrix window to 

verify that column (X) and row (Y) headings range from -10 to 10.   
You can see that there are two ways to view the matrix column and row 
headings – by column or row number (View:Show Column/Row)or by 
the X and Y axis values (View:Show X/Y).  When we create our 3D plot 
from this matrix window, you will see that both X and Y axis values 
range from -10 to 10, so it should be clear that the values that you specify 
in the Coordinates group of the Matrix Dimensions dialog will determine 
your 3D graph X and Y scale values.   
9. From the Origin menu, select Matrix:Set Values.  This opens the 

Set Matrix Values dialog. 
We can use this dialog to fill our empty matrix with Z values.  You 
might, for instance, want to plot a mathematical function in 3D.  To 
demonstrate: 
10. Type x in the Cell(i,j)= text box and click OK.  Each cell in each 

column is filled with a number equal to the X value of that column.   
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11. Re-select Matrix:Set Values and this time type y (replacing x) in 
the Cell(i,j)= text box.  Click OK.  Each cell in each row is filled 
with a number equal to the Y value of that row. 

12. Once more, select Matrix:Set Values and type the equation 
cos(x)+sin(y) in the Cell(i,j)= text box.  Click OK.  The matrix is 
filled with numbers.   

The value in each cell, z, is determined by the relationship cos(x)+sin(y); 
where x=x coordinate value and y=y coordinate value.  There is no 
particular significance to our made-up function;  we only want to point 
out that when you specify x or y in a function in the Set Matrix Values 
dialog, the x and y coordinate values will be used to calculate the z value. 

To create a 3D Contour plot from a matrix of values: 
13. Select Plot:Contour Plot:Contour-Color Fill to create a contour 

graph of the matrix data.  Note the X and Y scales (-10 to 10) on the 
resulting graph. 
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Converting a Worksheet to a Matrix 
In many, if not most, cases, your data will be stored not as a worksheet or 
spreadsheet of z values but rather as a worksheet of x,y,z triplets.  When 
this is the case, you must convert your worksheet to a matrix of z value 
before you can create a 3D surface or contour plot.  In this section you 
will learn how to convert an XYZ worksheet to a matrix so that it can be 
plotted as a 3D surface graph. 
The data for this lesson is provided in an ASCII file. 

To Import the ASCII File: 

1. Click New Project  on the Standard toolbar. 

2. Click Import ASCII  on the Standard toolbar. 
3. In the Origin \Tutorial folder, select Tutorial_5.DAT from the list of 

files. 
4. Click Open.   
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By default, when the file is imported, columns are added to the 
worksheet as Y columns.  To convert the worksheet to a matrix it must 
be in an XYZ format.  Recall that we can change a column’s plot 
designation in a couple of ways: 
• Double-click on a worksheet column heading to open the Worksheet 

Column Format dialog box. 
• Right-click on a column heading and choose Set As (X, Y, Z, etc.) 

from the shortcut menu. 

To Change the Column Designation: 
1. Right-click on the C(Y) column heading. 
2. Select Set As:Z from the shortcut menu.  Column C is now 

designated as a Z column. 

Selecting the Type of Conversion 
Origin provides several methods for converting worksheets to matrices, 
including direct, expand columns, 2D binning, regular XYZ and random 
XYZ conversions.  The method that you choose will depend on the 
nature of your worksheet data.   
We will give a brief run-down of the matrix conversion methods 
available to you, but we also encourage you to study the information in 
Worksheet to Matrix.OPJ in the \Samples\Analysis\Worksheet to Matrix 
folder in your Origin software directory. 
• Direct Conversion:  A common format for XYZ data is to have X 

data values in the left-most column, Y data values in the first row, 
and Z values in columns 2 to N and rows 2 to M.  If your worksheet 
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(or Excel spreadsheet) data are organized in this way, you should 
probably use Direct Conversion.   

• Expand Columns:  There may be cases where a screen editor which 
is used to create an ASCII file has an upper limit for the number of 
characters allowed on a single line.  This upper limit may even be 
less than the number of columns required in the matrix.  To 
compensate for this, one row of matrix data can be stored in multiple 
rows of an ASCII file.  After this type of data is imported in a 
worksheet, the Expand Columns method will copy the number of 
worksheet rows that you specify into the first row of a matrix.  
Origin repeats this procedure to convert all rows in the worksheet.  

• 2D Binning:  This method bins the XY data (creates a frequency 
count of data points falling within a given XY range) and stores the 
bin counts as Z values in a matrix. 

• Regular XYZ:  In order for XYZ worksheet data to be considered 
Regular (a) each X value must have the same number of Y values 
and each Y value must have the same number of X values and (b) 
both the X and the Y data values must be equally  

• Sparse XYZ:  This method converts “regular” XYZ data to a matrix 
by assuming missing values for missing X,Y data pairs.   

• Random XYZ:  If your worksheet data are not of the previously 
mentioned types, then it can be classified as random data.  The 
procedure for converting random XYZ data to a matrix is called 
gridding.  Origin offers a number of gridding methods, including the 
method of Renka and Cline and a modification of Shepard's method.  
Both these methods are provided by the NAG® C Library eo1 
Interpolation.   

Most likely, you will use either the Regular XYZ or Random XYZ 
worksheet to matrix conversion methods.  There is a simple test that you 
can use to determine which method is best suited to your data.  This 
involves selecting only the X and Y columns of your XYZ worksheet and 
plotting the XY data as a scatter plot.  If the resulting plot resembles an 
“orchard in plan view” (each scatter point is a “tree”), you can conclude 
that the data are Regular XYZ data.  If the resulting plot displays no such 
regularity, it is Random XYZ data. 
1. Activate the Tutorial5 worksheet, select the X and Y columns of 

data, and click the Scatter Graph  button.  The resulting plot 
looks like this: 
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Clearly, our data are not regularly spaced in the X and Y dimensions, so 
we will convert our worksheet to a matrix using one of Origin’s Random 
XYZ gridding methods. 

To convert the worksheet to a matrix: 
1. In the Tutorial5 worksheet, select the C(Z) column heading.   
2. Select Edit:Convert to Matrix:Random XYZ.  This opens the 

Random XYZ Gridding dialog box.   
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3. Select Renka-Cline from the Select Gridding Method drop-down 
list if it is not already selected.  

4. Select the Show Plot check box if it is not already selected. 
5. Click Apply.  A graph is created that shows the raw data as an XYZ 

scatter plot (the Show Plot check box) and the gridded data as a 3D 
Wire Frame plot.   

The superimposition of the raw data on the gridded data allows you to 
quickly assess a gridding method’s effectiveness.  Obviously, you don’t 
want your gridded data to depart radically from your raw data. 

 

You can change the gridding method – each time clicking the Apply 
button – to compare the graph output for the various methods and then 
choose the method which produces a surface that most closely coincides 
with your raw data.  For our example, the Renka-Cline method is the best 
choice.   
6. Click OK to close the dialog box.   
7. Activate the matrix window that contains the Renka-Cline gridding 

data.   

Note:  If origin cannot display an entire cell value, it displays # character 
in the cell.  To increase the column width of the matrix, select 
Matrix:Set Properties, and adjust the Cell Width.  This affects all 
columns in the matrix. 
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Graphing and Speed Mode 
Now that you have your data in a matrix you can create any of Origin’s 
contour or 3D surface graphs.  For this tutorial you will create a 3D color 
mapped surface graph.   

To create a 3D color mapped surface graph: 
1. With the Renka-Cline gridding matrix active, select Plot:3D Color 

Map Surface.  A Reminder Message reports that the graph will be 
displayed using Speed Mode.   

 

Speed mode can be very useful for increasing the screen redraw speed of 
your graph by displaying a reduced number of data points.  While the 
effect is not noticeable for plots created from smaller matrices, it can be 
very significant for plots of very large matrices. 
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At other times, you may find that reducing the number of plotted points 
is the only way to produce an intelligible data plot;  imagine, for 
instance, trying to create a scatter plot of 1 million data points.   
Speed mode reduces the number of plotted by points by systematically 
weeding out every nth data point from your dataset.  Speed mode can be 
invoked at three levels depending on your requirements: 
• Video display  
• Clipboard Images and Graphic Export files  
• Printout 
At the video display level, you can control speed mode by activating 
your graph and selecting Format:Layer from the menu.  This opens the 
active layer's Plot Details dialog box.  Select the Size/Speed tab and edit 
the Speed Mode, Skip Points if needed group. 

 

This speed mode setting only effects the display of the graph in Origin.  
When you copy, export, or print your graph, all the data points will be 
included.   
To invoke speed mode for Clipboard (copied) or exported images (BMP, 
TIF, JPG, etc.), select Format:Page.  This opens the Plot Details dialog 
box.  Select the Miscellaneous tab and, in the Performance group, select 
the If speed mode is enabled for display… check box.  This will apply 
your speed mode settings to your copied/exported graph. 

 

Lastly, you can reduce the number of data points in your printouts, using 
the settings in the Print Graph group of the Print dialog box (File:Print 
from the Origin menu). 
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2. Click OK to close the speed mode reminder message.  The matrix 
data is plotted as a color map surface graph.  The different colors 
represent different Z-value ranges. 

Note that Origin 7.5 
now provides 2 visual 
cues to remind you that 
Speed Mode is on: a 
red-colored layer icon 
in the upper-left corner 
of the graph window 
and a non-printing 
Speed Mode is on 
watermark across the 
graph. 

See Speed Mode in the 
Origin Help file 
(Help:Origin)  for more 
information. 

3. From the Origin menu, select Format:Layer.  This opens the Plot 
Details dialog. 

4. Select the Size/Speed tab. 
5. In the Speed Mode, Skip Points if needed group, clear the Matrix 

data, maximum points per dimension check box and click OK.   
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Note that the appearance of your graph has changed somewhat.  The 
default speed mode settings limited the portion of the matrix that plotted 
to 15 rows and 15 columns, but by clearing this check box, we are now 
plotting the full 20 rows by 20 columns of data.   

 

Customizing the Graph 
Origin gives you full control over the color mapping applied to the 
surface data plot.  You can customize the color map by changing the 
settings on the Color Map tab of the Plot Details dialog box.   
The Color Map tab displays the current color map; with different colors 
representing a particular range of z values from zMIN to zMAX.   To edit an 
individual level or color, click on the value or color in the Level or Fill 
column.  To edit the entire range of levels or colors, click on the Level or 
Fill column heading.  To edit a range of levels, SHIFT + click on the 
desired values to select a range, then click on the Level or Fill column 
heading. 

To change the number of levels in the color map: 
1. Right-click on your 3D Color Map Surface plot (take care not to 

click on the contour lines or on the side walls) and select Plot 
Details from the bottom of the shortcut menu.   
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Note:  If you have a problem getting to Plot Details from the shortcut 
menu, you can choose Format:Plot from the Origin menu.  Both will 
open the Plot Details dialog to the Color Map tab. 

2. Click on the Level column heading to open the Set Levels dialog 
box. 

3. Select the Num. of Levels radio button, type 12 in the associated 
text box, and click OK. 

 

The Color Map tab updates to show twelve levels (plus levels for values 
above and below the maximum and minimum levels) and associated 
colors in the list box. 
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Customizing the Color Map 

To customize the color fill characteristics: 
1. Click on the Fill column heading to open the Fill dialog box.   
2. From the From drop-down list, select Red 
3. From the To drop-down list, select Green.  

 

4. Click OK. 
5. In the Plot Details dialog box, click OK. 
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In addition to editing color ranges, you can edit individual colors.  This is 
especially useful if you have an important section of your data that you 
want to highlight or make transparent. 

To edit an individual color: 
1. Right-click on the color map surface plot.   
2. Select Plot Details from the shortcut menu. 
3. On the Color Map tab, click on the color associated with 1.75E -4.   

 

This opens the Fill dialog.  Note that this controls the fill color only for 
Level 1.75E-4. 
4. Select Dark Gray from the Fill Color drop-down list and click OK. 
5. In the Plot Details dialog box, Click OK. 
The data plot redraws with the 1.75E-4 level in dark gray. 
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Adding Contours to the Color Map Surface 
Graph 

To further enhance your graph, you can display contour lines or project 
your color map onto the top or bottom plane of your surface graph.  This 
is done on the Surface / Projections tab of the Plot Details dialog box.   

To project your color map onto the bottom plane of the 3D Color Map 
Surface graph: 
1. Right-click on the surface graph. 
2. From the shortcut menu, select Plot Details. 
3. Select the Surface / Projections tab. 
4. Under Bottom Contour, select the Fill Color check box  

 

5. Click OK. 
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With the current Z axis scale range and the current view angle, the 
surface plot substantially overlaps the bottom contour, blocking it from 
view.  To make more of the contour visible, change the Z axis scale to 
begin from a lower value. 

To Change the Z Axis Scale: 
6. Select Format:Axes:Z Axis to open the Z Axis dialog box. 
7. In the From text box, type -1E-4. 
8. Click OK. 

 

The Z axis now displays a greater range below the surface graph.  This 
decreases the amount of overlap of the surface plot and the projection, 
providing for a better visual presentation. 

Changing the Perspective of the Graph 
When you create a 3D graph, the 3D Rotation toolbar automatically 
opens.  This toolbar provides buttons for controlling the perspective of 
the 3D graph.  By rotating the graph you can further reduce the overlap 
of the surface plot with the contour, providing better perspective for 
viewing the graph. 
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To rotate the graph: 

1. On the 3D Rotation toolbar,  click Tilt Up . 

2. On the 3D Rotation toolbar, click Rotate Clockwise . 

 

This new perspective eliminates much of the overlap between the surface 
plot and the projection, and provides better visibility of the dark gray 
section of the surface plot. 
 
 
This concludes the 3D Surface and Contour Graphs tutorial. 
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Tutorial 11, Nonlinear Curve 
Fitting 

Introduction 
Origin offers several methods of fitting functions to your data.  These 
methods vary in speed and complexity so that you may choose the 
method that best fits your needs. 
In this tutorial, you will be introduced to fitting using the menu 
commands, the tools, the fitting wizard (NLSF Wizard), and the 
advanced fitting tool (NLSF).  You will then use the NLSF to define your 
own function and fit sample data.   

Fitting from the Menu 
Origin offers access to several fitting functions directly from the 
Analysis menu.  To perform a fit on your data using the menu 
commands, make sure that the data plot you want to perform the fit on is 
active, then select the type of fit you want to perform from the Analysis 
menu.  
Most of the menu commands require no parameter input from you; the fit 
is performed automatically.  Some may ask you for some parameter 
information, but will suggest default values based on your data.   
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After performing the fit, Origin displays the fit curve in the graph 
window, and types the results to the Results Log.   

 

 

To perform a fit using one of the fitting functions available from the 
Analysis menu: 

1. On the Standard toolbar, click the Open button .   
2. In the \Tutorial folder, open the file FITEXMP1.OPJ.  The project 

contains one worksheet and one graph. 
3. Verify that the graph is the active window.  From the menu, choose 

Analysis:Fit Exponential Decay:First Order. 
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Origin generates a best-fit model for the dataset using the ExpDec1 
fitting function.  The best-fit curve is plotted as a red line through the 
data plot. 
The Results Log reports data relevant to the fit:  the date and time, the 
graph page, the curve fitting equation, chi-square and r-square values, 
and the parameter and parameter error values.   

Fitting Using the Tools 
For those who require a greater degree of control over your curve fit 
operations than the menu commands allow, Origin provides three fitting 
tools:  the Linear Fit, Polynomial Fit, and Sigmoidal Fit tools.  These 
tools can be opened from the Tools menu when either a worksheet or a 
graph is the active window.   

 

        

To use the fitting tools, (1) select the data set or data plot you want to fit, 
(2) open the tool and customize the options on both tabs of the tool, and 
(3) click the Fit button on the Operation tab.   
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Begin this tutorial with a new project: 

1. Click New Project  on the Standard toolbar. 

To perform a fit using the Sigmoidal Fit tool: 

1. On the Standard toolbar, Click the Import ASCII button .   
2. In the \Samples\Data folder, open a file named SigmoidalLog.DAT.   
3. In the SigmodalLog worksheet, select the B(Y) column and click the 

Scatter button , or, from the menu, choose Plot:Scatter.  A 
scatter graph is created. 

 

4. Double-click precisely on the X axis (not on the axis tick labels).  
The X axis dialog box will open to the Scale tab (if you missed with 
your mouse-clicks and got another tab, just select the Scale tab). 

5. From the Type drop-down list, choose Log10 and click OK.  The X 
scale changes to a log scale and the plot has taken on a sigmoidal 
shape. 

6. From the menu, select Tools:Sigmoidal Fit.  The Sigmoidal Fit tool 
opens. 

You will notice that Asymptotes and Parameters groups display some 
initial values.  You can accept the defaults.  In most cases, you will not 
need to adjust these, as Origin will initialize the parameters once you 
click the Fit button.   
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7. Click the settings tab and notice that the Logged Data Fit Function 
group has two options for log scaled data:  Boltzmann and Dose 
Response.  We will leave the Dose Response function selected.   

8. Return to the Operation tab and click Fit.  Origin performs a 
sigmoidal fit on the data and types the results to the Results Log 

 

Note that the Logistic model was used.  This model is commonly used 
for dose response studies in pharmacology.  The formula for this, and 
other Origin fitting functions, can be found in the .FDF file (a text file) 
that resides in the \FitFunc folder.  The formula for this particular 
function: 

y = A2 + (A1-A2)/(1 + (x/x0)^p) 

We should point out some of the post-fit functionality of the Sigmoidal 
Fit tool.  At the bottom of the operation tab is a FindX/Find Y group that 
allows you to find a Y value from an inputted X value or an X value from 
an inputted Y value.   
The methods differ for FindX and FindY, but the calculation of the X 
value from an inputted Y is very straightforward.  The Y value is 
calculated using the best fit model that we just calculated using the 
Sigmoidal Fit tool.  We merely input an X value and Origin calculates 
the Y value using the above equation and parameter values. 

To find a Y value based on an inputted X value: 
1. Enter 40 in the FindX text box. 
2. Click FindY.  Origin calculates a Y value of  40.22945. 
You could get out your calculator and see for yourself that our best fit 
model will return a value of 40.22945 when X=40, but rather than do 
that, let’s digress here for a moment and have a bit of fun. 

3. On the Standard toolbar, click the Script Window button .  This 
opens the Script window. 



 

 

Tutorial 11, Nonlinear Curve Fitting 

214 •  Fitting Comparison 

 

 

 

Origin’s Script window has many uses, but one of the simplest 
applications is to use it to perform calculations.  We demonstrate this in 
one of the later Command Line Tutorials, but let’s get our toes wet now 
and learn a bit more about one of  Origin’s many capabilities.   
4. In the Script window, type: 

A1= 

5. Press ENTER. 
Origin responds with 96.56111.  Note that this is the value Origin 
calculated for the parameter A1.  Origin has temporarily stored our 
parameter values in memory.   
6. Now let’s type our Logistic equation into the Script window: 

y = A2 + (A1-A2)/(1 + (x/x0)^p) 

7. Press ENTER. 
Origin responds by placing a semicolon at the end of the equation. 
Now, let’s give Origin our X value of 40 and see it return our Y value. 
8. Type in the following into the Script window: 

x=40; 

9. Press ENTER. 
Origin responds by placing a semicolon at the end of the line. 
10. Now type in: 

y= 

11. Press ENTER. 
Origin places a semicolon at the end of the line and returns: 

Y=40.22945 

This is, of course, our FindY value. 
The point of this little digression was simply to demonstrate that Origin 
is a very powerful program.  We hope that as you begin to work with 
Origin, that you will come to appreciate the fact that it is much more than 
a top-notch scientific graphics package.  It is also a very powerful 
analysis package that provides a wide variety of tools for “massaging” 
and analyzing your data. 
Now, let’s return to our Curve Fitting tutorial. 

Fitting Comparison 
A Fit Comparison tool is available to determine if two data sets are 
representative samples drawn from the same population.  This tool 
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compares the data sets by fitting the same function to the data.  It then 
uses an F-test to determine whether the data sets are significantly 
different from each other.  To open the Fit Comparison tool when a 
worksheet or graph is active, select Tools:Fit Comparison.   

 

To compare two datasets using the Fit Comparison tool: 

1. Click the New Worksheet  button. 

2. Click the Import ASCII button .   
3. In the \Samples\Data folder, open a file named Lorentzian.DAT.   
4. Select columns B(Y) and C(Y). 
5. From the menu, select Tools:Fit Comparison… 
6. Verify that the Datasets group registers Lorentizian_B and 

Lorentzian_C. 
7. Category should be set to Origin Basic Functions. 
8. From the Function drop-down list, select Lorentz. 
9. Click Compare.   
Origin performs a comparison of the selected datasets and types the result 
to the Results Log.  In this particular case, Origin finds that, at the 0.05 
level, the two datasets are statistically different;  it is highly unlikely that 
they represent samples drawn from the same population. 

Note:  The Refresh button should be used to update the Datasets or 
Category and Function drop-down lists when, for instance, different 
datasets are selected for comparison , new datasets are added to the 
project file, or new functions are defined in the Nonlinear Least Squares 
Fitter (NLSF). 
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The Fitting Wizard 
Origin provides two, progressively more advanced tools for performing 
nonlinear least squares fitting:  the NLSF Wizard and the Advanced 
Fitting Tool (the NLSF, or Nonlinear Least Squares Fitter).   
The wizard – as it’s name implies – is quite easy to use but it doesn’t 
allow as much control over the fitting process as the NLSF does.  For 
instance, you cannot define a new fitting function using the Wizard;  this 
must be done through the NLSF (though once defined via the NLSF, 
user-defined functions become available in the Wizard).  In addition, to 
fit multiple data sets to a function, fit with multiple independent or 
dependent variables, or run scripts at specified triggers (for example, 
after a fit is performed), you must use the NLSF.   
Yet, the Wizard provides enough control to be an effective and flexible 
fitting tool.  It is highly customizable, allowing you to do such things as 
hide unneeded pages and save your procedure to a button for repeat 
analyses using other datasets. 
To open the NLSF Wizard when a worksheet or graph is active, select 
Analysis:Nonlinear Curve Fit:Fitting Wizard.   

 



 

 

Tutorial 11, Nonlinear Curve Fitting 

The Advanced Fitting Tool •  217 

 

 

 

The Advanced Fitting Tool 
The advanced fitting tool (NLSF) is Origin's most powerful and complex 
method of fitting data.  To open the NLSF when a worksheet or graph is 
active, select Analysis:Nonlinear Curve Fit:Advanced Fitting Tool.    
There are two display modes available for the NLSF:  basic and 
advanced.  You can switch between modes by clicking the More button 
in the basic mode or the Basic Mode button in the advanced mode.   

The Basic Mode 
The basic mode of the NLSF provides an abbreviated fitting function list 
and a less complex interface than the advanced mode.  Additionally, the 
basic mode offers less control over the fit and less customization of the 
reported results. 

 

The Advanced Mode 
The advanced mode lets you customize all aspects of the fitting process.  
It provides access to many more fitting functions than the basic mode and 
the functions are separated into categories to facilitate searching.  The 
advanced mode also has its own menu and toolbar to provide access to all 
its features.   
To select a function in the advanced mode, first select Function:Select 
from the NLSF menu if the Select Function page is not active.  Then 
select the appropriate category from the Categories list box, and select 
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the desired function from the Functions list box.  Once a function is 
selected, the procedure for fitting is the same as for fitting after you 
define your own function (see the following sections). 

 

Defining a New Fitting Function 
In this tutorial, we will define and compile a new fitting function using 
Origin C, Origin’s built-in programming language.  We could also define 
the fitting function using LabTalk script, Origin’s built-in scripting 
language.  However, defining the function using Origin C delivers more 
in terms of flexibility and speed (up to 20X faster than LabTalk).  
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To Open the Project File: 

1. On the Standard toolbar, click the Open button .   
2. In the \Tutorial folder, open ASYMGAUSS.OPJ.  The project opens 

showing a worksheet containing data and a graph window containing 
a data plot. 

We will define a new function for fitting data with an asymmetric 
Gaussian peak shape. An asymmetric Gaussian is a peak function 
characterized by different widths on either side of the peak center, and is 
defined as: 
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The basic mode of the NLSF only permits defining new functions with 
LabTalk script. We will use the NLSF’s advanced mode so that we can 
use Origin C. 

To define your own Function in Advanced Mode: 
3. From the menu, choose Analysis:Nonlinear Curve Fit:Advanced 

Fitting Tool. This opens the NLSF. 
4. If the NLSF opens in the basic mode, click More to switch to 

Advanced mode. 
5. From the NLSF menu bar, select Category:New.  This opens the 

Category Name dialog box. 
6. Type in: 

Tutorial Example 

7. Click OK.   
Tutorial Example is added to the Categories list. 
8. From the NLSF menu bar, select Function:New.  This opens the 

Define New Function dialog box. 
9. In the Name text box, type the following: 

AsymmetricGaussian 

Note:  Spaces are permissible in category names but not in function 
names. 
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10. Select the User Defined Param. Names check box. 
11. In the Parameter Names text box, enter:  

y0,A, xc, sig1, sig2 

12. Verify that the Use Origin C check box is checked, and click the 
Edit in Code Builder button.  The Code Builder IDE opens with a 
specialized window intended for defining new fitting functions.   

13. In the editable part of the Code Builder workspace, type in the 
following lines of code: 

double B = A / (0.5 * (sig1 + sig2) * sqrt(2 * pi)); 

if( x < xc ) 

y = y0 + B * exp(-0.5 * ((x - xc) / sig1) ^ 2); 

else 

y = y0 + B * exp(-0.5 * ((x - xc) / sig2) ^ 2); 

14. Click the Compile button to compile the function code.  Origin types 
Done! to the Code Builder output window.   

15. Click the Return to NLSF button.  This returns you to the NLSF 
tool.  Note that our new fitting function registers in the Definition 
text box. 

16. Click Save to save the function. 
The function is saved under the name AsymmetricGaussian.  This 
function will now be available in the list of functions under the Tutorial 
Example category. To verify this: From the NLSF menu, select 
Function:Select.  To return to the current view, select Function:Edit. 

Assigning the Function Variables to the Data 
Sets 

The next step is to assign the independent and dependent variables to the 
corresponding X and Y data sets.   

To assign the function variables to the data sets: 
1. From the NLSF menu, select Action:Dataset.  This opens the Select 

Dataset dialog box.   
2.  Select the y variable in the top list box. 
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3. In the Available Datasets list box, select data1_b. 

 

4. Click the Assign button to the right of this list box.  Note that the x 
and y data sets are assigned to the dependent and independent 
variables (top list box). 

How did Origin know to assign the data set data1_a to the independent 
variable x?  Origin assumes that the y data set should be associated with 
the nearest x data set to the left of the y data set.  While Origin can work 
with other arrangements, this is the default Origin behavior. 

Assigning Initial Parameter Values 
For the iterative fitting process to succeed, the NLSF must have 
reasonably good initial parameter estimates.  You can manually assign 
initial values or you can write code that analyzes your data and performs 
some parameter initialization.  You can also simulate the fit curve by 
trying various parameter values;  when the simulated curve and raw data 
plot converge, you can assume that you have arrived at reasonable initial 
parameter values.   

Note:  Origin provides data set-specific parameter initialization for all 
built-in fitting functions. 

In this tutorial, we will manually assign the initial values during the 
fitting session.  For more information on simulating the fit curve, search 
on “simulate” in the Origin help file (Help:Origin).  For further 
information on writing your own parameter initialization code, search on 
“parameter initialization.” 
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Fitting the Data 
We are now ready to fit our data using our AsymmetricGaussian 
function. 

To fit the data: 
1. From the NLSF menu, select Action:Fit.  This activates the Fitting 

Session dialog box. 
2. Type in the following initial parameter values: 

y0:      10 

A:       10 

xc:       5 

sig1:     1 

sig2:     1 

3. Click the Chi-Sqr button.  The reduced chi-squared value for the 
current parameter values displays in the view box.   

4. Click the 100 Iter. button.   
Origin fits the data, performing a maximum of 100 Levenberg-Marquardt 
iterations.  The fit curve displays in the graph.  The reduced chi-squared 
value and the number of iterations performed are reported in the NLSF 
view box.  The updated parameter values are shown in the Value text 
boxes. 

Note:  You can also define your initial parameter values in the 
Parameter Initializations dialog box (from the NLSF menu, 
Scripts:Parameter Initialization), and they will be saved with the .FDF 
file.   
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Post Fit Output Options 
After fitting your data, you can opt to create a worksheet that contains the 
results of your fitting session.  Additionally, you can have your curve fit 
parameters written to the results log or in a label pasted to the graph 
window.   

To create a worksheet with the fitting results: 
1. From the NLSF menu, select Action:Results. 
2. In the Other Options group, click the Param. Worksheet button.  

Origin creates worksheet named Parameters1.  The worksheet 
contains the curve fit results including parameter values, confidence 
limits, r-square value, etc. 

To write parameter values to the results log and paste them to the graph 
window: 
3. From the NLSF menu, select Scripts:After Fit.   
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4. Make sure that the Write Parameters to Results Log and Paste 
Parameters to Plot check boxes are selected. 

5. Click the Close button  in the upper right hand corner of the 
NLSF.   

The parameter values are pasted to the graph of the raw data and the best-
fit curve.  Parameter values are also written to the Results Log.  
 
 
This concludes the Nonlinear Curve Fitting tutorial. 
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Tutorial 12, Creating 
Presentations with the Layout 
Page 

Introduction 
Origin’s Layout window provides a “canvas” for displaying and 
arranging pictures of worksheets and graphs from other windows in your 
project, as well as text and other annotations.  The Layout window is the 
only means for presenting worksheet data along with your graph. 
This tutorial will show you how to add and arrange various elements on a 
layout page, how to edit elements of the layout page and how to export 
the layout page to one of Origin’s many graphic export file types. 
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Adding Graphs, Worksheets and Text to the 
Layout Page 

Pictures of graphs and worksheets are added to the layout page by 
clicking the buttons on the Layout toolbar, or by selecting associated 
menu commands.  Text can be added with the Text tool, or by pasting 
from the Clipboard.  Shapes, lines, and arrows can be added using the 
drawing tools from the Tools toolbar. 
The data for this tutorial lesson is provided in an Origin project file. 

To open the project file: 

1. Click the Open button  on the Standard toolbar. 
2. In the Origin \Samples\Graphing\Statistical Graphs subfolder, select 

Histogram.OPJ from the list of files. 
3. Click Open.   
The Origin project file opens.  You should see a notes window and a 
histogram in a graph window.  The project file contains other windows in 
another folder.  Recall that the Project Explorer workspace is toggled on 
and off by pressing ALT+1.   
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Creating a New Layout Page 

To create a newLayout page: 

1. Click the New Layout button  on the Standard toolbar.  A blank 
layout page opens. 

 

2. If the layout page is displayed in landscape orientation, right-click 
on the gray area just outside of the layout page (but inside the layout 
window), and select Rotate Page from the shortcut menu.  The 
layout page will now display in portrait orientation.   

Adding Pictures and Text to a Layout Page 
You can add pictures of any worksheet or graph from your current 
project to a layout page.  Remember as you work with these that they are 
only pictures.  Graphs and worksheets in the layout window are not 
directly editable.  If you want to change some details of the picture 
subsequent to adding it to your layout window (a line color or worksheet 
cell value, for example), you must make the change in the source 
window.  After making your changes, activate the layout window and 

click the Refresh button .  This will update the pictures in the layout 
window. 

To add pictures of graphs and worksheets to the layout page: 
1. Right-click in the layout page (do not click in the gray area just 

outside the page) and select Add Graph from the shortcut menu.   
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2. Select HistGraph from list box in the Select Graph Object dialog 
box and click OK. 

3. Drag out a box on the bottom half of the layout page.  After you 
release the mouse button, a picture of the HistGraph graph displays 
in the layout page. 

 

When the graph picture is selected, you can drag the picture to a new 
location or use the sizing handles to resize it. 
4. Right-click on a blank section of the layout page and select Add 

Worksheet from the shortcut menu. 
5. Select Bin1 from the list box in the Select Worksheet Object dialog 

box and click OK. 



 

 

Tutorial 12, Creating Presentations with the Layout Page 

Adding Pictures and Text to a Layout Page •  229 

 

 

 

6. Drag out a box in the top half of the layout page, leaving some space 
at the top for a title.   

 

After you add the worksheet picture to the layout page, it may display a 
blank area to the right of the last worksheet column, and it may include a 
number of blank worksheet rows.   

To remove blank areas from the worksheet picture: 
1. Right-click on the worksheet picture in the layout page and select 

Keep Aspect Ratio from the shortcut menu.  This cancels the 
selection.   

2. Drag one of the control handles on the right edge of the worksheet 
picture so that only the four worksheet columns display.   

3. Drag one of the control handles on the bottom edge of the worksheet 
picture so that only the worksheet rows with values display.   

4. Re-position the worksheet picture in the layout page.   
5. Click outside the worksheet picture (but within the layout page) to 

cancel the selection. 

To add text to the layout page using the text tool: 

1. On the Tools toolbar, click the Text Tool button .  
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2. Click above the worksheet picture in the layout page. 
3. Before you start typing, from the Format toolbar, select 36 from the 

Font Size combo box.   

   

4. Type Histogram Data in your new text label.   
5. Click outside the label to cancel text editing mode.  

 

Customizing the Appearance of the Layout 
Page 

In this section, you will fine tune the position of the pictures displayed in 
the layout page.  In addition, you will make changes to the source graph 
window to change the picture's appearance in the layout page. 
There are several ways to arrange pictures on the layout page.  You can 
drag the pictures and “eyeball” the position, use the Object Edit toolbar 
to align and group objects, or you can view the layout page grid 
(View:Show Grid) and align the pictures using the grid lines as a guide. 
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To arrange the pictures on the Layout page using the Object Edit tools: 

 

1. If the Object Edit toolbar is not currently open, select 
View:Toolbars.  From the Toolbars tab, select the Object Edit 
check box, then click Close. 

2. Click on the Histogram Data text label to select it. 
3. Press SHIFT and click on the worksheet picture, and then on the 

graph picture (in that order).  All three objects are now selected in 
the layout page. 

4. Click the Vertical button  on the Object Edit Toolbar.  The 
pictures align vertically on the last selected picture (the graph).   

5. Click in the layout page but outside of the pictures to clear the 
selection.   

Editing the Pictures in the Layout Page 
As mentioned, you do not edit the worksheet and graph pictures directly 
in the layout page.  Instead, you edit the source window and update the 
pictures in the layout window.  Origin provides a shortcut menu 
command to take you from a worksheet or graph picture to the source 
window. 

To edit a source window from the Layout page: 
1. Right-click on the histogram picture in the layout page.   
2. From the shortcut menu, select Go To Window.  Origin activates 

the HistGraph window. 
3. Right-click on the histogram and select Plot Details from the 

shortcut menu.  The Plot Details dialog box opens. 
4. Select the Data tab. 
5. Clear the Automatic Binning check box.   
6. In the Bin Size combo box , type 5.  Click OK.   
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7. Double-click on the Y axis in the HistGraph window.  This opens 
the Y Axis dialog box.   

8. Select the Scale tab (if not already selected). 
9. In the To text box Type 600;  in the Increment text box type 100.  

Click OK.   

 

10. Activate the layout page window. 

11. Click the Refresh button  on the Standard toolbar.   
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Exporting the Layout Page 
Once you have tweaked your layout page presentation, you might wish to 
print it out for a poster presentation or you might export the layout page 
to another application.   
You can export your graph or layout page by copying and pasting or you 
may opt to use any one of a number of built-in raster and vector graphic 
export filters to create a separate image file.   
Before you export your layout window we should say something about 
the settings that control the size of the exported image.   
• For Clipboard (copied) and vector file types, image dimensions are 

controlled by (1) page size (default printer page size) and (2) the 
settings in the Copy/Export Page Settings group on the Page tab of 
the Options dialog box (from the menu, select Tools:Options). 

Note: Common vector file types are EPS, PDF, WMF, EMF, AI, CGM, 
and DXF.  Vector files are often preferred by print publications because 
they can be resized without loss of image quality.  These formats 
generally create moderate file sizes. 

• For raster file types, image dimensions are a function of (1) page 
size and (2) export file resolution (commonly between 72 and 600 
dpi).  In effect, raster files are dimensionless because when you 
multiply page size by dpi, you get only "dots"; the dimensions cancel 
out.  Thus, the dimensions of a raster file are controlled by the 
resolution of the rendering device, be it a 96 dpi video display or a 
1200 dpi printer. 

Note: Common raster formats are BMP, TIF, JPG, GIF, PNG and TGA. 
 Taster formats are good for reproducing graphs with considerable detail 
and color variation.  They are not highly scalable, rescaling often leads to 
loss of detail and color.  These formats can produce a very large file size 
when high resolutions and colors are needed. 

Since we are going to be exporting a vector file shortly, let’s open the 
Options dialog box and have a look at the settings on the Page tab. 
1. From the menu, select Tools:Options. 
2. In the Options dialog box, select the Page tab. 
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As mentioned, the settings in the Copy/Export group control the 
dimensions of Clipboard and vector images.  The default settings are 
pictured here.  In most cases, you will only need to concern yourself with 
the Ratio, Margin Control, and Clip Border Width settings.  Briefly: 
•  The Ratio combo box specifies the dimensions of your exported 

image as a percentage of your graph page size.  You can choose a 
number from the associated drop-down list or you can type directly 
in the text box.  A ratio of 100 will create an export image that has 
the same dimensions as your graph page; a ratio of 50 will produce 
and image that is half of your page size, etc. 

• The Margin Control list allows you to specify how much of a 
margin (surrounding white space) to include with your graph or 
layout page pictures.  The choices are Border, Tight and Page.  If 
you choose Border, Origin will use the Clip Border Width setting 
to determine margin width (see the next item for an explanation).  If 
you choose Tight, Origin will draw the smallest rectangle that it can 
around your all objects in your graph or layout page and export only 
what is inside that rectangle.  This usually minimizes white space.  If 
you choose Page, Origin will export the entire page – that is, 
whatever is within the white background area of your page or layout 
window.  This maximizes white space 

• The Clip Border Width combo box, in concert with the Margin 
Control = Border, specifies how much of a margin to include with 
graph or layout page objects, as a percentage of page size. 

Attention to Ratio and Margin Control/Border width settings will suffice 
for most situations.  You are advised to leave the Advanced radio button 
selected and Set Resolution at 300 (or perhaps 600).  However, you are 
encouraged to experiment with these settings, as you have time, so that 
you will better understand how they affect the exported image. 
You should know that image export can be a fairly complex topic and 
there is much more to say about it than we can say here.  For more 
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information, select Help:Origin and search on exporting your graph or 
layout page.   
Returning to our tutorial, we will export our histogram layout page as an 
EPS file.  Encapsulated PostScript files are highly scalable;  that is, they 
can be resized without loss of detail.  For this reason, they are a sensible 
choice for print publishing. 

To export the layout page as an Encapsulated PostScript file: 
1. Make certain that your histogram layout page is the active window.  

From the menu, select File:Export Page.  The Save As dialog box 
opens. 

 

2. In the File Name text box, type Presentation1. 
3. In the Save as type: list, select Encapsulated PostScript (*.EPS). 
Each export file type has its own set of Export Options (pertaining to 
resolution, color density, etc.).  If you want to view or modify those 
export options, you must select the Show Export Options dialog box at 
the bottom of the Save As dialog box. 
4. Select the Show Export Options check box. 
5. Specify a Save in folder (the Origin software folder is fine) and click 

Save. 
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This opens a message reminding you that the Copy/Export page settings 
will be used to determine the size and the margins of your EPS image. 
6. Click OK to close the reminder message.  The EPS Options dialog 

box opens. 

 

In most cases, these default settings will work well, but you may find that 
changing one or more of them is sometimes necessary (in doing this, you 
will create new default settings).   

Note:  When you have determined that your export options are working 
satisfactorily, you may clear the Show Export Options check box in the 
Save As dialog box, and bypass the export options dialog.  Export 
options are stored for each export file type. 

One thing that can be handy when working with EPS files, is to create a 
TIFF (.TIF) preview.  Some applications do not display EPS files and 
will instead display a picture placeholder.  If you opt for a TIFF preview, 
the receiving application can use the appended TIF file to display your 
image. 
7. In the Preview group, select the TIFF radio button if it is not 

currently selected. 
8. Click OK.   
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The layout page is exported as an EPS file and can be inserted into any 
application that recognizes this file type.  If you have Adobe Photoshop 
or Ghostview, you should open your newly created EPS file and have a 
look. 
 
 
This concludes the tutorial on Creating Presentations with the Layout 
Page. 

 



 

 

Tutorial 12, Creating Presentations with the Layout Page 

238 •  Exporting the Layout Page 

 

 

 

 
 
This page is left intentionally blank. 



 

 

Tutorial 13, The Origin Script Window 

Introduction •  239 

 

 

 

Tutorial 13, The Origin Script 
Window 

Introduction 
The Script Window provides a convenient way to send LabTalk script 
commands to Origin. Script commands can range from simple math and 
data operations, to calling Origin C functions, and executing a collection 
of commands from a script file. In this tutorial you will use the Script 
Window to do simple calculations, and to read and write to Origin 
worksheets. 

Performing Calculations 
One of the more basic uses for the Script Window is as an interface to 
perform simple calculations. 
1.  From the Origin program menu, choose Window:Script Window.  

The Script window opens. 
2.  Type the following in the Script window:  

2+2= 

3. Press ENTER.  Origin appends a semi-colon the end of the line and 
returns: 

2+2=4 
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4. Type the following: 
log(100)= 

5. Press ENTER.  Origin appends a semi-colon at the end of the line 
and returns: 

LOG(100)=2 

Each statement in a LabTalk script must end in a semi-colon.  However, 
if your intent is to execute a single line of code from the Script window, 
you do not type the semi-colon at the end of the line .  Simply press 
ENTER to complete the line.  Origin will append a semi-colon for you 
and execute the Script command.   
If you are typing multiple lines of code in the Script window and you do 
not want code to execute each time you enter a carriage return, then you 
should type the semi-colon at line’s end and press CTRL + ENTER.  To 
execute multiple lines of script from the Script window, verify that the 
Script window’s Edit:Script Execution menu command is checked, 
select the entire script and press ENTER. 
You can re-execute a previously-typed command by either placing the 
cursor anywhere on the line and pressing ENTER, or by removing the 
semi-colon at the end of the line and pressing ENTER.  

Note:  Any mathematical function – built-in as well as user-created – can 
be executed from the Script Window. 

Reading and Writing Worksheet Values 
You can also use the Script Window to read and write worksheet values, 
or to perform math operations on datasets. 
1. Enter the following data into a fresh worksheet: 

 

2. To return the value in the first cell of the second column, type the 
following: 
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cell(1,2)= 

3. Press ENTER.  Origin returns: 
CELL(1,2)=6 

You can also use the column name and row number to reference cell 
values. 
4. Type the following: 

col(B)[1]= 

5. Press ENTER.  Origin returns: 
COL(B)[1]=6 

Note:   In addition to using the column name, you can also use the 
dataset name.  In LabTalk, the syntax for naming datasets is 
worksheetName_columnName.  So, For example, Data1_A[1]= 
would return the first element of column A in worksheet Data1.  Also, 
if the worksheet that you are referencing is the active window, you can 
use the LabTalk string variable %H, in place of the worksheet name.  For 
example, %H_A[1]. 

To subtract the value in row 1 of column A, from all the values in 
column B… 
6. Type the following: 

col(B)=col(B)-col(A)[1] 

7. Press ENTER.  Your worksheet now reads: 

 

Let’s use what we have learned about executing multiple lines of script in 
the Script window.  We will multiply every value in a column of data by 
some constant b. 
8. Type the following: 

b=3; 
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Press CTRL+ENTER.  Recall that this gives us a carriage return without 
executing the command.   
9. Now type: 

col(A)=col(A)*b; 

Again, Press CTRL+ENTER.   
10. Choose Edit from the Script window’s menu bar.  Script Execution 

should have a check mark next to it; if not, single-click on the menu 
item to place a check mark there. 

11. Now, select the two lines of script that you just entered into the 
Script window and press ENTER. 

Your worksheet now reads: 

 

Note:  The following C notation is also supported:   
b=3; 
col(A)*=b; 

You can also use linear interpolation or extrapolation on a specified X 
dataset to find the corresponding interpolated or extrapolated value in a Y 
dataset. This requires using a new notation with parentheses (  ) instead 
of brackets [  ]. 
In this example, data1_b is a Y dataset and (4) is a value in an X 
dataset (data1_a) for which you want to find a corresponding, 
interpolated Y value. 
12. Type the following: 

data1_b(4) = 

13. Press ENTER.  Origin returns: 
DATA1_B(4)=5.333333 
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This is a line plot of our simple worksheet data.  You can see that our 
interpolated Y value – the one corresponding to X = 4 – is 5.333333. 
 
 
This concludes the Origin Script Window tutorial. 
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Tutorial 14, Introduction to 
Origin C and Code Builder 

Introduction 
Origin C supports a nearly-complete ANSI C language syntax as well as 
a subset of C++ features including internal and DLL-extended classes.  In 
addition, Origin C is “Origin aware.”  This means that Origin objects 
such as worksheets and graphs are mapped to classes in Origin C, 
allowing direct manipulation of these objects and their properties from 
Origin C. 
Origin C’s integrated development environment (IDE) is called Code 
Builder.  Code Builder provides standard tools for writing, compiling, 
and debugging your Origin C programs.  Once an Origin C function is 
compiled, the function can be called in various ways from the Origin or 
Code Builder workspaces.   
This tutorial introduces you to Origin C and Code Builder by showing 
you how to write, compile and call a function that types the message 
“Hello World!!!”. 

Hello World!!! 

1. On the Origin Standard toolbar, click the Code Builder button .  

2. On the Code Builder toolbar, click the New button . 
 In the New File dialog, select C File. 
 In the File Name text box, type Tutorial. 
 In the Location text box, select the \Origin C subfolder ( The Browse 

button looks like this:  ). 
 Click OK.  A file named Tutorial.c opens in the Code Builder 
workspace. 
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3. Type the following beneath the line that reads // start your functions 
here: 

void test () 

{ 

   printf(“Hello World!!!\n”); 

} 

4. On the Code Builder workspace Standard toolbar, click the Build 

button .  This compiles the test function. 
5. To call this function, click in the upper pane of the LabTalk 

Console.  This is located in the lower right corner of the Code 
Builder workspace (This is the default location.  If the LabTalk 
console isn’t visible, select View:LabTalk Console from the Code 
Builder menu and make sure that the menu item is checked). 

6. Type the following LabTalk function call in the LabTalk Console: 
test 

7. Press ENTER. 
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To test this function in the Origin Script Window: 
8.  Return to the Origin workspace, and select Window:Script 

Window. 
9. In the Script window, type the following:   

test 

10. Press ENTER. 
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"Hello World!!!" displays in the Script Window. 
 
 
This concludes the Introduction to Origin C tutorial. 
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